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Introduction

R emember the Nowhere Man from the Beatles classic animated movie,
Yellow Submarine? He was the nerdy little fellow always going round in
circles, writing books, composing music, taking pictures, directing plays,
and making movies, always so very busy. But he was also very sad, because
no one could see his work; the Blue Meanies had taken art away from the
people (and if we speculate on who the Blue Meanies are, we might really
get in trouble . . . ). Nowhere Man is just “sitting in his nowhere land /
making all his nowhere plans for nobody.” But as John Lennon pointed out,
“Isn’t he a bit like you and me?”

With the iLife suite of software tools, you won’t be like Nowhere Man — iLife
puts the world at your command. All your digital assets — your photos,
your songs, your videos, everything — are at your fingertips. The iLife soft-
ware brings together all your digital assets so that you can use them for cre-
ative projects and manage them for the rest of your real life.

A day in the iLife might include ripping some music CDs with iTunes to use
with your iPod on the road, or perhaps transferring the photos from your
digital camera into your iPhoto library to share them with friends by e-mail.
You might want to assemble a slideshow of the photos in iPhoto and set it to
original music that you can create in GarageBand by just jamming with pre-
recorded loops and saving it in your iTunes library. You can then post the
slideshow with your music on the Web. You can even bring video footage
from your digital camcorder into iMovie and make a music video with all
these elements. Finally, you can use iDVD to put together eye-popping
menus and buttons to show off the music video and slideshow and anything
else you may have, and burn a DVD-R that your friends can play on their
Macs or on everyday DVD players. You can find out how to do all of this and
more in this book.

Now you're getting somewhere, man.
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About This Book

About This Book

We designed this book as a reference. You can find the information you need
when you need it easily — this book even has thumbtabs to locate subjects
quickly. We organize the information in a linear fashion into seven minibooks.
You can read each minibook from beginning to end to find out how to use
the software from scratch. You can also dive in anywhere and begin reading,
because you find all the info you need to know for each task in each section
or step list.

We don’t cover every detail of every function of the software, and we inten-
tionally leave out some detail so that we don’t spook you with technospeak
when it’s not necessary. (Really, engineers can sometimes provide too many
obscure choices that no one ever uses.) For this book, we wrote brief but
comprehensive descriptions and included lots of cool tips on how to be pro-
ductive with iLife.

Conventions Used in This Book

Like any book about computers, this book uses certain conventions.

When we write, “Choose iTunes=~>Preferences,” you should open the iTunes
menu from the toolbar (in iTunes) and then select the Preferences menu
item. Some menus have selections that are submenus with more choices,
such as View=>Arrange Photos=By Date. If we wrote out each command the
long way, this book would be bigger. In an effort to save paper, ink, and your
money, we use the command arrows.

It’s a relief that we’re mostly beyond having to type commands into a com-
puter, even if we have to use something rodent-like in appearance as well as
name. You can use a one-button mouse to do just about everything on a Mac.
When we write, “Click the Import button,” you should move the mouse
cursor to the button on-screen and click the mouse button.

Clicking once is not the only way to use a mouse. When we write “Drag the
photo over the name of the album” we mean click the photo, hold the mouse
button down, and drag the mouse pointer over to the name of the album
before lifting your finger off the mouse button.

Sometimes we abbreviate the instruction, “Click the name of something” to
“select something.” For example, when we say, “Select a photo album,” we
mean click the name of the photo album. Other times, we combine the click-
and-drag function — we say, “Scroll the Source list,” when we mean clicking
and dragging the scroll bar for the Source List window.
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Foolish Assumptions

Contrary to popular belief (and rumors circulated by the Blue Meanies), you
don’t need the following to use any of the applications (or this book):

4+ A pile of cash for extra equipment and software: Yes, you need a digital
camera for iPhoto, a digital camcorder for iMovie, a DVD-R drive for iDVD,
and the iPod for portable music playing, but you can get all of this, includ-
ing an iMac with a SuperDrive for burning DVD-Rs, for under $3,500, which
is about one-tenth of what it cost to do the same in 1998. And you don’t
need any extra software — every important piece of software we describe
in this book is either already on your Mac or available for free from the
Apple Web site at www.apple.com.

4+ A better education: Courses in film, photography, and music can’t hurt,
but iLife is designed for the rest of us air-guitar players that barely know
the difference between a video clip and a still image. You won’t need any
specialized knowledge to have a lot of fun with this software while build-
ing your digital assets.

4+ A tech support hotline: Not once do we ever feel the need to contact
the Apple technical support. Everything works as it should. We pinch
ourselves daily for this apparent miracle. We never have to wade through
inscrutable documentation, either — the built-in help is informative and
useful (which you certainly won’t need if you have this book).

The iLife software is free, supplied with every Mac. That’s really all the soft-
ware you need.

However, we do make some honest assumptions about your computer skills:

4+ You know how to use the Mac Finder: You should already know how to
use the Finder to locate files and folders, and how to copy files and fold-
ers from one hard drive to another.

4+ You know how to select menus and applications on a Mac: You should
already know how to choose an option from a Mac menu, how to find
the Dock to launch a Dock application, and how to launch an application
in the Application folder.

For more information on either topic, see that excellent book by Mark L.
Chambers, Mac OS X All-in-One Desk Reference For Dummies (Wiley).
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How This Book Is Organized

How This Book Is Organized

We organized this tome into seven minibooks. The first five minibooks repre-
sent the five parts of iLife (iTunes, iPhoto, iMovie, iDVD, and GarageBand);
the sixth minibook covers the iPod, and the last minibook delves into extra
iLife information.

Book I: iTunes

This minibook begins with the revolution in digital music and what iTunes
does. You find out how to play music CDs like a professional DJ, buy music
online from the Apple Music Store, rip CDs and import music from many
sources, and organize your music library. The minibook covers everything
you need to know about sound quality and hard drive space trade-offs, as
well as how to get the best sound from your computer or CDs you burn
yourself.

Book 11: iPhoto

This minibook provides all you need to know about using digital cameras
and organizing your photos to produce prints, photo albums, and even
professional-looking photo books. It shows you how to improve and retouch
digital photos, create slideshows, and share photos online and by e-mail.

Book 111: iMovie

This minibook introduces digital video and tells you everything you need to
know about using digital camcorders with your Mac to create videos of all
kinds, even professional videos. This minibook shows you how to manage
video clips, create movies with photos and clips, and even edit soundtracks
and special effects. It also covers sharing movies online and saving movies in
professional formats.

Book V- iDVD

This minibook describes how to bring all your digital assets together to
create exciting DVDs that can play in DVD players as well as computers. You
find out how to create interactive menus and buttons and special effects,
such as video backgrounds. Burn DVDs like the pros and back up all your
precious digital assets — photos, music, movies, slideshows — at their high-
est quality.
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Book U: GarageBand

This minibook describes how to create your own music by building songs
with prerecorded loops, recording a performance using your Mac as a syn-
thesizer that can simulate musical instruments, and recording performances
with real musical instruments (such as guitars) or live singing with vocal
microphones. You find out how to create and edit separate tracks, mix the
tracks with volume and panning controls to create stereo sound, employ
sound effects and simulated amplifiers, and export the finished song to
iTunes.

Book Ul: iPod

This minibook tells how to take your entire music library with you on the
road with an iPod. You also discover how to use the iPod to look up contacts
(addresses and phone numbers) and your calendar and to-do lists, as well as
how to use the iPod as a portable hard drive.

Book VII: iLife Extras

This minibook talks about integrating the various components of iLife and
includes some helpful third-party stuff.

Icons Used in This Book
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The icons in this book are important visual cues for information you need.

The Remember icons highlight important things you should commit to
memory.

The Technical Stuff icons highlight technical details you can skip unless you
want to bring out the technical geek in you.

The Tip icons highlight tips and techniques that save you time and energy,
and maybe even money.

The Warning icons save your butt by preventing disasters. Don’t bypass a
Warning icon without reading it. This is your only warning!
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Where to Go from Here

Feel free to begin reading this book anywhere or skip particular sections or
chapters (or go really wild and start on page 1 and continue reading to the
Index). If you want to know how to tackle a particular task, look it up in the
Index or Table of Contents and flip to the page you need. Or if you want to
start finding out about one of the products, start with that minibook. This is
your book; dive right in.
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Chapter 1: iTunes —
The Digital Jukebox

In This Chapter

v~ Starting iTunes

v Playing music tracks

1~ Setting visual effects

v Perfecting the sound

v~ Shopping for music online
v Importing into iTunes

v Listening to Web radio streams

M ore than half a century ago, jukeboxes were the primary and most con-
venient way for people to select the music they wanted to hear and
share with others, especially newly released music. Juke joints were hopping
with the newest hits every night; however, you still had to insert coins every
time you played a song. Possibly, you could afford records and a turntable,
but you had to throw a party to share the music with others.

Today, using a computer, you can create a digital jukebox and conveniently

click a button to play a song. Connect your Mac to a stereo amplifier in your
home, or connect speakers to your Mac, and suddenly your Mac is the best

jukebox in the neighborhood.

You can listen to a new song on the Internet and download it immediately.
You can also buy music online at the iTunes Music Store. iTunes downloads
music from the store and puts it in your library, making it immediately avail-
able for playing, burning onto a CD, or transferring to an iPod. You can even
listen to Web radio stations using iTunes and add your favorite stations to
your music list.

Transferring songs from a CD to your computer is called ripping a CD (to the
chagrin of the music industry old-timers who think we intend to destroy the
disc or steal the songs). Ripping an entire CD’s worth of songs is quick and
easy, and track information including artist name and title arrives automati-
cally over the Internet.



10

Setting Up iTunes

iTunes gives you the power to organize songs into playlists and burn (record)
CDs of any songs in your library, in any order. You can even set up dynamic
smart playlists that reflect your preferences and listening habits. iTunes offers
an equalizer with preset settings for all kinds of music and listening environ-
ments, and it gives you the ability to customize and save your own personal-
ized settings with each song.

This chapter explains how iTunes changes your music playing and buying
habits for the better. You can preserve your music virtually forever with-
out depending on the viability of the media (such as CDs that can become
scratched), and you can also use your music in a variety of creative projects
made possible by iLife.

Setting Up iTunes

You need to set up iTunes so that it can use your Internet connection to down-
load song information such as artist name and song titles. This happens auto-
matically when you first start iTunes. Follow these steps:

1. Launch iTunes.
Double-click the iTunes application, or click the iTunes icon in the Dock.

2. If this is the first time you’ve used iTunes, click the Agree button for
Apple’s License Agreement.

Apple’s License Agreement appears only when you start iTunes for the
first time. You can click Save to save the license agreement as a docu-
ment, Print to print it, Decline to quit iTunes immediately, or Agree to
move on to iTunes Setup Assistant. No lawyers will be present when you
do this; it’s all up to you.

The Setup Assistant takes you through the process of setting up iTunes
for the Internet.

3. Click Yes or No for the following options:

e “Yes, use iTunes for Internet audio content,” or “No, do not modify
my Internet settings”

We suggest clicking Yes to allow iTunes to handle audio content,
because iTunes offers more features than you typically find with
browser plug-ins from other companies. On the other hand, if you are
happy with your plug-ins and helper applications, you can click No
and leave your Internet settings untouched.
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e “Yes, automatically connect to the Internet,” or “No, ask me before
connecting”

If you use an always-on broadband Internet service, you probably
want iTunes to connect automatically, and you can click Yes. If you
use a dial-up modem, if your Internet service is intermittently off, or
if your Internet service charges when you use it, you probably don’t
want this connection to be automatic — you can click No to make
iTunes ask first. To go to the next screen, click Next.

The Setup Assistant also asks if you want iTunes to search your home
folder for music files. You may want to click the No button for now,
because iTunes may find files you don’t want to add to your library
(such as music for games).

4. Click Next to go to the iTunes Music Store screen of the Setup Assistant.

The assistant asks if you want to go straight to the iTunes Music Store.
We suggest clicking No for now, until you get to know iTunes.

5. In the Setup Assistant window, click Done.

The iTunes window appears, as shown in Figure 1-1. You can drag the
bottom-right corner of your iTunes window to make it larger or smaller
on your screen.

808 iTunes
(ee) [/:\Jf e i ‘ . a- ) |@
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Figure 1-1:
iTunes. -
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P If your computer shares a phone line or you pay Internet connection charges

by the minute, you probably don’t want to connect automatically. If you're
stuck with a dial-up modem, you may not want your modem to make a phone
call every time you slip a CD into the computer. On the other hand, if your
Internet cost isn’t based on usage and you're always connected, connecting
iTunes automatically is convenient.
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12 Playing CD Tracks

Whether or not you set iTunes to automatically connect to the Internet, you
should at some point connect to the Internet with iTunes, not only to buy
music online and listen to Web radio, but also to retrieve the track information
when you insert a CD new to iTunes so that you don’t have to type the infor-
mation yourself.

Playing CD Tracks

Figure 1-2:
The tracks
of an audio
CD.

To start playing music, just insert a music CD (or even a CD-R disc that
someone else may have burned for you). The music tracks appear in the
iTunes song/detail list, as shown in Figure 1-2.

You can play CDs without importing the music to your iTunes library if you
want to use iTunes as a CD player only. To find out how to get digital music
online or import music from CDs, see the sections, “Buying Music Online
from Apple” and “Importing Music into iTunes,” later in this chapter.

.
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If your Mac is connected to the Internet, and you clicked Yes to the “auto-
matically connect to the Internet” question in Setup Assistant, iTunes pres-
ents the track information from the Internet for each song automatically
after you insert the CD, as shown in Figure 1-3.

To play the CD from the first track — which is already selected if you just
inserted the disc, but may not be if you clicked somewhere else after inserting
the disc, in which case you should click the first track to select it — click the
Play button. The Play button turns into a Pause button, and the song plays.



Playing CD Tracks 13

Volume slider
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Back | Forward
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Shuffle Repeat Status Display Visual Effects Eject
When the song finishes, iTunes continues playing the songs in the list in
sequence until you click the Pause button (which then turns back into the
Play button). You can skip to the next or previous song using the arrow keys
on your keyboard, or by clicking the Forward or Back button next to the Play
button. You can press the the spacebar of your keyboard to perform the
same function as clicking the Play button; pressing the spacebar again is just
like clicking the Pause button.
P The status display above the list of songs tells you the name of the artist and

song (if known), and the elapsed time of the track. Click the artist name, and
the name disappears and the song title is displayed; click the title, and it is
replaced by the artist name. If you click the Elapsed Time status, the status
changes to the remaining time and then, with another click, to the total time
(one more click brings you back to the elapsed time).

Rearranging and repeating tracks

You can rearrange the order of the tracks to automatically play them in any
sequence you want — similar to programming a CD player. Click the upward-
pointing arrow at the top of the first column in the song list, and it changes
to a downward-pointing arrow, with the tracks in reverse order.
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Displaying Visuals

You can change the order of tracks played in sequence. Just press and hold
the mouse button on the track number in the first column for the song, and
drag it up or down in the list. You can set up the tracks to play in some com-
pletely different sequence.

Skipping tracks

To skip tracks so they don’t play in sequence, click the box next to the song
name to remove the check mark. iTunes skips deselected songs when you
play the entire sequence.

To remove all check marks from a list simultaneously, hold down the 88 key
while clicking a check mark. Click an empty check mark box while pressing
3 to add check marks to the entire list.

Repeating a song list

You can repeat an entire song list by clicking the Repeat button at the
bottom of the Source list on the left side of the iTunes window (or by choos-
ing Controls>Repeat All). The Repeat button icon changes to show blue
highlighting. Click the Repeat button again to repeat the current song

(or choose Controls>Repeat One) — the icon changes to include a blue-
highlighted numeral one. Click it once more to return to normal playback
(or choose Controls=>Repeat Off).

The Shuffle button, to the left of the Repeat button, plays the songs in the
list in a random order, which can be fun. You can then press the arrow keys
or the Back or Forward button to jump around in random order. Eject a CD
by clicking the Eject button or by choosing Controls=>Eject Disc.

Displaying Visuals

Visual effects can turn your Mac display into a lightshow for your amuse-
ment. You can watch a cool visual display of eye candy while the music
plays — or leave it on like a lava lamp. Click the Visual Effects button on
the bottom right side of the iTunes window (or choose Visualizer>Turn
Visualizer On). The visual animation appears in the iTunes window and
coordinates with the music.

In addition to the animation replacing the iTunes song list, an Options
button replaces the Import button in the upper-right corner of the iTunes
window. You can click the Options button to open the Visualizer Options
dialog, as shown in Figure 1-4.



Figure 1-4:
Set your
options for
visual
effects.
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Visualizer Options

[ Display frame rate

@ Cap frame rate at 30 fps

%Alwavs display song info
Use OpenGL

@ Faster but rougher display

T

The Visualizer Options dialog offers the following options that affect the ani-
mation but not the performance of iTunes when it’s playing music:

4+ Display frame rate: Displays the frame rate of the animation along with
the animation.

4+ Cap frame rate at 30 fps: Keeps the frame rate at 30 fps (frames per
second) or lower, which is the speed of normal video.

4+ Always display song info: Displays the song name, artist, and album for
the song currently playing, along with the animation.

4+ Faster but rougher display: The animation plays faster, with rougher
graphics. Choose this option if your animation plays too slowly.

The Visualizer menu in iTunes gives you even more control over visual effects.
You can choose Visualizer>Small or Visualize>Medium to display the visual
effects in a rectangle inside the iTunes window, or Visualize=>Large to fill the
iTunes window. Choosing Visualizer>Full Screen sets the visual effects to
take over the entire screen. With full-screen visual effects, you can click the
mouse or press the Escape key on your keyboard to stop the display and
return to iTunes.

While the animated visual effects play, press Shift+/ (the keystrokes you use
to type a question mark) to see a list of keyboard functions. Depending on
the visual effect, you may see more choices of keyboard functions by press-
ing Shift+/ again.

To turn off visual effects, click the Visual Effects button again. You can leave
the effects on (except when in full-screen mode) even while opening the
equalizer, because you still have access to the playback controls. See the
following section to find out how to change the equalizer settings.
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16 Fine- Tuning the Sound

Fine-Tuning the Sound

Figure 1-5:
Adjusting an
equalizer
preset.

The jumping-bar displays you see on audio equipment are in most cases
equalizers. An equalizer (EQ in audiospeak) enables you to fine-tune the
specific sound spectrum frequencies. Adjusting bass and treble controls on
aradio or stereo are simply cruder ways of adjusting these frequencies. An
equalizer gives you far greater control over specific frequencies.

Using an equalizer preset

To see the iTunes equalizer, click the Equalizer button, on the bottom-right
side of the iTunes window. The Equalizer window appears, as shown in
Figure 1-5. Chapter 3 of this minibook provides more details on enhancing
the sound with the iTunes equalizer.

8noe Equa\izer
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32 b4 125 250 500 1K 2K 4K 8K 16K

You can select one of the preset values from the pop-up menu or adjust the
frequencies manually by dragging the sliders up and down, just like a profes-
sional mixing console. We describe in detail how to use the equalizer in
Chapter 3 of this minibook.

Cross-fading and controlling volume

You can fade the ending of one song into the beginning of the next one to
slightly overlap songs, just like a radio DJ. Ordinarily, iTunes is set to have a
short cross-fade — a short amount of time between the end of the fade in the
first song and the start of the fade in the second song.

You can change this cross-fade setting by choosing iTunest>Preferences and
then clicking the Effects button. You can turn the Crossfade Playback option
on or off, and increase or decrease the amount of the cross-fade.

You can also adjust the volume for all the songs at once by sliding the
volume slider in the upper-left section of the iTunes window. The maximum
volume of the iTunes volume slider is the maximum set for the computer’s
sound in the Sound pane of System Preferences.
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To adjust the volume of a particular song, click a song to select it, and then Book |
choose Filew>Get Info. In the Get Info dialog, click the Options tab, and then Chapter 1
drag the Volume Adjustment slider left or right to adjust the volume.

o._.

Some CDs play more loudly than others, and occasionally, individual tracks a =

within a CD are louder than others. To ensure that all the songs in your 8 5
library play at the same volume level, follow these steps: =
~

@ -

1. Choose iTunes->Preferences. g 2

The Preferences dialog appears.
2. Click the Effects button.
3. Select the Sound Check check box.

iTunes sets the volume for all songs according to the level of the slider.
4. Click OK.

Buying Music Online from Apple

When Apple announced its new music service, Apple chairman Steve Jobs
remarked that other services put forward by the music industry tend to
treat consumers like criminals. Steve had a point. Many of these services
cost more and add a level of copy protection that prevents consumers from
burning CDs or using the music they bought on other computers or portable
MP3 players.

Apple did the research on how to make a service that worked better and
was easier to use, and it forged ahead with the iTunes Music Store. By all
accounts, Apple has succeeded in offering the easiest, fastest, and most
cost-effective service for buying music for your Mac and iPod. For example,
the iTunes Music Store offers gift certificates you can e-mail to others, and
allowance accounts you can set up for others (such as children) with credit
limits but without the need to use a credit card. New features are added
almost weekly to the store.

Uisiting the iTunes Music Store

As of this writing, the iTunes Music Store offers more than 500,000 songs,
with most songs available for download at the price of $.99 each, and entire
albums are available for download at far less than the price you pay for the
CD. You can play the songs on up to three different computers, burn your
own CDs, and use them on players such as the iPod.

You can preview any song for up to 30 seconds, and if you already estab-
lished your account, you can buy and download the song immediately. We
don’t know of a faster way to get a song.
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Buying Music Online from Apple

To use the iTunes Music Store, follow these steps:

1.

In iTunes, click the Music Store option in the Source list.

The Music Store front page appears (see Figure 1-6), replacing the iTunes
song list. The page enables you to check out artists and songs to your
heart’s content, although you can’t buy songs until you sign into a
Music Store account. You can use the Choose Genre pop-up menu to
specify music genres, or click links for new releases, exclusive tracks,
and so on — just like any music service on the Web.
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2. Click the Sign In button on the right to create an account or sign in to
an existing account.
You need an account (with a credit card) to buy music. iTunes displays
the account sign-in dialog, as shown in Figure 1-7.
P If you already set up an account in the Apple Store, in the .Mac service, or

on America Online (AOL), you're halfway there. Type in your ID and pass-
word, and then click the Sign In button. Apple remembers the information
you put in previously, so you don’t have to re-enter it every time you visit
the iTunes Music Store. If you forgot your password, click the Forgot
Password? button, and iTunes provides a dialog to answer your test ques-
tion. If you answer correctly, your password is then e-mailed to you.

If you aren’t signed up, click the Create New Account button to, uh,
create a new account.

iTunes displays a new page, replacing the iTunes front page, with an
explanation of steps to create a new account and the terms of use.



Figure 1-7:
Signing into
the iTunes
Music
Store.
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To create an Apple Account, click Create New Account.

sz Sign In to buy music on the iTunes Music Store

¥ R T —- Y
= Create New Account

If you have an Apple Account (from the Apple Store or .Mac, for example), enter
your Apple ID and password. Otherwise, if you are an AOL member, enter your AOL
screen name and password.
= Apple 1D:
@ ' bcvel Example: stev
Password:
—~ 7 Y
U 48 AOL Forgot Password?

4 ) . A Y
Cancel / Sign In

(-2

4. Click the Agree button, and then fill in your personal account
information.

iTunes displays the next page of the setup procedure, which requires
you to type your e-mail address, password, test question and answer
(in case you forget your password), birth date, and privacy options.

5. Click Continue to go to the next page of the account setup procedure,
and then enter your credit card information.

Enter your personal credit card information. The entire procedure is
secure, so you don’t have to worry. The Music Store keeps your informa-
tion on file and you don’t have to type it in again.

6. Click Done to finish the procedure.

You can now use the iTunes Music Store to purchase and download
music to play in iTunes and to use on an iPod.

Browsing the store and previewing a song

You may want to listen to a song before buying or just browse the store and
listen to song previews. To browse the store, click the Browse button in the
top-right corner of the window. iTunes displays the store’s offerings catego-
rized by genre, and within each genre, by artist and album. Click a genre,
then an artist, and then an album, to see the list of songs from that album
that are available to preview or purchase, as shown in Figure 1-8.

To see more information about a song or the album it came from, click one of
the circled arrow buttons in the song list:

4+ Clicking the arrow in the Artist column takes you to the artist’s page of
albums.

4+ Clicking the arrow in the Album column takes you to the album page, as
shown in Figure 1-9.
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4 Clicking the arrow in the Genre column takes you back to the genre’s
specials page (or the home page).
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Click a song in the list of songs and click the Play button to play a preview.

Each preview lasts about 30 seconds. The previews play on your computer
off the Internet in a stream, as shown in Figure 1-9, so there may be a few
hiccups in the playback.
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Buying songs

After you have an account set up, you can purchase songs and download
them to your computer. Select a song and click the Buy Song button at the
far right of the song (you may have to scroll your iTunes window horizon-
tally). The store displays a warning to make sure you want to buy the song,
and you can either go through with it or cancel. The song downloads auto-
matically and shows up in your iTunes song list. Purchased songs also
appear in a Purchased Music playlist in the iTunes library.

If for some reason your computer crashes or you quit before the download
finishes, iTunes remembers to continue the download when you return to
iTunes. If for some reason the download doesn’t continue, choose Advanced=
Check for Purchased Music to continue the download.

Apple offers 1-Click technology in the store so that when you click the Buy
Song button, the song immediately starts downloading to your computer
and the purchase is done.

But you don’t have to use the 1-Click technology. You can instead add songs
to a shopping cart in the store, to delay purchasing and downloading until
you’re ready. With the shopping cart, the store remembers your selections
and you can browse the store at different times, adding to your shopping
cart without making any purchases final; you can also remove items from the
cart at any time. When you’re ready to buy, you can purchase and download
the songs in your cart at once. If you decide on the shopping cart method,
the Buy Song button changes to an Add Song button. When you’re ready to
purchase everything in your cart, click the Buy Now button to close the sale
and download all the songs at once. To switch from 1-Click to a shopping
cart, check out the section, “Setting the music store preferences.”

All sales are final. If your computer’s hard drive crashes and you lose your
information, you also lose your songs — you have to purchase and down-
load them again. But you can mitigate this kind of disaster by backing up
your music library, which we describe in detail in Chapter 2 of this mini-
book. You can also burn your purchased songs onto an audio CD, as we
describe in Chapter 4 of this minibook.

Handling authorization

The computer you use to set up your account is automatically authorized by
Apple to play the songs you buy. Fortunately, the songs aren’t locked to that
computer — you can copy them to another computer and play them from
within the other computer’s iTunes program. When you first play them on
another computer, iTunes asks for your iTunes Music Store ID and password
in order to authorize that computer. You can authorize up to three comput-
ers at a time. If you want to add a fourth computer, you can remove the
authorization on a computer by choosing Advanced=>Deauthorize Account.
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After you set up an account, you can sign into the iTunes Music Store at any
time to buy music, view or change the information in your account, and see
your purchase history. To see your account information and purchase history,
click the View Account link in the store after signing in with your ID and pass-
word. Every time you buy music, you get an e-mail from the iTunes Music
Store with the purchase information.

Setting the music store preferences

Your decision to download each song immediately or add to a shopping cart
and download the song(s) later will likely be based on how your computer
connects to the Internet. If you would rather gang up your song downloads
to do at a certain time (such as overnight), you probably want to use the
shopping cart method.

You can change your preferences with the iTunes Music Store by choosing
iTunes>Preferences; and in the Preferences dialog that appears, click the
Store button at the top of the dialog. The Store dialog appears, as shown in
Figure 1-10. The Store dialog enables you to change from 1-Click to Shopping
Cart or vice versa. You can also select the Play Songs after Downloading
option so that the songs you bought start playing immediately after down-
loading. The Load Complete Preview before Playing option, if turned on, pro-
vides better playing performance (fewer hiccups) with previews if you have
a slow Internet connection.

P If you use more than one computer with your account, you can set the pref-
erences for each computer differently while still using the same account. For
example, your store-authorized home computer may have a faster connec-
tion than your authorized PowerBook on the road, and you can set your
iTunes preferences accordingly.

Store
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Chapter 1

To immortalize your music, you need to import it into iTunes from your
audio CDs and other sources. After you put music into the iTunes library,

o._.
you can preserve it forever. A song in digital format can be kept in that <. E'
format in a file on any number of digital media storage devices — so even if E a
your CDs, DVDs, and hard drive fails, your backup copy (assuming you made =
a backup copy on a safety disk) is still as perfect as the original digital file. &5
You can make as many digital copies as you want. There are no limitations g°

on playing the copies except those imposed by the iTunes Music Store for
songs you purchased (up to three computers).

Importing songs from a CD is called ripping a CD. We're not sure why it came
to be called that, but Apple certainly took the term to a new level with an ad
campaign for Macs a while back that featured the slogan “Rip, Mix, Burn.”
Burning a mix CD was the hip thing to do a few years ago. If you have an
iPod, you only have to rip and mix — burning CDs to play your music wher-
ever you go isn’t necessary.

Ripping, in technical terms, is the process of extracting the song’s digital
information from an audio CD, but in common terms it also includes the
process of compressing the song’s digital information and encoding it in a
particular sound file format. The ripping process is straightforward, but the
settings you choose for importing affect sound quality, hard drive space
(and iPod space), and compatibility with other types of players and comput-
ers. Chapter 3 of this minibook provides an in-depth look at these encoders
and quality settings; for now, we show you how to do it and provide sugges-
tions for settings.

Ripping music from CDs

Though importing music from an audio CD takes a lot less time than playing
the CD, it still takes time. We suggest that before you rip your first CD, you
look at the Importing dialog by choosing iTunes=>Preferences, and then
clicking the Importing button at the top of the Preferences dialog. The
Importing dialog appears, as shown in Figure 1-11.

Note the type of encoding selected in the Import Using pop-up menu and the
quality setting in the Setting pop-up menu and consider these options:

4+ Import Using: Set this pop-up menu to AAC Encoder, which is the same
as the format used by the Apple Music Store, or the MP3 Encoder, which
is the standard for online music files. The other formats are for higher-
quality uncompressed music files. (Chapter 3 of this minibook provides
a more in-depth look at these choices.)
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Figure 1-11:
Check your
preferences
for ripping
CDs.

Importing
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Use this option if you experience problems with the
audio quality from Audio CDs. This may reduce the
speed of importing.

Setting: Set this pop-up menu to High Quality for most music. You can
change this setting to get better quality or to use hard drive space more
efficiently, as we describe in Chapter 3 of this minibook.

Play songs while importing: Click the check box to play the songs at the
same time that you rip them. This option slows down the speed of
importing.

Create file names with track number: Click the check box to include the
track number in the filenames created by iTunes for the songs you rip.

Use error correction when reading Audio CDs: Click the check box if
you have problems with the audio quality when playing the CD (or prob-
lems with the music files ripped from the CD). Dirty or scratched CDs
can cause such problems. This option slows down the ripping process,
but it corrects some of these problems.

To rip a CD, follow these steps:

1.

Insert an audio CD.

The songs appear in your song list as generic unnamed tracks at first. If
the track names don’t appear in a minute, connect to the Internet and
choose Advanced=>Get CD Track Names.

(Optional) Deselect any song(s) on the CD that you don’t want to
import.

iTunes imports the songs that have check marks next to them; when you
remove the check mark next to a song, iTunes skips that song.
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3. (Optional) To remove the gap of silence between songs that segue
together, select those songs and choose Advanced~>Join CD Tracks.

The tracks on many music CDs are separate, but the end of one song
merges into the beginning of the next song. You don’t want an annoying
half-second gap between those songs.

To select multiple songs, click the first one, and then hold down the 88
key to click each subsequent song. To select several songs consecu-
tively, click the first one, and then hold down the Shift key and click the
last one.

4. Click the Import button at the top right of the iTunes window.

The status display shows the progress of the operation. To cancel, click
the small x next to the progress bar.

iTunes plays the songs as they import. You can click the Pause button

to stop playback. You can also stop the playback by choosing iTunesw>
Preferences and clicking the Importing button. Deselect the Play Songs
While Importing check box in the Importing dialog.

As iTunes finishes importing each song, it displays a green check mark
next to the song. iTunes chimes when it finishes the import list.

5. Click the Eject button at the bottom right of the iTunes window to
eject the CD after all the songs are imported.

You can also choose Controls=>Eject Disc to eject the CD.

Importing music files from other sources

The quality of the music you hear depends on the quality of the source. Web
sites and services offering MP3 files vary widely. Some sites provide high-
quality, legally derived MP3 songs, and some don’t. Anyone can create MP3
files, so beware of less-than-high-quality knockoffs and sites that offer free
music.

Some sites offer only streaming audio, just like a Web radio station
(described in the “Listening to Web Radio” section, later in this chapter). If
you download something that turns out to be just a Web address (a URL),
you can still use that with iTunes — a broadcast symbol appears next to the
song in your library, just like a Web radio station.

Whether you download the music file or copy it from another hard drive,
you need to save it on your hard drive. After you save or copy an MP3 file —
or for that matter an AIFF or WAV file — on your hard drive, you can simply
drag it into the iTunes window to import it to your library. If you drag a
folder or disk icon, all the audio files it contains are added to your iTunes
library. You can choose Filec>Add to Library as an alternative to dragging.
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Adding your own pet sounds

No, we're not talking about sounds your pet
may have made. We're referring instead to your
favorite music or sounds that can't be found on
CD or, believe it or not, on the Internet. The Pet
Sounds Sessions box set by the Beach Boys
includes just about every spoken word and
sneeze in the studio during the recording, and
you may have equally unusual sounds or rare
music that can’t be found anywhere else. How
do you get stuff like that into iTunes?

Sound can be imported from almost anywhere:

v Internet: You can import MP3 music files
from Web sites by first downloading the
MP3 files to your Mac. You can also link to
Web radio stations, but you can't capture
the songs from Web broadcasts without
additional software, and you may be violat-
ing copyright law, so we don't recommend
doing it.

Professional editing programs: You can
import high-quality AlIFF-format or WAV-
format files from music editing programs.
These programs typically record from any
analog source device, such as a tape
player or even a turntable for playing vinyl
records.

Line-in connector: You can record music
from instruments and microphones directly
into a digital file from the Mac'’s line-in con-
nector using GarageBand, described in
Book V, which lets you mix tracks of music
from instruments and other sources and
export directly into iTunes. You can also
record an analog signal, such as a line out

from your home stereo connected to the
Mac's line-in connector, using the Sound
Studio program, found in the Applications
folder in Mac 0S X systems (you can use it
for about two weeks before paying for it).
You can connect any music source to the
line-in connector, including home stereos
with turntables for playing vinyl records.
(The Sound Studio program may not be
bundled with all systems. You can down-
load an application to check it out at
www.felttip.com/products/sound
studio/.) For newer Macs that no longer
have the line-in connections, you can pur-
chase a USB audio input device, such as
the Griffin iMic or the Roland UA-30.

You can import any sound saved in an MP3,
AIFF, or WAV sound file, including your own
voice recorded to the hard drive using the
Mac microphone and a program such as
GarageBand or Sound Studio. You may want to
create special sound effects to use with photo
slideshows in iPhoto, videos in iMovie, or DVD
menus in iDVD. You can import the sound
effects file once into your iTunes Library and
use it in all three types of projects.

Voice recordings tend to be low-fidelity, so we
recommend using the MP3 Encoder with the
Good Quality setting (128 Kbps), rather than
higher quality settings. Sound effects and voice
recordings are typically mono rather than
stereo — but you can also select the Custom
setting to force the importing to be mono
or stereo, as we describe in Chapter 3 of this
minibook.

\\3

When you add a song to your iTunes Library, a copy is placed inside the
iTunes Music folder, which you can view in the Finder. (The iTunes Music
folder lives in the Music folder of your Home directory/folder.) The original
song file is not changed or moved. You can then convert the song to another




Listening to Web Radio 27

format — for example, you can convert an AIFF file to an MP3 file — while Book I
leaving the original file intact. We describe converting songs in Chapter 3 of Chapter 1
this minibook.
o._.
e
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Do you like to listen to audio books and spoken magazine and newspaper E =]
articles? Not only can you bring these sounds into iTunes, but you can also g°

transfer them to an iPod and take them on the road, which is much more
convenient than taking cassettes or CDs.

Audible is a leading provider of downloadable spoken audio files. Audible
lets you enable up to three computers to play the audio files, just like the
iTunes Music Store. Audible does require that you purchase the files.
Audible’s content is also licensed by Apple to be included in the iTunes
Music Store in the Audio Books category, with over 5,000 titles so far, includ-
ing magazines and radio programs as well as books.

To import Audible files, follow these steps:

1. Go towww.audible.com and set up an account if you don’t already
have one.

2. Choose and download an Audible audio file.
These are files whose names end with . aa.
3. Drag the Audible file to the iTunes window.

If this is the first time you've added an Audible file, iTunes asks for your
account information. You need to enter this information only once for
each computer you use with your Audible account.

To disable an Audible account, open iTunes on the computer that will no
longer be used with the account, and choose Advanced=>Deauthorize
Computer. In the Deauthorize Computer dialog that appears, select the
Deauthorize Computer for Audible Account option and click OK. Remember:
You need to be online to authorize a computer or to remove the authoriza-
tion from that computer.

Listening to Web Radio

Now you can reach radio stations on the Internet that represent nearly every
area of the world. You can tune into Japan-A-Radio for the top 40 hits in
Japan, or Cable Radio UK from the south coast of England, or Radio Darvish
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Figure 1-12:
Selecting a
Web radio
station.

for Persian traditional music. You can also check out the local news and
sports from your hometown, no matter where you are. You can listen to talk
radio and music shows from all over the country and the world.

You can’t record or save a song from a radio broadcast without special soft-
ware. But you can add your favorite stations to your music library or to a
playlist to tune in quickly and easily. You can also tune in any Web radio or
streaming broadcast if you know the Web address.

Streaming music from the Internet

Apple provides links within iTunes directly to radio stations on the Internet,
so you may want to try these first. Follow these steps:
1. Click the Radio option in the Source list.

The iTunes window displays a list of categories of radio stations, as
shown in Figure 1-12.
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2. Click the Refresh button to retrieve the latest radio stations.

More Web radio stations are added all the time. The Refresh button in
the top-right corner of the iTunes window (taking the place of the
Browse button) connects iTunes to the Internet to retrieve the latest list
of radio stations for each category.

3. Click the triangle next to a category name to open the list of radio
streams in that category.
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Radio station broadcasts stream to your computer over the Internet —
sections of the audio transfer and play while more sections transfer so
that you hear it as a continual stream. Some large radio stations offer
more than one stream.

4. Select a stream and click the Play button.

Within seconds, you hear live radio off the Web.

If you use a dial-up modem connection to the Internet, you may want to
choose a stream with a bit rate of less than 56 Kbps for best results. The Bit
Rate column shows the bit rate for each stream.

iTunes creates a buffer for the audio stream so that you hear continuous
playback with fewer Internet-related hiccups than most Web radio software.
The buffer temporarily stores as much of the stream as possible, adding
more of the stream to the end of the buffer as you play the audio in the
buffer. If you hear stutters, gaps, or hiccups when playing a stream, set your
buffer to a larger size by choosing iTunes>Preferences. In the Preferences
dialog, click the Advanced button, and then choose a size from the
Streaming Buffer Size pop-up menu. Your choices are Small, Medium, or
Large (sorry, no X-Large).

Saving your favorite stations

Car radios offer preset stations activated by you pressing a button. Of
course, you first need to tune into the station of your choice to set that
button. You can do the same with iTunes, and the process is just as easy:
1. Select a radio station stream.
2. Create a playlist or scroll the Source list to an existing playlist.
See Chapter 2 of this minibook to discover how to create a playlist.
3. Drag the stream name over the playlist name.

iTunes places the stream name in the playlist with a broadcast icon next
to it. You can click the playlist name and rearrange the playlist as you
want, dragging stream names as you would drag song names.

Drag as many steams as you like to as many playlists as you like. Radio
streams in your playlists play only if you are connected to the Internet.

To quickly create a playlist from selected radio streams, first select the
streams (by holding down Shift or the 38 key to make multiple selections),
and then choose File>New Playlist from Selection.
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Figure 1-13:
Enter the
URL to play
any Web
streaming
broadcast.

Listening to Web Radio

Adding Web broadcasts

Millions of Web sites offer temporary streaming audio broadcasts all the
time. A rock group on tour may offer a broadcast of a special concert, avail-
able for only one day. You may want to tune in weekly or monthly broadcasts
such as high-tech talk shows, news programs, documentaries, or sporting
events . .. the list is endless. You may even have access to private broadcasts
such as corporate board meetings.

As of this writing, iTunes supports only MP3 broadcasts. You can find lots of
MP3 broadcasts at www.shoutcast.comand 1ive365.com.

All you need to know is the Web address, also known as the URL (Uniform
Resource Locator) — the global address of documents and other resources
on the Web. You can find most URLs from a Web site or e-mail about a broad-
cast. Follow these steps to add a Web broadcast to a playlist:

1. Choose Advanced=>Open Stream.

The Open Stream dialog appears, with a URL text field for typing a Web
address.

2. Type the exact, full URL of the stream, as shown in Figure 1-13.

Include the http:// prefixasin http://64.236.34.141:80/stream/
1014.

If you're connected to the Internet, iTunes automatically retrieves the
broadcast and places it at the end of your song list.

3. Click OK.
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Chapter 2: Organizing Your Library

In This Chapter

v Browsing the library and searching for songs
v Adding and editing song information
v Creating custom and automatic smart playlists

v Backing up your library and sharing music over a network

Fe iTunes library is awesome even by jukebox standards — it can hold
up to 32,000 songs (depending on how much space you have on your
hard drive). Finding Chuck Berry’s “Maybelline” is a challenge using a rotat-
ing dial of 32,000 songs. And its companion, the 40GB iPod portable music
player, can hold about 10,000 songs in the AAC format — that’s enough
music to last two weeks if played 24 hours a day!

Even if you keep your iTunes library down to the size of what you can fit on
your iPod, you still have a formidable collection at your fingertips. If you're
a music lover and your music collection is getting large, you’ll want to
organize your collection to make finding songs easier.

In this chapter, we show you how to organize your songs in iTunes. You can
find any song in seconds and display songs sorted by artist, album, genre of
music, or other attributes. You can grab song information from the Internet
and add and edit the information to make organizing more useful. Grabbing
and editing the information is important because you don’t want your
imported CD music to have song titles like “Track 1” — you don’t want to
mistakenly play “My Guitar Wants to Kill Your Mama” by Frank Zappa when
trying to impress your classical music teacher with Tchaikovsky’s Pathétique
Symphony, 3rd Movement, do you?

This chapter also explains how to create playlists, which are lists of songs to
be played, transferred to an iPod, or burned to a CD. iTunes even offers
smart playlists — playlists that generate their own lists, without your help,
based on the song information (which is another good reason to edit the
information). You also find out how to make a backup of your library — a
very important operation, especially if you have music files on your hard
drives that are your only copies of the songs. For example, you may have
songs in the AAC format that you purchased from the iTunes Music Store
(so you don’t have the songs on CD), or you may have songs that you
recorded with GarageBand (see Book V for more about GarageBand).
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Been Searching . . . Browsing, and Sorting, Too

You rip a few CDs, buy some songs from the iTunes Music Store, and you
watch your music library fill up with songs. That song list keeps getting
longer and longer, and as a result, your library gets harder to navigate.
Selecting songs to play in a proper order also is harder. Shouldn’t a com-
puter be able to make these things easier? Of course it can.

Figure 2-1:
Click the
Browse
button to
browse the
iTunes
library.

Been Searching . . . Browsing, and Sorting, Too

Browsing by artist and album

You can switch to the Browse view to find songs more easily. The Browse
view is useful as long as you track information for the songs. You aren’t over-
whelmed by a long list of songs — when you select an album, iTunes displays

only the songs for that album.

To select the Browse view, click the Browse button in the upper-right corner.
iTunes organizes your music library by artist and album, which makes finding
just the right tunes easier, as shown in Figure 2-1. Click the Browse button
again to return to List view. Clicking the Browse button toggles between the

two views.
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The Browse view sorts the songs by artist, and within each artist’s group, by
album. This type of column arrangement is a called a tree structure, although

it looks more like a fallen tree to us.
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When you click an artist in the Artist column on the left side (as shown in
Figure 2-2), the album titles appear in the Album column on the right. At the
top of this Album column, the All selection is highlighted, and all of the
songs appear in the Song Name list.
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To see more than one artist’s albums at a time, hold down the 88 key and
click each artist’s name. iTunes displays all of the albums for the artists you
88 +click.

As you click different albums in the Album column, the Song Name list dis-
plays the songs from that album. The songs are listed in proper track order,
just as the artist intended them.

This arrangement is great for selecting songs from albums, but what if you
want to look at all the songs by that artist in the library at once? See all the
artist’s songs in the iTunes library by selecting the All option in the Artist
column. (Note that iTunes considers “Clash” and “The Clash” to be different
groups — we edit the artist name and other information whenever neces-
sary, as described in the “Speed editing multiple songs” section, later in this
chapter.) To see all the songs in your collection, return to the default List
view by clicking the Browse button.

Understanding the song indicators

As you make choices in iTunes, it displays an action indicator next to each
song to show you what iTunes is doing. Here’s a list of indicators and what
they mean:
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4+ Moving zigzag: iTunes is importing the song.
4 Green check mark: iTunes has finished importing the song.

4+ Exclamation point: iTunes can’t find the song. You may have moved or
deleted the song accidentally. Drag the song from the Finder to the
iTunes window.

4+ Broadcast icon: The song is on the Internet, and iTunes plays it as a
music stream.

4+ Black check mark: The songs are marked for the next operation, such as
importing from an audio CD or playing in sequence.

+

Speaker: The song is currently playing.

4+ Chasing arrows: iTunes is copying the song from another location or
downloading the song from the Internet.

Changing viewing options

iTunes gives you the ability to customize a song list. The list starts out with
the Song Name, Time, Artist, Album, Genre, My Rating, Play Count, and Last
Played categories — you may have to drag the horizontal scroll bar along
the bottom of the song list to see all these columns. You can display more or
less information, or different information, in your song list; you can also dis-
play columns in a different order from left to right, or with wider or narrower
column widths.

You can make a column wider or narrower by dragging the dividing line
between the column and the next column. As you move your cursor over the
divider, it changes to a double-ended arrow; you can then click and drag the
divider to change the column’s width.

You can also change the order of columns from left to right by clicking a
column header and dragging the entire column to the left or right.

Maybe you don’t like certain columns — they take up too much valuable
screen space. Or perhaps you want to display some other information about
the song. You can add or remove columns such as Size (for file size), Date
and Year (for the date the album was released, or any other date you choose
for each song), Bit Rate, Sample Rate, Track Number, and Comment. To add
or delete columns, choose Edit=>View Options.

The View Options dialog appears, as shown in Figure 2-3, and you can select
the columns you want to appear in the song list. To pick a column, select the
check box next to the column’s name. Any unchecked column headers are
columns that do not appear in the iTunes window. Note: The Song Name



Figure 2-3:
The viewing
options for
the song list.

35

Been Searching . . . Browsing, and Sorting, Too

column always appears in the iTunes window and can’t be removed, so it
doesn’t appear in the View Options dialog. You can also change the view
options by 8-+clicking any of the column headings in the songlist in either
Browse or List view.

View Options

Library
Show Columns
MAlbum : Grouping
M Artist [ Kind
: Beats Per Minute E Last Played
[ Bit Rate # My Rating
E Play Count

: Sample Rate

|| Comment

: Compaser
[}y Date Added
__! Date Modified

: Disc Number

: Size
@ Time
: Track Number

: Egualizer : Year

M Cenre

A\

The viewing options you choose depend on your music playing habits. You
may want to display the Time column to know at a glance the duration of
any song. You may want the Date or Year columns to differentiate songs from
different eras, or the Genre column to differentiate songs from different
musical genres.

You can also browse by genre in the Browse view, rather than by artist. To
add a Genre column to the Browse view, choose iTunes=Preferences and
click the General button at the top of the Preferences dialog. In the General
dialog that appears, select the Show Genre When Browsing option.

Sortmq songs by Vlernq optwns

Knowing how to set viewing options is a good idea because you can use the
viewing options to sort the listing of songs. Whether you're in Browse view

or viewing the song list in its entirety, the column headers double as sorting
options.

For example, clicking the Time header reorders the songs by their duration
in ascending order (from shortest to longest). If you click the Time header
again, the sort is reversed, starting with the longest song. This can be useful
if you are looking for songs of a certain length — for example, looking for a
song to match the length of a slideshow in iPhoto (see Book II) or a movie
clip in iMovie (see Book III).
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You can tell which way the sort is sorting — ascending or descending
order — by the little arrow indicator in the header. When the arrow is point-
ing up, the sort is in ascending order; when down, it is in descending order.

You can sort the song list in alphabetical order. Click the Artist header to
sort all the songs in the list by the artist name, in alphabetical order (the
arrow points up). Click it again to sort the list in reverse alphabetical order
(the arrow points down).

Searching for songs

As your music library grows, you may find locating a particular song by the
usual browsing and scrolling methods that we describe earlier in this chap-
ter to be time consuming. So . . . let iTunes find your songs for you!

Locate the Search field — the oval field in the top-right corner, to the left of
the Browse button — and follow these steps:

1. Click in the Search field, and then type the first characters of your
search term, using these tips for best searching:

* You can search for a song title, an artist, or an album title.

e Typing very few characters results in a long list of possible songs,
but the search narrows down as you type more characters.

e The Search features ignore case — for example, when we search for
miles, iTunes finds “Eight Miles High,” “She Smiles Like a River,” and
everything by Miles Davis.

The search operation works immediately, searching for matches in the
Song Name, Artist, and Album columns.

2. The results display as you type.

If you're in Browse view with an artist and a particular album selected,
you can’t search for another artist or song. Use browsing with searching
to further narrow your search.

3. Scroll through the search results and click a song to select it.

If you want to search the entire library, first click the All selection at the top
of the Artist column to browse the entire library, before using the Search
field. Or if you prefer, turn off the Browse view by clicking the Browse button
again, and use the Search field with the library’s song list.

To back out of a search so that the full list appears again, you can either
click the circled X in the Search field, or delete the characters in the Search
field. You then see the entire list of songs in your library, just as before. All
the songs are still there, and remain there unless you explicitly remove
them. Searching only manipulates your view of the songs.



The Singer, Not the Song: Adding and Editing Information 3 7

The Singer, Not the Song: Adding
and Editing Information

\\3

Organization depends on information. You expect the computer to do a lot
more than just store this music with “Untitled Disc” and “Track 1” as the
only identifiers. Song names, album titles, composer credits, and release
dates may seem trivial. But you can use the song information to search for
songs or sort song lists, and the information is absolutely necessary for
making smart playlists.

Adding all the song information seems like a lot of trouble, but that ol’ Mac
magic comes through for you. You can get most of the information automati-
cally, no typing necessary.

Retrieving information from the Internet

Why type song information if someone else has typed it? You can get infor-
mation about most commercial CDs from the Internet. However, you need to
check your Internet connection first.

During the setup process, you can control whether iTunes connects auto-
matically or manually to the Internet. In Chapter 1 of this minibook we
describe how, when you first start iTunes, the Setup Assistant helps you
through the process of setting iTunes up to connect to the Internet automati-
cally. You can change the setup of your Internet connection at any time by
following these steps:

1. Choose iTunes—Preferences.
The Preferences dialog appears.
2. Click the General button.

3. Select the Connect to Internet When Needed option.

When this option is selected, iTunes connects automatically; otherwise,
iTunes asks first before connecting to the Internet.

4. Click OK.

You can connect to the Internet at any time, if you're not automatically con-
nected, and get the song information when you need it. After you connect,
from the iTunes menu, choose Advanced=>Get CD Track Names.

Even if you automatically connect to the Internet, the song information data-
base on the Internet (known as Gracenote CDDB) may be momentarily
unavailable, or you may have a delayed response. If at first you don’t suc-
ceed, choose Advanced=>Get CD Track Names.
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Editing artist and band names

At some time or another you may want to edit artist and band names that
come in from the Internet. For example, for solo artists, we like to list the
artist by last name, rather than first name like the Gracenote CDDB does.
For example, we routinely change the name of the artist derived from CDDB,
which comes in as, “Miles Davis” because we’d rather have the artist name
be “Davis, Miles.”

Other annoyances often occur in the CDDB, such as bands that normally
have “The” in front of their names, such as The Who, The Band, The Beatles,
and The Beach Boys. We dislike having “The” before the band name, so we
routinely remove “The.”

You can edit a song’s information in either Browse view or List view. Edit a
song’s track information by clicking directly in the field, and clicking again so
that the mouse pointer turns into an editing cursor. You can then select the
text and type over it, or use 8+C (copy), #8+X (cut), and 38+V (paste) to
move tiny bits of text around within the field. As you can see in Figure 2-4,
we changed the Artist field to “Beck, Jeff.”
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Song Mame Time Artist A
o & Hi Ho Silver Lining zs3 [
% Radio # Tally ban 246 Jeff Beck
@ Music Store # Beck's Bolero 2:51  Jeff Beck
|g| 60's Music # shapes Of Things 321 |eff Beck
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e IS f| Dead-live
. & # Blues De Luxe 732 Jeff Beck
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We prefer working directly with the song list (with Browse view turned off)
when editing song information.

You can edit the Song Name, Artist, Album, Genre, and My Ratings fields
right in the song list. But editing this information by choosing File>Get Info
is easier. Keep reading to find out more.
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Automatic dialup

If your computer uses a modem, iTunes triggers
the modem automatically (like a Web browser).
It can call your Internet service provider and
complete the connection process before
retrieving the track information.

At that point, your Internet service may still be
on until the service hangs up on you. You may
want to switch to a browser, without quitting
iTunes, and surf the Web to make use of the

connection — iTunes continues to import or
play the music while you surf.

You can stop an automatic modem connec-
tion as quickly as possible — if your service
provider or phone service charges extra fees
based on timed usage. When iTunes finishes
importing, switch to your remote connection
program without quitting iTunes, terminate the
Internet connection, and then switch back to
iTunes.

2

WING/

Speed editing multiple songs

Editing in the song list is fine if you're editing the information for one song,
but typically you need to change all the tracks of an audio CD. For example,

if a CD of songs by Bob Dylan is listed with the artist as “Bob Dylan,” you

may want to change all the songs at once to “Dylan, Bob.” Changing all the
song information in one fell swoop, of course, is fast and clean, but like most

powerful shortcuts, you need to be careful because it can be dangerous.

You can change a group of songs in either Browse view or List view. To
change a group of songs at once, follow these steps:

1. Select a group of songs by clicking the first song and then holding
down the Shift key as you click the last song.

All the songs between the first and last are highlighted. You can add to a
selection by Shift+clicking other songs, and you can remove songs from
the selection by 88+clicking.

2. Choose Filer>Get Info or press 38+1.

A warning message displays Are you sure you want to edit
information for multiple items?

Like speed skating, speed editing is dangerous. If, for example, you
change the song name, the entire selection then has that song name. Be
careful about what you edit when doing this. We recommend leaving the

Do Not Ask Me Again warning option deselected, so that the warning
appears whenever you try this.

3. Click the Yes button.

The Multiple Song Information dialog appears, as shown in Figure 2-5.
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Multiple Song Information
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4. Edit the field you want to change (typically the Artist field) for the
multiple songs.
When you edit a field, a check mark appears automatically in the check
box next to the field. iTunes assumes you want that field changed in all
the selected songs. Make sure that no other check box is selected except
the field you want, which is typically the Artist field (and perhaps the
Genre field).
5. Click OK to make the change.
iTunes changes the field for the entire selection of songs.
P You can edit the song information before importing the audio tracks from a

CD. The edited track information for the CD imports with the music. (What’s
interesting is that when you access the library without the audio CD, the
edited version of the track information is still there — iTunes remembers CD
information from the CDs you inserted before. Even if you don’t import the
CD tracks, iTunes remembers the edited song information until the next time
you insert that audio CD.)

Adding liner notes and ratings

Although the track information grabbed from the Internet is usually enough,
you probably won'’t find the track information to be complete, or that it
matches your personal taste. Your ratings and genre choices make creating
playlists automatically possible (as described later in this chapter).
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Mac was like magic. iTunes, after thinking fora  database keeps track information for most of ;;'- =3
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album title, and artist names automatically.
How did it know? This information isn’t stored
on a standard music CD — iTunes has to either
recognize the disc somehow or read the liner
notes.

The magic is that the software knows how to
reach out and find the information on the
Internet, in a music database known as
Gracenote CDDB (CDDB stands for CD
Database). The site (www.gracenote.com)
that hosts Gracenote CDDB on the Web offers
the abhility to search for music CDs by artist,
song title, and other methods. The iTunes soft-
ware already knows how to use this database,
so you don't have to!

iTunes finds the track information by first look-
ing up a key identifying number on the audio
CD — a secret number stored on every publicly
released music CD. iTunes uses this number to

cial market.

Although the database doesn’t contain any
information about personal or custom CDs,
people can submit information to the data-
base about CDs that the database doesn't
know about. You can even do this from within
iTunes — type the information for each track
while the audio CD is in your Mac, and then
choose Advanced=>Submit CD Track Names.
The information you typed is sent to the
Gracenote CDDB site, where the good people
who work tirelessly on the database check out
your information before including it. In fact, if
you spot a typo or something erroneous in the
information you receive from Gracenote, you
can correct it, and then use the Submit CD
Track Names command to send the corrected
version back to the Gracenote site. The good
folks there appreciate the effort.

Some facts, such as composer credits, may not be included in the informa-
tion grabbed from the Internet. However, composer information is important
for iPod users, because the iPod allows you to scroll music by composer as
well as by artist, album, and song. Adding composer credits is usually worth
your while because you can then search, sort, and create playlists based on
this information.

After your songs import into the music library, locate a single song and
choose File>Get Info (or press 3+I). You see the Song Information dialog, as
shown in Figure 2-6. The Song Information dialog offers the following tabs:

4+ Summary: The Summary tab offers useful information about the music
file’s format and location on your hard drive, its file size, as well as infor-
mation about the digital compression method (bit rate, sample rate, and
so on). You can read more about compression methods in Chapter 3 of
this minibook.
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Figure 2-6:
View and
edit the
song
information.
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4+ Info: The Info tab allows you to change the song name, artist, composer,
album, genre, and year, and you can also add comments.

4+ Options: The Options tab offers volume adjustment, choice of equalizer
preset, ratings, and start and stop times for each song. We describe
these settings in Chapter 3 of this minibook. You can assign a rating of
up to five stars to a song (your own rating system, equivalent to the Top
40 charts).

4+ Artwork: The Artwork tab enables you to add or delete artwork for the
song (the Apple Music Store supplies artwork with most songs).

You may have noticed the My Top Rated playlist in the Source list. This play-
list is an example of a smart playlist — a playlist that updates when ratings
are changed. The My Top Rated playlist plays all the top-rated songs in the
library.

The cool thing about ratings is that they’re yours. You can use them to mean
anything you want. For example, you may rate songs based on how much you
like them, or whether your mother would listen to them, or how they blend
into a work environment. Then you can use the My Top Rated playlist to auto-
matically play the top-rated songs in the library. You find out more about
playlists later in this chapter, in the section, “Generating a Smart Playlist.”
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To organize your music for different operations, such as copying to an iPod
or burning a CD, you make a list of the songs called a playlist. You can also

use playlists to organize your music and act as a DJ. Make a playlist of love g =
songs from different albums to play the next time you need a romantic ;"§
mood. Compile a playlist of surf songs for a trip to the beach. We create g
playlists specifically for use with an iPod on road trips and other playlists 3 a

that combine songs from different albums based on themes or similarities.

You can create as many playlists of songs, in any order, as you want. The
song files don’t change, nor are they copied — the music files stay right
where they are, only their names are stored in the playlists. You can even
create a smart playlist that automatically adds songs to the playlist based on
the criteria you set up, and removes songs from the playlist that don’t match
the criteria.

Creating a playlist of multiple songs

The Mac was made for this: dragging items visually to arrange a sequence.
Save yourself a lot of browsing time by creating playlists (which, by the way,
can really improve the way you use music with an iPod). You can drag indi-
vidual songs and entire albums into a playlist and rearrange the songs
quickly and easily. To create a playlist, follow these steps:

1. Click the + button or choose File->New Playlist.

The + button, in the bottom-left corner of the iTunes window under the
Source list, creates a new playlist in the Source list named “untitled
playlist.”

2. Type a descriptive name for the playlist.

The playlist appears in the Source list, as shown in Figure 2-7. After you
type a new name, iTunes automatically sorts it into alphabetical order in
the Source list, underneath the preset smart playlists and other sources.

3. Select the library in the Source list and then drag songs from the
library to the playlist.

4. Select the playlist in the Source list and then drag songs to rearrange
the list.

The order of songs in the playlist is based on the order in which you
drag them to the list. To move a song up the list and scroll at the same
time, drag it over the up-arrow in the first column (the song number); to
move a song down the list and scroll, drag it to the bottom of the list.
You can move a group of songs at once by selecting the group (either by
clicking the first song and Shift+clicking the last song, or by 8+clicking
songs to select a noncontiguous group).
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You can drag songs from one playlist to another playlist. Remember: Only
links are copied, not the actual files. Besides dragging songs, you can also
rearrange a playlist by sorting the list — click the Song Name, Time, Artist
column headings, and so on. And when you double-click a playlist, it opens
in its own window, displaying the song list.

To create a playlist quickly, select the group of songs that you want to make
into a playlist (Shift+click or 8+click to select the group), and then choose
Filec>New Playlist from Selection. A new playlist appears in the Source list,
and you can then type a name for the playlist.

Creating a playlist of multiple albums

You may want to play entire albums of songs without having to select each
album as you play them. You may want to use an iPod, for example, on that
long drive from London to Liverpool, and play Beatles albums in the order
they were released (or perhaps the reverse order, reversing the Beatles’
career from London back to Liverpool).

To create a playlist of entire albums in a particular order, follow these steps:

1. Create a new playlist.

Create a playlist by clicking the + sign under the Source list, or choosing
File>New Playlist. Type a descriptive name for the new playlist.

2. Select the library in the Source list and then click the Browse button
to find the artist.

The Album list appears in the right panel.
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3. Drag the album name over the playlist name.

4. Select and drag each subsequent album over the playlist name.
Each time you drag an album, iTunes automatically lists the songs in the
proper track sequence.

You can rename a playlist at any time by clicking its name and typing a new
one, just like you would rename any filename in the Finder.

Generating a Smart Playlist

At the top of the Source list, indicated by a gear icon, you can find what
Apple (and everyone else) calls smart playlists. iTunes comes with a few
sample smart playlists, such as the My Top Rated playlist we mention earlier
in this chapter, and you can create your own. Smart playlists add songs to
themselves based on prearranged criteria. For example, as you rate your
songs, the My Top Rated playlist changes to reflect your new ratings. You
don’t have to set anything up — My Top Rated is already defined for you.

The smart playlists are actually ignorant of your taste in music. You can
create one that grabs all the songs from 1966, only to find that the list
includes “Eleanor Rigby,” “Strangers in the Night,” “Over Under Sideways
Down,” and “River Deep, Mountain High” (in no particular order) — which
you may not want to hear at the same time. You may want to fine-tune your
criteria.

Viewing and editing a smart playlist

To view and edit a smart playlist, select the playlist and choose Filem>Edit
Smart Playlist. The Smart Playlist dialog appears, with the criteria for the
smart playlist. You may want to modify the smart playlist so that songs with
a higher rating are picked — simply add another star or two to the My Rating
criteria. You can also choose to limit the playlist to a certain number of
songs, selected by various methods such as random, most recently played,
and so on.

Setting up a new smart playlist

To create a new smart playlist, choose File>oNew Smart Playlist. The Smart
Playlist dialog appears, giving you the following choices for setting criteria:

4+ Match the Following Conditions: You can select from the first pop-up
menu any of the categories used for song information, and from the
second pop-up menu, you select an operator, such as the greater than or
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less than operators. The selections you make in these two pop-up menus
combine to express a condition such as Year is greater than 1966
or something like that. You can also add multiple conditions by clicking
the + button, and then deciding whether to match all or any of these
conditions.

4+ Limit To: You can make the smart playlist a specific duration, measured
by the number of songs, time, or size in megabytes or gigabytes. Limiting
a smart playlist to what can fit on a CD, or for the duration of a drive or
jogging exercise with an iPod is useful. You can select the songs by vari-
ous methods such as random, most recently played, and so on.

4+ Match Only Checked Songs: This selects only songs that have a black
check mark beside them, along with the rest of the criteria. Checking
and unchecking songs is an easy way to fine-tune your selection for a
smart playlist.

4+ Live Updating: This allows iTunes to automatically update the playlist
continually, as you add or remove songs from the library.

After setting up the criteria, click OK to create the smart playlist. iTunes cre-
ates the playlist with a gear icon and the name “untitled playlist.” You can
then click in the playlist and type a new name for it.

Setting up multiple criteria gives you the opportunity to create playlists
that are way smarter than the ones supplied with iTunes. For example, we
created a smart playlist with criteria shown in Figure 2-8 that does the
following:

4+ Adds any song added to the library in the past week that also has a
rating greater than three stars.

4+ Limits the playlist to 72 minutes of music to fit on an audio CD and
refines the selection to the most recently added if the entire selection
becomes greater than 72 minutes.

4+ Matches only checked songs and performs live updating.

Smart Playlist

@ Match all 4 !of the following conditions:
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If you hate to be disorganized, you’'ll love iTunes and its nice, neat file stor-
age methods. iTunes, by default, stores your music library inside your home
folder — the path to this folder is typically your home folder/Music/iTunes/.
Inside this folder is an iTunes Music folder. All songs you import are stored
in the iTunes Music folder. Even music files you drag to the iTunes window
are stored here — iTunes makes a copy and stores the copy in the iTunes
Music folder.

You can change where iTunes stores your music library by choosing
iTunesPreferences, clicking Advanced, and clicking the Change button,
which lets you select another location.

If you access Web radio and shared libraries on a network, you probably
have music in your library that is not actually in your library at all — it can
be streamed to your computer over the Internet, or be part of a shared
library or playlist on a network, as we describe later in this chapter.

You can find the location of any song by selecting the song and choosing
File>Get Info, and then clicking the Summary tab in the Song Information
dialog. Look in the Kind section. If you see remote, then the song is not on
your hard drive. If you have songs in different locations — on different hard
drives connected to the same Mac, or shared over a network, you can have
iTunes consolidate your music library by copying everything into the iTunes
Music Library folder. By consolidating your library first, you make sure that
your backup is complete.

To consolidate your music library, choose Advanced=>Consolidate Library.
The original songs remain where they are, but copies are made in your music
folder.

To copy the music files in your library to another hard drive, locate the
iTunes folder using the Finder. Drag this entire folder to another hard drive
or backup device, and you're all set. Note, however, that this action copies
the music itself, not your playlists. You still have to export your playlists.

You can export a playlist and import it into a different computer in order to
have the same playlist in both places. Select the playlist and choose
FilecoExport Song List, choose the XML option from the Format pop-up menu
in the Save: iTunes dialog, and click the Save button. When you export a
playlist, you get a list of songs in the XML (Extensible Markup Language)
format, but not the songs themselves — you still need to copy the actual
song files to the other computer. You can then import the playlist into
iTunes on the other computer by choosing FileImport, selecting the XML
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file, and clicking the Choose button. You can also export all the playlists in
your library at the same time by choosing Filec>Export Library, and then
import them into iTunes on the other computer by choosing File=> Import
and selecting the exported XML file.

The copy operation may take some time if the library is huge — you can
stop the operation anytime, but the newly copied library may not be com-
plete. Allowing the copy operation to finish is always best.

If you subscribe to the Apple .Mac service, you can use its Backup software.
With Backup, which comes with a .Mac membership, you can quickly and
easily store important files on your iDisk. For information about Mac OS X
backup procedures and the .Mac service, see the excellent book titled

Mac OS X All-in-One Desk Reference For Dummies by Mark L. Chambers
(published by Wiley).

To copy your entire music library to another Mac, follow these steps:

1. Locate your iTunes Music folder in the Finder in your old Mac.

Locate your iTunes folder, which is usually within the Music folder in
your home folder. Inside the iTunes folder is the iTunes Music folder,
which contains your music library.

2. If the new Mac has a music library, move the music folders inside the
iTunes Music folder to another folder, or copy them to another hard
drive and delete the original files.

If the music library is empty, you can skip this step.

3. Copy the iTunes Music folder from the old Mac to the iTunes folder of
the new Mac.

The iTunes Music folder contains all the music files.

4. On the old Mac, choose FilecoExport Library, browse to a location on
your hard drive or network, and click the Save button.

When you export your entire library, iTunes creates an XML file that
contains all the playlist information and links to music files.

5. Start iTunes on the new Mac.

6. Choose File’ Import, select the Library.xm] file, and click the
Choose button.

The music library is now available on the new computer.
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Sharing Music (Legally) Chaptor2

You want to protect your investments in music. If you buy music online, you
want to be able to play the music anywhere, and even share the music with

your friends. You can easily share the music you rip yourself from CDs. You g =
can also share, to a limited extent, the music you buy online from Apple. ;‘3
= =)
=
Apple uses a protected form of the AAC encoder for the songs in its online 3 a

store. The rights of artists are protected while also giving you more leeway
in how to use the music more than most other services (though by the time
you read this, other services may have adopted this format with similar
privileges).

Some of the features Apple offers through the Apple Music store are the
following:

4+ Creating backups: Easily create backups by copying music several
times.

4+ Copying music: Play songs on three separate computers. See Chapter 1
of this minibook for more info.

4+ Sharing music over a network: Everyone on a network (such as the
Apple wireless AirPort network) can play the music.

Whether or not you manage files on your hard drive on a regular basis, you
may want to know where these songs are stored, so that you can copy music
to other computers and make a backup of the entire library. You may also
need to copy or move the library when you get a new Mac — after all, these
Macs just keep getting better year after year. You can play your purchased
music on any authorized computer — you can authorize up to three comput-
ers at once, and you can remove authorization from the computer(s) you
don’t use anymore.

Copying songs to other computers

“‘Q,N\BEI? You can copy as much music as you want. If the songs are in the protected
& AAC format (bought from the online music store), you can copy them to
another computer, but you can’t play them on that computer unless, of
course, the computer is authorized to do so.

Using the Finder, you can copy songs freely from your iTunes Music folder to
other folders, other hard drives, and other computers. You can use iTunes to
copy music to devices such as the iPod. We describe the iPod in Book VI.
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| fought the law and the law won:
Sharing and piracy

Apple CEO Steve Jobs gave personal demon-
strations of the Apple Music Store, iTunes, and
the iPod to Paul McCartney and Mick Jagger.
According to Steven Levy at Newsweek
(May 12, 2003), Jobs said, “They both totally get
it.” The former Beatle and the Stones front-
man are no slouches — both conduct music-
business affairs personally and both have
extensive back catalogs of music. They know
all about the free music swapping services on
the Internet, but they agree with Jobs that you
will be willing to pay for high-quality music
rather than download free copies of question-
able quality.

We agree with the idea, also promoted by Jobs,
that technology should not be treated as the
culprit with regard to violations of copyright
law. Conversely, technology should not be used
as a solution to piracy, because determined
pirates will circumvent it with newer technol-
ogy, and only consumers are inconvenienced.

We're not lawyers, but we think the law already
covers the type of piracy that involves counter-
feiting CDs. The fact that you are not allowed to
copy a commercial CD and sell the copy to
someone else makes sense. You also can't sell
the individual songs of a commercial CD.

Giving music away is, of course, the subject of
much controversy, with some file-sharing serv-
ices closed by court order while others flour-
ish in countries that don't have copyright laws
as strict as the United States. Nothing in the
Apple realm of technology enables the sharing
of music at this level — you have to hack it
somehow — so we don't need to go into it,
except to provide one observation: The songs
we hear from free sharing services such as

KaZaa have, for the most part, been low qual-
ity, on a par with FM radio broadcasts. Nice for
listening to new songs to see if we like them
but not useful for acquiring as part of our real
music collection. The Apple Music Store is
clearly superior in quality and convenience,
and we prefer the original, authorized version
of the song, not some knock-off that may have
been copied from a radio broadcast.

As for making copies for personal use, the law
is murky at best. It depends on what you mean
by personal use. The iLife package allows you
to use these music files in creative projects.
You can, for example, put together a music
video to show your friends by using iMovie to
combine some video footage you shot with your
camcorder and the latest hit by Eminem. But
don't expectto see it on MTV or VH1. Your local
public access cable TV station can't even play
it, unless you obtained the broadcast rights,
which typically includes contacting the music
publisher, the record label, and the artist —
good luck.

Can you legally use a pop song as a soundtrack
for a high school yearbook slideshow? It
sounds legal to us, given the ability to use
music for educational purposes, but that is a
question only a lawyer can answer. If you're
interested in obtaining the rights to music
to use in semi-public or public presentations,
or even movies and documentaries for public
distribution, you can contact the music pub-
lisher or a licensing agent. Music-publishing
organizations, such as the Music Publishers’
Association (www . mpa . org), offer information
and lists of music publishers, as well as expla-
nations of various rights and licenses.
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The files are organized in folders by artist name and by album within the
iTunes Music folder. Copying an entire album, or every song by a specific
artist, is easy. You can find the location of any song by selecting the song
and choosing File>Get Info. Click the Summary tab in the Get Info dialog to
see the Summary pane.

To use iTunes music with iPhoto, iMovie, or iDVD, you don’t have to copy any-
thing or do anything. When you open any of the iLife applications, your iTunes
music library is automatically available from within the other iLife application.

Sharing music in a network

If you live like the Jetsons, the TV cartoon family of the future — with a Mac
in every room, connected by wireless or wired network — iTunes is made for
you. You can share the music in your library with up to five other computers
in the same network. You can even do this with music from the Apple Music
Store.

When you share songs on a network, the song is streamed from the Mac that
contains the songs in its library (the library Mac) to your computer over the
network — the song is not copied to your music library. From your computer,
you can’t burn the shared songs to a CD or copy the shared songs to an iPod.
You can, of course, do those things on the library Mac.

You can share radio links, MP3, AIFF, and WAV files, and even AAC files and
music purchased from the Apple Music Store, but not Audible spoken word
files or QuickTime sound files. If you have a large network (such as an office
network), check to make sure the computers share the same subnet. The
computers need to be within the same subnet to share music.

To share your music library, turning your Mac into the library Mac, follow
these steps:
1. Choose iTunes->Preferences and click the Sharing button.

The Sharing tab of the Preferences dialog appears, showing the options
for sharing music.

2. Select the Share My Music option.

3. Select either the Share Entire Library option or the Share Selected
Playlists option and choose the playlists to share.

4. Type a name for the shared library and add a password if you want.

The name you choose appears in the Source list for other computers
that share it. The password restricts access to those who know it. Use a
password you don’t mind letting others know — not the password for
the online music store or any other secret password.

5. Click OK.
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On the other computers on the network, you can access the music by
following these steps:
1. Choose iTunes->Preferences and click the Sharing button.

The Sharing tab of the Preferences dialog appears, with options for
sharing music.

2. Select the Look for Shared Music option and then click OK.
The shared libraries or playlists appear in the iTunes Source list.

3. Click the shared library or playlist to play it.



Chapter 3: Enhancing the Audio

In This Chapter

v+ Importing and converting music using custom import settings
1 Getting the best quality and space trade-offs with music files

v Using the equalizer and assigning presets to songs

ust a century ago, people would gather at phonography parties to listen

to a new invention called a phonograph, the predecessor to the record
player. Before records, radio, and jukeboxes, the phonograph was the only
source of prerecorded music, and the quality of the sound must have been
awful by today’s standards.

The choices of formats for sound have changed considerably from the frag-
ile 78-rpm records from the phonography parties to the scratchy 45-rpm and
33-rpm records to today’s CDs. Consumers had to be on the alert then, as
you do now, for dead-end formats that could lock up music in a cul-de-sac of
technology, never to be played again. You know what we’re talking about —
dead-end formats like the ill-fated eight-track cassette, or the legendary
quadraphonic LP.

You want your digital music to last forever and play at high quality on future
players as well as today’s players. You also want to take advantage of the
compression technology that squeezes more music onto players than ever
before. This chapter provides our suggestions for the importing preferences
for ripping CDs that provide the highest quality and the best use of compres-
sion technology. You may be quite happy with the results using these sugges-
tions. But listening pleasure depends entirely on the listener, and some people
can hear qualitative differences that others don’t hear or don’t care about.

You can specify quality settings to your liking, but as you discover more about
digital audio technology, you'll find that you have decisions to make about
your music library. This chapter helps you make them. For example, you may
be tempted to trade quality for space by importing music at average-quality
settings that allow you to put more songs on your hard drive and iPod than if
you chose higher-quality settings. This may make you happy today, but what
about tomorrow, when iPods and hard drives double or triple in capacity?

On the other hand, you may be very picky about the sound quality and, with
an eye toward future generations of iPods and cheaper hard drives, decide
to trade space for quality, importing music at the highest possible quality
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settings and then converting copies to lower-quality, space-saving versions
for iPods and other uses. Of course, you need more hard drive space to
accommodate the higher-quality versions.

This chapter explains which music encoding and compression formats to use
for higher quality, and which to use for cramming more songs into the same
amount of hard drive space. It also covers importing sounds other than music,
converting songs from one format to another, enhancing music with the built-
in equalizer, and saving equalizer settings with songs. You'll impress your
audiophile friends, even ones who couldn’t believe that iTunes is capable of
reproducing magnificent music.

Deciding Your Encoding Format

WMBER
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The encoding format and settings you choose for importing music when rip-
ping a CD affect sound quality, hard drive space (and iPod space), and com-
patibility with other types of players and computers. You may want to change
your import settings before ripping CDs depending on the type of music, the
source of the recording, or other factors, such as whether you plan to burn
an audio CD or listen to the music on a portable player such as the iPod. We
describe in detail how to change your import settings in the section, “Chang-
ing Encoders and Settings,” later in this chapter.

Some encoding formats compress the music, while others do not. Compres-
sion reduces the sound quality because it throws away information to make
the file smaller. The amount of compression depends on the bit rate you
choose, as well as the encoding format and other options.

Without getting too technical (as we do later in this chapter), more compres-
sion means the files are smaller but music quality is poorer. Less compression
means better quality, but the files are larger. You can therefore trade quality
for space, and have more music of lower quality, or trade space for quality,
and have less music of higher quality.

Power also is an issue. In iPods, playing larger files takes more power because
the hard drive inside the iPod has to refresh its memory buffers more quickly
to process more information as the song plays — you might even hear hiccups
in the sound.

We prefer a higher-quality sound overall, and we typically don’t use the lower-
quality settings for encoders except for voice recordings. We can hear differ-
ences in music quality at the higher compression levels and would rather go
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out and buy another hard drive if necessary to store more music. But iTunes
gives you the choice in the Import Using pop-up menu in the Importing dialog
(which you get to from the Preferences dialog). This is perhaps the most
important choice. You can choose one of four encoders (see the sidebar,
“AAC, MP3, and AIFF” for more detailed descriptions):

4+ AAC Encoder: Used for songs in the Apple Music Store — we recommend
it for all uses except burning new audio CDs (see AIFF).

4+ AIFF Encoder: Use AIFF if you plan on burning the song to an audio CD,
the most universal music format, because it offers the highest possible
quality. The files occupy lots more space than AAC or MP3 files because
they are not compressed.

4+ MP3 Encoder: Supported in most computers and some CD players —
use the MP3 format for songs you intend to send to others or to use with
MP3/CD players or applications that support MP3.

4+ WAV Encoder: WAV is the high-quality sound format used on PCs (like
AIFF). The files occupy lots more space than AAC or MP3 files because
they are not compressed. Use WAV if you plan on burning the song to an
audio CD or using the song with PCs.

If you use an MP3 player other than an iPod, you want to either import or
convert songs with the MP3 encoder. If you use an iPod or play music on the
Mac, you can use the higher-quality AAC encoder to produce files that are
either the same size as their MP3 counterparts but higher in quality, or at
the same quality but smaller in size.

To have the best possible quality you can have for future growth, you may
consider not using compression at all, and not compromising on quality. You
can import music at the highest possible quality — using the uncompressed
AIFF or WAV encoders — and then convert the music files to a lesser-quality
format for use in the iPod or other devices. We describe how to convert
music later in this chapter in the section, “Converting songs to other
encoders.”

You can import a CD using one encoder, and then import the CD again using
a different encoder as long as you change the name of at least one of the
imported CDs to identify it (you can always tell by its settings, as described
in Chapter 2 of this minibook). You can always delete the repetitive album
after you transfer it into another application (such as the iPod) to reclaim
hard drive space.
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AAC, MP3, and AIFF

We intend to leapfrog years of technospeak
about digital music file formats and get right to
the ones you need to know about:

AAC: The iTunes Music Store file format, known
as MPEG-4 Advanced Audio Coding, is a higher
quality format than MP3, comparable to CD qual-
ity (MPEG stands for Moving Pictures Experts
Group, a body that recognizes compression
standards for video and audio). We think it offers
the best trade-off of space and quality. All your
purchased music from the iTunes Music Store
comes in this format. Itis suitable (though not as
good as AIFF) for burning to an audio CD and
excellent for playing in an iPod or from a hard
drive. However, as of this writing, only Apple
supports the AAC format.

AIFF: The Audio Interchange File Format is the
standard digital format for uncompressed sound
on a Mac and provides the highest quality rep-
resentation of the sound. Use AIFF if you plan to
burn songs to an audio CD. Mac-based digital
sound editing programs import and export AIFF
files, and you can edit and save in AIFF format
with absolutely no loss in quality. The downside
is that AIFF files take up enormous amounts of
hard drive (and iPod) space because they're
uncompressed.

MP3: The MPEG-1, Layer 3 format, also known
as MP3, is supported in most applications on
most computers. Use the MP3 format for songs
you intend to send to others or use with MP3
players. The MP3 format offers quite a lot of dif-
ferent compression and quality settings, so you
can fine-tune the format to get better quality,
sacrificing hard drive (and iPod) space as you
dial up the quality. Use the MP3 format for a
song you intend to burn on an MP3 CD (AIFF or
WAV formats are better for regular audio CDs).

WAV: Waveform Audio File Format is a digital
audio standard that Windows-based PCs can

understand and manipulate. Like AIFF, WAV is
uncompressed and provides the highest quality
representation of the sound. Use WAV if you
plan on burning the song to an audio CD or using
it with PC-based digital sound editing programs,
which import and export WAV files. WAV files
take up enormous amounts of space on hard
drives and iPod because they're uncompressed.

DVD-audio: DVD-audio is a relatively new digi-
tal audio format developed from the format for
DVD video. DVD-audio is based on PCM record-
ing technology but offers improved sound qual-
ity by using a higher sampling frequency and
longer word lengths. iTunes does not yet directly
support the DVD-audio format, but you can
import a digital video file containing DVD-audio
sound into iMovie (as described in Book IlI,
Chapter 2), extract the sound, and export the
sound in AIFF or WAV format for use with
iTunes.

Super Audio CD (SACD): The Super Audio CD is
a new format developed from the past audio
format for CDs. The SACD format is based on
Direct Stream Digital (DSD) recording technol-
ogy that closely reproduces the shape of the
original analog waveforms to produce a more
natural, higher-quality sound. Originally devel-
oped for the digital archiving of priceless analog
master tapes, DSD is based on 1-hit sigma-
delta modulation, and operates with a sampling
frequency of 2.8224 MHz (64 times the 44.1 kHz
used in audio CDs). Philips and Sony have
adopted DSD as the basis for SACD, and the
format is growing in popularity among audio-
philes. However, iTunes does not support SACD.
If you buy a music product in the SACD format,
choose the hybrid format that offers a conven-
tional CD layer and a high-density SACD layer.
You can then import the music from the con-
ventional CD layer.
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Changing Encoders and Settings

\\3

If you want to change your encoder and quality settings before you rip an
audio CD, follow these steps:

1. Choose iTunes->Preferences, and then click the Importing button.

The Importing dialog appears, where you can make changes to the encod-
ing format and its settings.

2. Choose the encoding format you want to convert the song into and
select the settings for that format.

Use the pop-up menus to make your changes. The Setting pop-up menu
offers different settings depending on your choice of encoder in the
Import Using pop-up menu. See the sections on each encoding format
later in this chapter for details on settings.

3. Click OK to accept changes.

After changing your importing preferences, and until you change them
again, iTunes uses these preferences whenever it imports or converts
songs.

Using the AAC encoder

We recommend using the AAC encoder for everything except music you
intend to burn on an audio CD. AAC offers the best trade-off of space and
quality for hard drives and iPods.

The Setting pop-up menu for the AAC encoder offers only two choices: High
Quality and Custom (see Figure 3-1). You may want to use the High Quality set-
ting for most music, but for complex music (such as jazz and classical), you
may want to select Customs to fine-tune the AAC encoder settings.

To customize your AAC encoder settings, choose Custom from the Setting
pop-up menu to see the AAC Encoder dialog, as shown in Figure 3-2. The
custom settings for AAC allow you to change the following:

4+ Stereo Bit Rate: This pop-up menu allows you to select the bit rate, which
is measured in kilobits per second (Kbps). Use a higher bit rate for higher
quality, which, of course, increases the file size. 320 Kbps is the highest-
quality setting for this format; 128 Kbps is considered high quality.

4+ Sample Rate: This pop-up menu enables you to select the sample rate,
which is the number of times per second the sound waveform is cap-
tured digitally (or sampled). Higher sample rates yield higher-quality
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sound and large file sizes. However, never use a higher sample rate than
the rate used for the source. CDs use a 44.100 kHz rate, so choosing a
higher rate is unnecessary unless you convert a song that was recorded
from digital audio tape (DAT) or directly into the Mac at a high sample
rate, and you want to keep that sample rate.

4 Channels: This pop-up menu enables you to choose how you want the
music to play through speakers — in stereo or mono. Stereo, which offers
two channels of music for left and right speakers, is the norm for music.
Mono — monaural or single-channel — was the norm for pop records
before the mid-1960s. (Phil Specter was known for his high-quality monau-
ral recordings, and the early Rolling Stones records are in mono.) Monau-
ral recordings take up half the space of stereo recordings when digitized.
Choose the Auto setting to have iTunes use the appropriate setting for

the music.
<\P
We recommend selecting the highest bit rate in the Stereo Bit Rate pop-up
menu and leaving the other two pop-up menus set to Auto.
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Figure 3-3:
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the settings
for the MP3
encoder.
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Using the MP3 encoder

Although we prefer the AAC encoder for quality, as of this writing, most MP3
players (other than iPods) don’t support AAC. You may want to use the MP3
encoder for other reasons, such as more control over the compression param-
eters and compatibility with other applications and players that support MP3.

The MP3 encoder offers four choices for the Setting pop-up menu in the
Importing dialog:

4+ Good Quality (128 Kbps): Certainly fine for audio books, comedy
records, and old scratchy records. You may even want to go lower in bit
rate (Kbps stands for kilobits per second) for voice recordings.

4+ High Quality (160 Kbps): Most people consider this high enough for
most popular music, but we go higher with our music.

4+ Higher Quality (192 Kbps): High enough for just about all types of music.

4+ Custom: To fine-tune the MP3 encoder settings, choose the Custom set-
ting, as shown in Figure 3-3. Customizing your MP3 settings increases
the quality of the sound while also keeping file size low.

MP3 Encoder

Stereo Bit Rate: | 192 -kb_ps_ T!

@kUse Wariable Bit Rate Encoding (VBR)

Quality: [ Highest

(with WER enabled, bit rate settings are used for a guaranteed minimum bit rate.)

Sample Rate: = Auto % l
Channels: " Auto T{

Sterea Mode: | Normal

™ smart Encoding Adjustments

@ Filter Frequencies Below 10 Hz

————————— ———
{ Use Default Settings | { Cancel ) @

The MP3 encoder offers a bunch of choices in its custom settings dialog
(refer to Figure 3-3):

4+ Stereo Bit Rate: This pop-up menu’s choices are measured in kilobits
per second (Kbps); select a higher bit rate for higher quality, which, of
course, increases the file size. The most common bit rate for MP3 files
you find on the Web is 128 Kbps. Lower bit rates are more appropriate
for voice recordings or sound effects. We recommend at least 192 Kbps
for most music, and we use 320 Kbps, the maximum setting, for songs
we play on our iPods.
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Figure 3-4:

4+ Use Variable Bit Rate Encoding (VBR): This option helps keep file size

down, but quality may be affected. VBR varies the number of bits used
to store the music depending on the complexity of the sound. If you
select Highest from the Quality pop-up menu for VBR, iTunes encodes at
up to the maximum bit rate of 320 Kbps in sections of songs where the
sound is complex enough to require a high bit rate, while keeping the
rest of the song at a lower bit rate to save file space. The lower limit is
set by the rate you chose in the Stereo Bit Rate pop-up menu (shown in
Figure 3-4). Some audiophiles swear by it, while others don’t ever use it.
We use it only when importing at low bit rates, and we set VBR to its
highest quality setting.

MP3 Encoder

Stereo Bit Rate: | 182 _prs Lowest

T Low (VBR)
sevaral  Medium Low
Select the Quality: | ¥ Medium |
Use Variable (With ¥BR enabled, bit rate settings are ust ﬁ_edhlum High  fum bt rae 1
. — ig
Bit Rate Sample Rate _Mw—m
EnCOdmg Channels M——
(VBR) check —_—— T
Stereo Mode: (Normal &)
box to get
h|gh quahty @Smart Encoding Adjustments
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Many MP3 players do not support VBR-encoded files. (Note that you can
use VBR-encoded MP3 files on the iPod without any problem.)

Sample Rate: This pop-up menu enables you to select the sample rate
(the number of times per second the sound waveform is captured digi-
tally). Higher sample rates yield higher quality sound and large file sizes.
However, you should never use a higher sample rate than the rate used
for the source — CDs use a 44.100 kHz rate, so choosing a higher rate is
unnecessary, unless you convert a song that was recorded from DAT or
directly into the Mac at a high sample rate, and you want to keep that
sample rate.

Channels: This pop-up menu enables you to choose how you want the
music to play through speakers — in stereo or mono. Stereo, which offers
two channels of music for left and right speakers, is the norm for music.
Monaural (Mono) recordings take up half the space of stereo recordings
when digitized. Choose the Auto setting to have iTunes use the appropri-
ate setting for the music.



Figure 3-5:
Choose the
Joint Stereo
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for MP3
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reduce file
size without
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quality.
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4+ Stereo Mode: This pop-up menu enables you to choose between Normal
or Joint Stereo. Normal mode is just what you think it is — normal stereo.
Choose the Joint Stereo setting, as shown in Figure 3-5, to make the file
smaller by removing information that is identical in both channels of a
stereo recording, using only one channel for that information, while the
other channel carries unique information. At bit rates of 128 Kbps and
below, this mode can actually improve the sound quality. However, we typi-
cally don’t use the Joint Stereo mode when using a high-quality bit rate.

4+ Smart Encoding Adjustments: This option, when selected, tells iTunes
to analyze your MP3 encoding settings and music source and to change
your settings as needed to maximize the quality of the encoded files.

4+ Filter Frequencies Below 10 Hz: This option, when selected, filters out
low frequency sounds. Frequencies below 10 Hz are hard to hear, and
most people don’t notice if they’re missing. Filtering inaudible frequen-
cies helps reduce the file size with little or no perceived loss in quality.
However, we think selecting this option and removing the low-frequency
sounds detracts from the overall feeling of the music, and we prefer not
to filter frequencies.

MP3 Encoder

Stereo Bit Rate l_ﬁﬂkhps e !

@ Use Variable Bit Rate Encoding (VBR)

Quality: = Highest
(with WER enabled, bit rate settings are used for a guaranteed minimum bit rate.)

Sample Rate: _Auto % l
Channels: [ Auto ?ﬁ

Sterea Mode: | ¢ Normal
Joint Stereo .
e Adjustments

Srrrms e 2

I Filter Frequencies Below 10 Hz

—————== R
/ Use Default Settings | { Cancel )

Using AIFF or WAU encoders

We recommend that you use the AIFF or WAV encoders for songs from audio
CDs if you intend to burn your own audio CDs with the music. You get the best
possible quality with either encoder because the music is not compressed.

The difference between the encoders is only that AIFF is the standard for
Mac applications and computers, and WAV is the standard for PC applica-
tions and computers.
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Figure 3-6:
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encoder to
importin
stereo no
matter what
the source.

You can import music with AIFF or WAV at the highest possible quality and
then convert the music files to a lesser-quality format for use in the iPod or
other devices.

AIFF and WAV files take up huge amounts of hard drive space, and although
you can play them on an iPod, they take up way too much space and battery
power to be convenient for anyone but the most discerning audiophile who
can afford multiple iPods. You can handle these large files by adding another
hard drive or by backing up portions of your music library onto other media,
such as a DVD-R disc (which can hold 4.7GB). But if multiple hard drives and
backup scenarios scare you, you should use the AAC or MP3 encoders to
compress files so they take up less space on your hard drive.

Both the AIFF encoder and the WAV encoder offer the same custom settings
in the AIFF Encoder dialog, shown in Figure 3-6, with Sample Rate, Sample Size,
and Channels pop-up menus. You can choose the Auto setting for all three
pop-up menus, and iTunes automatically detects the proper sample rate, size,
and channels from the source. If you choose a specific setting, such as the
Stereo setting in the Channels pop-up menu, iTunes imports the music in
stereo, regardless of the source. Audio CDs typically sample at a rate of
44.100 kHz, with a sample size of 16 bits, and stereo channels.

AIFF Encoder

Sample Rate "44.100 kHz F{
Sample Size:' 16 bit m

Channels: « Auto E]

(" Default Settings \ %{‘

The Sample Rate pop-up menu for AIFF and WAV offers more choices than for
AAC, down to a very low sample rate of 8.000 kHz that’s suitable only for
voice recordings.

Import settings for voice and sound effects

Audio books are available from Audible (www.audible.com) in a special
format that doesn’t require any further compression. You can also import
audio books, spoken-word titles, comedy CDs, and other voice recordings in
the MP3 format.
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If the recording has any music at all, or requires close listening to stereo
channels (like a Firesign Theatre or Monty Python CD), you should treat the
entire recording as music and skip this section.

Sound effects CDs offer sound effects at CD quality, which you may want to
treat as normal music; but you may also want to reduce the sound file if you
intend to incorporate the sound effect into movies in iMovie to keep the
overall movie from getting too large.

By fine-tuning the import settings for voice recordings and sound effects, you
can save a significant amount of space without reducing quality. We recom-
mend the following settings depending on your choice of encoder:

4+ AAC encoder: AAC allows you to get away with an even lower bit rate
than MP3 to get the same quality, thereby saving more space. We recom-
mend a bit rate as low as 80 Kbps for sound effects and voice recordings.

4+ MP3 encoder: Use a low bit rate (such as 96 Kbps). You may also want to
reduce the sample rate to 22.050 kHz for voice recordings. Filter frequen-
cies below 10 Hz because voice recordings don’t need such frequencies.

Converting songs to other encoders

Converting a song from one encoder to another may be useful if you want to
use one encoder for one purpose, such as burning a CD, and another encoder
for another purpose, such as playing on an iPod.

You want to use different encoding formats if you have a discerning ear and

you want to burn a CD of songs, and also use the songs in your iPod. You can
first import and then burn AIFF-encoded songs to a CD, and then convert the
songs to AAC or MP3. You can then save space by deleting the AIFF versions.

Converting a song from one compressed format to another is possible (say
from AAC to MP3), but you may not like the results. When you convert a com-
pressed file to another compressed format, iTunes compresses the music
twice, reducing the quality of the sound. You get the best results by starting
with an uncompressed song that was imported using either the AIFF or WAV
format, and then converting that song to the compressed AAC or MP3 format.

You can tell what format a song is in by selecting it and choosing Filer>Get
Info. Click the Summary tab to see what kind of file format the song is in.

You can’t convert songs you buy from the iTunes Music Store to another file
format because they are encoded as protected AAC files. If you could, they
wouldn’t be protected, would they? You also can’t convert Audible books and
spoken-word content to another format. (However, you can burn them to an
audio CD and re-import them, with a perhaps noticeable drop in quality.)
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Manic compression has captured your song

Every person hears the effects of compression
differently. You may not hear any problem with
compressed audio that someone else says is
tinny or lacking in depth.

Too much compression can be a bad thing.
Further compressing an already-compressed
music file — say by converting a song —
reduces the quality significantly. Not only that,
but once your song is compressed, you can't
uncompress the song back to its original quality.
Your song is essentially locked into that format.

The audio compression methods that are good
at reducing space (and if you're not going to
reduce space significantly, why bother?) have
to throw away information. In technospeak,
they are /ossy (as opposed to loss-less) com-
pression algorithms. Lossy compression loses
information each time you use it, which means
if you compress something that's already com-
pressed, you lose even more information.

MP3 and AAC (the new, advanced Apple-
sponsored cousin to MP3) use two basic meth-
ods to compress audio: removing non-audible
frequencies and removing the less important
signals.

For non-audible frequencies, the compression
removes what you supposedly can't hear
(although this is a subject for eternal debate).
For example, if a background singer’s warble is
totally drowned out by a rhythm guitar playing a
chord, and you can't hear the singer due to the
intensity of the guitar’s sound, the compression
algorithm loses the singer’s sound while main-
taining the guitar’s sound.

Within the sound spectrum of frequencies that
can be heard by humans, some frequencies
are considered to be less important in terms of
rendering fidelity, because many people can’t
hear sounds in that frequency. Removing spe-
cific frequencies is likely to be less damaging
to your music than other types of compression,
depending on how you hear things. In fact,
your dog may stop getting agitated at songs
that contain ultra-high frequencies only dogs
can hear (such as the ending of “Day in the
Life” by the Beatles).

Another option in MP3 compression is the
Channel choice. Most likely, you want to keep
stereo recordings in stereo, and mono record-
ings in mono, and the Auto setting guarantees
that. But you can also select Joint Stereo for
the stereo mode of the MP3 encoder to reduce
the amount of information per channel. The
Joint Stereo mode removes information that is
identical in both channels of a stereo record-
ing, using only one channel for that information,
while the other channel carries unique infor-
mation. At bit rates of 128 Kbps and below, this
mode can improve the sound quality.

Variable Bit Rate (VBR) encoding is a technique
that varies the number of bits used to store the
music depending on the complexity of the
sound. While the quality of VBR is endlessly
debated, it's useful when set to the Highest set-
ting, because VBR can encode at up to the
maximum bit rate of 320 Kbps in those rare
cases where the sound requires it, while keep-
ing the rest at a lower bit rate.




\NG/
Vg\\\

A\

Equalize It! 65

To convert a song to another file format, follow these steps:

1. Choose iTunes- Preferences and then click the Importing button.
The Importing dialog appears.

2. Choose the encoding format you want to convert the song into from
the Import Using pop-up menu; in the Encoder dialog that appears,
select the settings for that format.

For example, if you are converting songs in the AIFF format to the MP3
format, you choose MP3 Encoder from the Import Using pop-up menu, and
then select the settings you want in the MP3 Encoder dialog that appears.

3. Click OK to accept the settings for your chosen format.

4. In the iTunes window, select the song(s) you want to covert, and then
choose Advanced->Convert Selection.

The encoding format you chose in Step 4 appears in the menu: Convert
Selection to MP3, Convert Selection to AAC, Convert Selection to AIFF,
or Convert Selection to WAV. Choose the appropriate menu operation to
perform the conversion. When the conversion is complete, the newly
converted version of the song appears in your iTunes library (with the
same artist name and song name, so it is easy to find).

iTunes creates a copy of each song and converts the copy to the new format.
Both the original and the copy are stored in your music library.

If you convert songs obtained from the Internet, you’ll find that the most
common bit rate for MP3 files is 128 Kbps, and choosing a higher stereo bit
rate won’t improve the quality — it only wastes space.

The automatic copy-and-convert operation can be useful for converting an
entire music library to another format — hold down the Option key and
choose Advanced=>Convert Selection, and all the songs copy and convert
automatically. If you have a library of AIFF tunes, you can quickly copy and
convert them to AAC or MP3 in one step, and then assign the AIFF songs to
the AlFF-associated playlists for burning CDs, and MP3 or AAC songs to MP3
or AAC playlists that you intend to copy to your iPod.

Equalize It!

When you turn up the bass or treble on a stereo system, you are actually
increasing the volume, or intensity, of certain frequencies while the music is
playing. If you are a discerning listener, you may change these bass and
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Figure 3-7:
Use the
equalizer's
Preamp
slider to
adjust
volume
across all
frequencies.

treble settings a lot — perhaps even for each song. Wouldn't it be nice if you
could save these settings with each song? You can with iTunes.

The iTunes equalizer (EQ) allows you to fine-tune the specific sound spectrum
frequencies in a more precise way than with bass and treble controls. You can
use the equalizer to improve or enhance the sound coming through a particu-
lar stereo system and speakers — for example, you may pick entirely different
equalizer settings for car speakers, home speakers, and headphones.

With the iTunes EQ, you can adjust the frequencies directly or use one of
more than 20 built-in presets for various types of music, from classical to
rock. You can then assign the equalizer settings to a specific song or set of
songs. With the equalizer settings, you can customize playback for different
musical genres, listening environments, or speakers. You can even save your
own customized presets.

To see the iTunes equalizer, click the Equalizer button, which is on the
bottom-right side of the iTunes window, or choose Window=>Equalizer.

Adjusting the preamp volume

The preamp in your stereo is the component that offers a volume control
that applies to all frequencies equally. (Volume knobs generally go up to ten,
except, of course, for Spinal Tap’s preamps, which go to eleven.)

The iTunes equalizer, shown in Figure 3-7, offers a Preamp control on the

far left side. You can increase or decrease the volume in 3-decibel (dB) incre-
ments up to 12 dB. Decibels are units that measure the intensity (or volume)
of the frequencies. You can adjust the volume while playing the music so
that you can hear the result right away.
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Figure 3-8:
Choose one
of the built-
in equalizer
presets.
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You may want to increase the preamp volume for songs that are recorded too
softly, or decrease it for songs that are so loud you can hear distortion. If you
want to make any adjustments to frequencies, you may want to adjust the
preamp volume first if volume adjustment is needed, and then move on to the
specific frequencies.

Using presets

iTunes offers presets, which are equalizer settings made in advance and saved
by name. You can quickly switch settings without having to make changes to
each frequency slider. iTunes comes with more than 20 presets of the most
commonly used equalizer settings.

To use an equalizer preset, click the Equalizer button, which is on the bottom-
right side of the iTunes window. The Equalizer window appears, and you can
click the pop-up menu at the top of the equalizer, as shown in Figure 3-8, to
select a preset. If a song is playing, you hear the effect in the sound immedi-
ately after choosing the preset.

Make Preset...
Edit List..

-~ Manual

Acoustic
Bazs Booster
Bass Reducer
Classical
Dance

Deep
Electronic
Flat

Hip-Hop
Jazz

Latin
Loudness
Lounge
Piano

Pop

RE&E

Small Speakers !

Spoken Word
Treble Booster
Treble Reducer
Vocal Booster

You can also create your own presets. Choose the Manual option in the pop-
up menu to make setting changes in the equalizer, as described in the next
section, “Adjusting frequencies.” Then choose the Make Preset option from
the pop-up menu to save your changes. The Make Preset dialog appears, as
shown in Figure 3-9. Give your new preset a descriptive name. The name
appears in the pop-up menu from that point on — your very own preset.
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Figure 3-9:
Save your
adjustments
as your own
preset.

Figure 3-10:
Rename
or delete
presets.

Make Preset

New Preset Name:
Home SIErEEFI

( Cancel @

You can rename or delete the presets by choosing the Edit List option from the
pop-up menu, which displays the Edit Presets dialog for renaming or deleting
presets, as shown in Figure 3-10. You can rename or delete any preset, includ-
ing the ones supplied with iTunes.

Edit Presets
Bass Reducer (Rename...")
Classical ———
Dance .&.
Deep
Electronic
Flat
Hip-Hop
Home stereo ¥
lazz
Latin
Loudness
Lounge
Piano .

Adjusting frequencies
You can adjust the frequencies in the iTunes equalizer by clicking and drag-
ging sliders that look like mixing-board faders.

The horizontal values across the equalizer represent the spectrum of human
hearing. The deepest frequency (“Daddy sang bass”) is 32 hertz (Hz); the mid-
range frequencies are 250 Hz and 500 Hz, and the higher frequencies go from
1 kilohertz (kHz) to 16 kHz (treble).

The vertical values on each bar represent decibels (dB), which measure the
intensity of each frequency. Increase or decrease the frequencies at 3-decibel
increments by clicking and dragging the sliders up and down. You can drag
the sliders to adjust the frequencies while the music is playing to hear the
effect immediately.
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( ( ( Book |
Assigning equalizer presets to songs | | s
One reason why you go to the trouble of setting equalizer presets is to assign
the presets to individual songs. The next time you play the song, it will use
the equalizer preset you assigned.

= M
\\3 . . g =
You can also use the same presets in an iPod. When you transfer the song to = =
the iPod, the preset stays assigned to it, and you can choose whether or not s 2
to use the preset when playing the song on the iPod. °ea
You can assign any equalizer preset directly to a song. Assign a preset to
songs by following these steps:
1. Choose Edit>View Options.
Alternatively, 8+click any column heading in the song list and choose
the Equalizer option from the shortcut menu.
The View Options dialog appears, as shown in Figure 3-11.
View Options
Library
Show Calumns
MAlhum : Grouping
@Amst : Eind
: Beats Per Minute : Last Played
- . @ Bit Rate : Mty Rating
Flgure 3-11' T comment " Play Count
ShOW the _: Composer _: Sample Rate
; ™ Dare Added [ size
equallzer _: Date hModified @T\me
CO|umn to :Dist MNumber ETrackNumher
aSSign L Equalizer [Dvear
presets to S
songs. (Cancel ) 0K

2. Select the Equalizer check box and click OK.

3. Locate a song in the song list, and scroll the song list horizontally to
see the Equalizer column.

You can open a playlist or scroll the entire song list in List or Browse view.
4. Choose a preset from the pop-up menu in the Equalizer column.

The Equalizer column has a tiny pop-up menu, as shown in Figure 3-12,
that allows you to assign any preset to a song.
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When you transfer songs with presets to the iPod, it uses the presets for
playback. See Book VI, Chapter 2 for lots of great suggestions on using equal-
izer settings with the iPod.



Chapter 4: Burning CDs

In This Chapter

v+ Choosing the proper disc media
v Preparing a playlist for burning
v Choosing the sound and format settings

v Burning CDs

Wlen vinyl records were popular, rock radio disk jockeys who didn’t
like disco would hold disco meltdown parties. People were encour-

aged to throw their disco records into a pile to be burned up or steamrolled
into vinyl glop. This chapter isn’t about that, nor is it about anything involv-
ing fire or heat.

Burning a CD actually refers to the process in which the CD drive recorder’s
laser meets the surface of the disc and creates a new impression loaded
with digital information.

Contrary to the beliefs of some record company executives, burning CDs is
not a global pastime simply because people want to steal music. People burn
CDs for a lot of reasons. Maybe you want to bring a CD of your special party
songs to the local DJ club to mix in with the night’s music. Maybe having your
12 favorite love songs on one CD for your next romantic encounter is conven-
ient. Or maybe you want to burn a few CDs of obscure songs to impress your
friends on your next big road trip. Blank discs are cheap — pennies to the
dollar compared with the older technology of cassette tapes.

This chapter burns, er, boils down everything for you by telling you what kind
of discs to use, where the discs play, how to get your playlist ready for burn-
ing, what settings to use for burning, and so on. You find out what you need
to know to make sure that your burns are not meltdowns — the only melting
is the music in your ears.

Using Recordable CDs

If you don’t have an iPod or similar player, you can’t take music with you
unless you burn a disc. Even if you have a player, you may still want to make a
CD that plays on any CD player or to back up your music files on CD or DVD.
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Using Recordable CDs

After importing music into your iTunes library, you can arrange any songs in
your library into a playlist and burn a CD using that playlist. If you have an
Apple-supported CD-R, CD-RW, or DVD-R drive (such as the Apple SuperDrive),
and blank CD-Rs (“R” is for “recordable”), you can create your own music CDs
that play in most CD players.

Blank CD-Rs are available in most electronics and computer stores. You can
also get them online from the Apple Store. Choose iTunes=>Shop for iTunes
Products to reach the Apple Store online.

The discs are called CD-Rs because they use a recordable format related to
commercial CDs (which are not recordable, of course). You can also create a
disc in the MP3 format by creating a CD-R with data rather than music, which
is useful for backing up a music library.

Where you can play CD-Rs

CD-Rs play just like commercial CDs in most CD players, including car and
portable CD players. The CD-R format is the most universal and most com-
patible with older players.

The Apple SuperDrive and the ComboDrive also create CD-RWs (the RW
stands for ReWritable) that you can erase and reuse, but most CD players
don’t recognize them as music CDs. The SuperDrive can create data DVD-R
and DVD-RWs also, which are useful for holding data files, but you can only
use these discs with computers that have a DVD drive — most commercial
DVD players won'’t read data on a DVD-R or DVD-RW. To find out how to create
DVD titles for commercial players, see Book IV.

You can play MP3 files burned on a CD-R in the new consumer MP3 disc play-
ers and combination CD/MP3 players, as well as on computers that recognize
MP3 CDs (including Macs with iTunes).

What you can fit on a CD-R

You can fit up to 74 minutes of music on a high-quality CD-R (some can go as
high as 80 minutes). You measure the amount of music in minutes (and sec-
onds) because the Red Book encoding format for audio CDs and CD-Rs com-
presses the music information. Although CD-Rs (and CD-RWs) hold about
650MB of data, the actual storage of music information varies. The sound
files on your hard drive may take up more space but still fit within the 650MB
confines of the CD.

If you burn music to a CD-R or CD-RW in the MP3 format, the disc can hold
more than 12 hours worth of music. You read that right — 12 hours on one
disc. Now you know why MP3 discs are popular.
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The little Red Book that launched an industry

The typical audio CD and CD-R use the CD-DA
(Compact Disc-Digital Audio) format, which is
known as Red Book — not something from
Chairman Mao, but a document, published in
1980, that provides the specifications for the
standard compact disc (CD) developed by Sony
and Philips. According to legend, this document
was in a binder with red covers.

Also according to legend, in 1979, Norio Ohga,
honorary chairman and former CEQO of Sony
who's also a maestro conductor, overruled
his engineers and insisted that the CD format
be able to hold Beethoven’s Ninth Symphony
(which is 74 minutes and 42 seconds).

CD-DA defines audio data digitized at 44,100
samples per second (44.1 kHz) and in a range
of 65,536 possible values (16 bits). Each second

of hi-fi stereo sound requires almost 1.5 million
bits of storage space. Data on a CD-DA is organ-
ized into sectors (the smallest possible sepa-
rately addressable block) of information. CD
data is not arranged in distinct physical units;
data is organized into frames that are each 1/75
of a second. These frames are intricately inter-
leaved so that damage to the disc does not
destroy any single frame, but only small parts
of many frames.

To import music into the computer from an
audio CD, you have to convert the music to dig-
ital sound files by using a program such as
iTunes. When you burn an audio CD-R, iTunes
converts the sound files back into the CD-DA
format as it burns the disc.

If you have a DVD (Digital Versatile Disc) burner, such as the Apple Super-
Drive, you can burn data to a DVD-R or DVD-RW to use with other comput-
ers. This approach is suitable for making backup copies of music files (or
any data files, such as movies or digital photos). DVD-Rs can hold about

4.7GB of music or other data files.

To burn a CD-RW or DVD-RW that already has data on it, you must first erase
it by reformatting it using the application supplied with the drive. CD-RWs
and DVD-RWs work with computers but won’t work with consumer players.

Creating a Burn Playlist

To burn a CD, you must first define a playlist for the CD. (See Chapter 2 of
this minibook for how to create a playlist.) You can use songs encoded in
any format that iTunes supports; however, you get higher quality music with
the uncompressed formats AIFF and WAV.
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Figure 4-1:
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Creating a Burn Playlist

To copy an album from your iTunes library onto an audio CD, you can quickly
create a playlist for the album by switching to Browse view in your iTunes
library and dragging an album from the Album list (in the top-right section
of the library) to the white area below the items in your Source list. iTunes
automatically creates a playlist with the album name. You can then use that
playlist to burn a CD.

If your playlist includes music purchased from the Apple Music Store or other
online stores in the protected AAC encoding format, some rules may apply.
For example, the Apple Music Store allows you to burn ten copies of the same
playlist containing protected songs to an audio CD, but no more. You can,
however, create a new playlist and copy the protected songs to the new
playlist, and then burn more CDs with the songs.

Calculating how much music to use

When you create a playlist, you find out how many songs can fit on the CD by
totaling the durations of the songs, using time as your measure. You can see
the size of a playlist by selecting it; the bottom of the iTunes window shows
the number of songs, the amount in time, and the amount in megabytes for the
currently selected playlist, as shown in Figure 4-1.
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In Figure 4-1, the selected playlist has 23 songs that total 1.1 hours and
724.1MB. You may notice the discrepancy between the megabytes (724.1)
and what you can fit on an audio CD (650). While a CD holds only 650MB,
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the music is compressed and stored in a special format known as CD-DA
(or Red Book). Thus, you can fit a bit more than 650MB of AIFF-encoded
sound, because AIFF is uncompressed. We can fit 1.1 hours (66 minutes) of
music on a 74-minute or 80-minute CD-R with many minutes to spare.

You should always use the actual duration, in hours, minutes, and seconds,
to calculate how much music you can fit on an audio CD — either 74 or 80
minutes for blank CD-Rs. Leave at least one extra minute to account for the
gaps between songs.

You should do the opposite for an MP3 CD — use the actual megabytes to cal-
culate how many songs to fit — up to 650MB for a blank CD-R. You can fit lots
more music on an MP3 CD-R, because you use MP3-encoded songs rather than
uncompressed AIFF songs.

If you have too many songs in the playlist to fit on a CD-R, iTunes burns as
many songs in the playlist as can fit on the CD-R (either audio or MP3), and
then it asks you to insert another CD-R to continue burning the remaining
songs in the playlist.

Importing music for an audio CD-R

Before you rip an audio CD of songs you want to burn to an audio disc, you
may want to change the importing settings, as described in Chapter 3 of this
minibook.

The iTunes Music Store provides songs in the protected AAC format. You
should convert songs from music CDs to the AIFF or WAV formats if you want
to take those songs and burn them to your own audio CD-Rs.

AIFF is the standard digital format for uncompressed sound on a Mac, and
you can’t go wrong with it. WAV is basically the same thing for Windows.
Both the AIFF Encoder and the WAV Encoder offer the same Custom Settings
dialog, with settings for sample rate, sample size, and channels. You can
choose the automatic settings, and iTunes automatically detects the proper
sample rate, size, and channels from the source.

The Apple AAC music file format is comparable to audio CD quality and is a
higher quality format than MP3. We think AAC offers the best trade-off of
space and quality. All music that you purchase from the Apple Music Store
comes in this format, and it is suitable (though not as good as AIFF) for burn-
ing to an audio CD.

Book |
Chapter 4
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Importing music for an MP3 CD-R
MP3 discs are CD-Rs with MP3 files stored on them. You can buy consumer MP3
CD players (car, portable, and home) that play both audio CDs and MP3 CDs.

You can fit up to 12 hours of music on a CD-R using the MP3 format. The
amount of music varies with the encoding options and settings you choose, as
does the quality of the music, as we describe in Chapter 3 of this minibook.

You can use only MP3-encoded songs to burn an MP3 CD-R. Any songs not
encoded in MP3 are skipped and not burned to the CD-R. Audible books and
spoken-word titles are provided in an audio format that uses security tech-
nologies, including encryption, to protect purchased content. You can’t burn
an MP3 CD-R with Audible files, so any Audible files in a burn playlist are
skipped when you burn an MP3 CD-R.

Setting the Burning Preferences

Burning a CD is a simple process, and getting it right the first time is a good
idea — when you burn a CD-R, it’s done, right or wrong. You can’t erase con-
tent on a CD-R as you can with a CD-RW. But because you can’t play a CD-RW
in most CD players, if you want to burn an audio CD, we recommend using a
CD-R. Fortunately, CD-Rs are inexpensive, so you won’t be out more than a
few cents if you burn a coaster (a bad CD-R).

Setting the sound check and gaps

Musicians do a sound check before every performance to check the volume
of microphones and instruments and its effect on the listening environment.
The aptly named Sound Check option in iTunes allows you to do a sound
check on your tunes to bring them all in line, volume-wise.

To have all the songs in your library play at the same volume level all the
time, choose iTunes=Preferences, and in the Preferences dialog, click the
Effects button to see the Effects dialog. Select the Sound Check check box,
which sets all the songs to the current volume controlled by the iTunes
volume slider.

After selecting the Sound Check option, you can burn your audio CD-R so
that all the songs play back at the same volume, just like they do in iTunes.
Choose iTunes=>Preferences, and then click the Burning button. Select the
Use Sound Check option, as shown in Figure 4-2. This option is only active if
you already selected the Sound Check option in the Effects dialog.
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Consistent volume for all tracks makes the CD-R sound professional. Another
professional touch is to add an appropriate gap between songs, just like com-
mercial CDs. Follow these steps to control the length of the gap between the
songs on your audio CD-Rs (not MP3 CD-Rs):
1. Choose iTunes->Preferences, and then click the Burning button in the
Preferences dialog.
The Burning dialog displays, as shown in Figure 4-3.
2. Choose an amount from the Gap Between Songs pop-up menu.
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Setting the format and recording speed

Before burning a CD-R, you have to set the disc format and the recording
speed. Choose iTunes=Preferences, and then click the Burning button in the
Preferences dialog.

You can choose from the following three options for the Disc Format setting
in the Burning dialog (refer to Figure 4-2):

4 Audio CD: Choose this option to burn a normal audio CD of up to 74
or 80 minutes (depending on the type of blank CD-R) using any iTunes-
supported music files, including songs bought from the iTunes Music
Store. While connoisseurs of music may prefer to use AlFF-encoded or
WAV-encoded music to burn an audio CD, you can also use songs in the
AAC and MP3 formats.

4+ MP3 CD: Choose this option to burn an MP3 CD with songs encoded in
the MP3 format; no other formats are supported for this option.

4+ Data CD or DVD: Choose this option to burn a data CD-R, CD-RW, DVD-R,
or DVD-RW with the music files. You can use any encoding formats for
the songs. Data discs don’t play on consumer CD players — they are
meant for use with computers. Data discs are good choices for storing
copies of music bought from the iTunes Music Store.

Blank CDs are rated for recording at certain speeds. Normally, iTunes detects
the rating of a blank CD and adjusts the recording speed to fit. But if your
blank CDs are rated for a slower speed than your burner, or you are having
problems creating CDs (see the section, “Dealing with trouble in CD-R para-
dise,” later in this chapter), you can change the recording speed setting to
match the CD’s rating. Choose iTunes=>Preferences, and then click the Burning
button in the Preferences dialog. Choose a specific recording speed from the
Preferred Speed pop-up menu in the Burning dialog, or choose the Maximum
Possible option to set the recording speed to your burner’s maximum speed.

Burning a Disc

After you set the burning preferences, you're ready to start burning. Follow
these steps to burn a CD:

1. Select the playlist designated for burning to a disc and click the Burn
Disc button.
A message appears, telling you to insert a blank disc.

2. Insert a blank disc (label side up).

iTunes immediately checks the media and displays a message in the
status window that the disc is ready to burn.



Burning a Disc 79

3. Click the Burn Disc button again. Book |

Chapter 4
This time, the button has a radioactive symbol. After clicking the Burn aper

Disc button, the process begins. The radioactive button rotates while the
burning takes place, and a progress bar appears, displaying the names of
the songs as they burn to the disc.

When iTunes has finished burning the CD, iTunes chimes, and the CD is
mounted on the Desktop.

s@9 buiung

4. Eject the newly burned disc from your CD drive and test it out.

V?‘“\NG! Burning takes several minutes. You can cancel the operation at any time by
& clicking the X next to the progress bar. But canceling the operation isn’t like
undoing the burn. If the burn has already started, you can’t use the CD-R or

DVD-R again.

If the playlist has more music than fits on the disc using the chosen format,
iTunes burns as much as possible from the beginning of the playlist, and then
asks you to insert another disc to burn the rest. To calculate the amount of
music in a playlist, turn to the section, “Calculating how much music to use,”
MBER earlier in this chapter.
N
& If you choose the MP3 CD format, iTunes skips over any songs in the playlist
that are not in the MP3 format.

Exporting song information for liner notes

Don’t delete the playlist yet! You can export the song information for all the
songs in the playlist to a text file and edit that information to make liner notes
for the CD.

iTunes exports all the song information for a single song, all the songs in a
playlist, an album, by an artist, or in the library into a text file. Select the songs
or playlist and choose Filec>Export Song List (or 88+click and choose Export
Song List from the shortcut menu). In the Export Song List dialog, select the
Plain Text option from the Format pop-up menu (unless you use a double-byte
language, such as Japanese or Chinese, for which the Unicode option is the
right choice).

You can open this text file in a word-processing program, such as the free
TextEdit program supplied with the Mac. iTunes formats the information in
order for you to easily import it into a database or spreadsheet program.
You can change the formatting by manipulating the tab settings (tabs are
used between pieces of information).
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iTunes exports all the song information, which may be too much for your
liner notes. Edit the liner notes by following these steps:

1. Open your preferred word processor while you are using iTunes.

2. Switch to iTunes, select the playlist, and choose Edit=>View Options.
The View Options dialog opens.

3. Select the columns that you want to appear in the song list.

To pick a column, click the check box next to the column header so that
a check mark appears. Any unchecked column headers are columns that
do not appear. Note: The Song Name column always appears in the list-
ing and can’t be removed.

4. Select all the songs in the playlist and choose Edit=>Copy.

To select all the songs in the playlist, click the first song, and hold down
Shift while clicking the last song to highlight all the songs.

5. Switch to your word processor and choose Edit~>Paste.

The liner notes appear in your word processor, as shown in Figure 4-4.
You can now edit the liner notes in your word processor — for example,
you may want to decrease the font size or delete nonessential informa-
tion so that the liner notes will fit inside a CD case when printed.

6. In your word processor, choose Filer>Print to print out the liner notes
so that you can include them with your newly-burned CD.

You can automate the task of creating liner notes from iTunes if you are
adept at using AppleScript. Free AppleWorks templates and AppleScripts for
making liner notes are available on the Apple Web site (www.apple.com/
applescript/itunes/index.html) and information about scripting iTunes
can be found in Book VII, Chapter 2.

Dealing with trouble in CD-R paradise

Murphy’s Law applies to everything, even something as simple as burning a
CD-R. Don’t think for a moment that you are immune to the whims and
treacheries of Murphy (no one really knows who Murphy is) who in all his
infinite wisdom, pronounced that anything that can go wrong will go wrong.
We cover some of the most common problems you may encounter when
burning CDs in this section.

The best way to test your newly burned disc is to pop it right back into your
SuperDrive or any CD-ROM drive, or try it on a CD player. On most CD players,
an audio CD-R plays just like any commercial audio CD. MP3 CDs play fine on
MP3 CD players and also work in computers with CD-ROM and DVD drives.
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If the CD works on the Mac but not on a CD player, you may have a compati-
bility problem with the player and CD-Rs. We have a five-year-old CD player
that doesn’t play CD-Rs very well; car CD players sometimes have trouble
playing CD-Rs as well.

The following list gives some typical problems you may run into when burn-
ing a CD, along with the solutions to those problems:

4 Problem: The disc won’t burn.

Solution: Perhaps you have a bum disc (it happens). Try using another
disc and burning at a slower speed.

4+ Problem: The disc doesn’t play, or stutters when playing, with a CD
player.

Solution: This happens often with older players that don’t play CD-Rs
well. Try the disc in your Mac CD-ROM, DVD-ROM, or SuperDrive. If it
works there, and you set the format to Audio CD, then you probably
have a compatibility problem with your CD player.

Book |
Chapter 4
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4+ Problem: The disc doesn’t show tracks on a CD player, or it ejects

immediately.

Solution: Be sure to use the proper disc format — choose iTunes=>
Preferences and click the Burning button to see the Disc Format setting
in the Burning dialog. The Audio CD format works in just about all CD
players that can play CD-Rs. MP3 CDs work in MP3 CD players and com-
puter CD-ROM and DVD drives. Data CDs or DVDs work only in computer
drives.

Problem: The eMac went to sleep while burning and never woke up.

Solution: You have found one strange glitch that fortunately only applies
to eMacs set to go into sleep mode. As a safety precaution, turn off sleep
mode in the Energy Saver preferences (in System Preferences) before
starting a burn.

Problem: Some songs in a playlist were skipped and not burned onto
the disc.

Solution: Audio CD-Rs burn with songs encoded in any format, but you
can use only MP3-encoded songs to burn an MP3 CD-R — any songs not
encoded in MP3 are skipped (any Audible files are also skipped). If your
playlist for an audio CD-R includes music purchased from the Apple Music
Store or other online stores in the protected AAC encoding format, some
rules may apply — see the section, “Creating a Burn Playlist,” earlier in
this chapter.

Burning CDs is a personal matter. Piracy is not a technology issue — it is a
behavior issue. Don’t violate copyright law. See the section about sharing
music legally in Chapter 2 of this minibook.
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Chapter 1: Getting to Know iPhoto

In This Chapter

v~ Finding out what features to look for in digital cameras
1 Checking out what iPhoto can do for you

v Opening images in iPhoto

Taking photos has never been easier. Digital cameras and Apple software
have combined to turn the Macintosh into a digital darkroom — no need
for a real darkroom with smelly chemicals and film processing equipment. In
fact, you no longer need film. What a relief! You can take all the pictures you
want without ever having to find a store to buy another roll of film.

This chapter tells you all you need to know about digital cameras, and it
provides an overview of what you can do with iPhoto. You find out how to
get around in iPhoto and look at your pictures in detail.

Living in the Digital World

Maybe your vacation photos bore other people (at least, if you show them in
a long slideshow), but to you they’re priceless, preserving special memories.
Family pictures, vacations, weddings . . . these events don’t happen every day
and you want to preserve your photos of these events. You don’t want your
photos to deteriorate due to age, weather, or environmental factors such as
kids with peanut butter fingers. The problem with film and prints is that film
negatives eventually deteriorate, and photographic prints fade over time, or
can be scratched or torn, and are costly to replace (if they can be replaced at
all). The cost of film also limits the number of pictures you may want to take.

In the digital world, these limitations don’t exist. The ones and zeroes that
make up digital information don’t change, and the image remains perfect —
for all eternity.

Digital information can be destroyed, however. You might accidentally erase
the photos on your camera. Your computer or your hard drive can fail. A
virus can take over your computer and wreak havoc, destroying files in the
process. Your laptop can be stolen. You may drop the computer while
moving. Stuff happens, even in the digital world.
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USB versus FireWire for digital cameras

USB (Universal Serial Bus) is used to connect
hundreds of nifty devices to your computer,
such as keyboards, pointing devices, external
hard drives, keychain-sized flash drives, print-
ers, scanners, and so on. USB connectors are
plug-and-play: You can plug them in at any time
while your computer is on or off. Many of these
devices get their power directly from the Mac
through the USB connection.

Like USB, FireWire also supplies power to a
device, such as a camera, through the same
cable that connects it to the computer. FireWire
devices are also plug-and-play. But FireWire
can handle data transfer speeds of more than
30 times faster than USB — at least that's true
of the first versions of USB and FireWire. USB
version 1, which is used in every Mac model
sold at the time of this writing, offers a trans-
fer rate of 12 megabits per second (Mbps).
FireWire version A offers a rate of 400 Mbps.

However, the more advanced generation of
USB, version 2.0, has a transfer rate of 480
Mbps, 40 times faster than the first version

(USB 1.1). Many Mac models now sport USB
2.0 connectors, but not all cameras support
USB 2.0 — the camera will still work with the
USB 2.0 port, but you'll only get the slower USB
1.1 transfer rate of 12 Mbps. Meanwhile, the
FireWire spec (IEEE 1394) hasnt stood still:
Version B offers a transfer rate of 800 Mbps,
twice as fast as FireWire A. Again, 0S X sup-
ports both, but as of this writing, older Mac
models and the iBook, iMac, and eBook offer
FireWire A. The 17-inch PowerBook G4 offers
FireWire B.

USB is the connection of choice for most digi-
tal cameras (though some very high-quality
cameras may offer FireWire) because digital
camera manufacturers need to make cameras
that work with all types of computers; most
PCs, for example, come with USB ports, but
they likely don't have FireWire ports. This isn't
such a bad deal, though, because even USB 1.1
is generally fast enough for transferring digital
photo images.

You can protect information a number of ways. With iPhoto, you can archive
all of your photos to CD or DVD, creating multiple copies easily. You can, for
example, store archives of your photos on separate DVDs, storing one copy

at home and another at work for safekeeping — all for just the price of a few
blank DVD discs.

Why digital is better: Instant pictures

Everything about digital photography is easier and costs less than tradi-
tional film photography. Digital photography is truly instant gratification —
you see the results immediately and can then take more pictures based on
what happened an instant before.

With a film camera, you pay for every picture, including the accidental shot
of your foot, thumb, or the inside of your jacket pocket. The entire roll, no
matter what’s on it, has to be processed before you even see the photos.
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And if you want extra prints of the good photos, you need to reorder them
and pay for them again.

With a digital camera, you see your pictures in seconds, and you can delete
bad shots and reshoot them. You can archive what you like, and you can
delete what you don’t like. If you have a color printer, obtaining extra prints
is as easy as using the Print command. You can even e-mail the photos to a
service for high-quality prints. You never have to run to a store to buy film,
or waste money again on perishable film you don’t use.

Features of digital cameras can be intimidating. Camera buffs speak a different
language with their F-stops, optical zoom, and fish-eye lenses. You may want
to base your choice of digital cameras on features such as optical zoom, which
offers a higher-quality close-up than digital zoom, or the type of memory card
available for the camera.

If you're an amateur photographer, you probably don’t need to be too picky
about which camera to buy. You can get excellent results from just about any
digital camera. You need only know two important facts when picking out

a digital camera:

4+ Your camera must be compatible with the Mac USB (Universal Serial
Bus) or FireWire (IEEE 1394) connectors.

4+ Image quality is measured by the pixel resolution of the digital camera.

Resolution — the image quality factor

All you need to know about image quality with a digital camera is the
number of pixels — specific points of information in a picture. Digital cam-
eras are often described by the image resolution in millions of pixels, or
megapixels. Higher megapixel counts usually result in better images. A
2-megapixel camera produces good 4-x-6-inch prints and acceptable 8-x-10-
inch prints. A 3-megapixel camera produces very good 4-x-6-inch prints and
magazine-quality 8-x-10-inch prints. A 5-megapixel camera produces good
quality 10-x-14-inch prints.

Modifying and enhancing your photos

If you aren’t a professional photographer, the chances that your pictures
come out perfect every time are very slim. Some of the pictures may not be
as vivid as you thought they would be. That almost postcard-perfect view
from the highway may show a bit of road litter and guardrail, and you want
to cut out that part. Or maybe the light was too bright or too dim, or the
camera’s flash put red spots in your subject’s eyes (the dreaded red-eyes).

iPhoto makes these problems easy to fix. iPhoto is a digital darkroom, offer-
ing a number of easy ways to improve and enhance your photos, such as the
following:
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4+ You can instantly correct any photo that’s too dark, too light, or over-
exposed. iPhoto also provides editing tools for automatically correcting
that red-eye effect.

4+ You can crop any image. Cropping is a process in which you draw a
smaller rectangle inside the image and omit everything outside the rec-
tangle. You can improve a postcard-perfect view of a scenic stop along a
highway by removing, for example, the road litter and guardrail from the
bottom edge of the photo.

4+ You can change color photos to black and white (or more accurately,
grayscale) or sepia tone. Changing color to grayscale is very handy for
printing in books, newspapers, newsletters, or documents that don’t use
color. You can also change a color photo to sepia tone to make the pic-
ture look old-timey.

4+ You can make blemishes disappear like magic. (And with some cre-
ative editing in programs such as Adobe Photoshop, you can even make
people look thinner.)

You don’t have to load any special software to do the kind of improvements
to your pictures that make them more effective as photographs. Chapter 4 of
this minibook provides details on how to make improvements.

Storing, printing, and sharing your photos

iPhoto acts as your own processing lab and photo service. iPhoto allows you
to use your Mac to keep track of photos with titles and keywords and com-
ments. You can quickly display them on-screen, in any size ranging from
thumbnails to full screen.

The iPhoto photo library holds any number of photos — limited only by how
much space you have on your hard drive. Even if you store thousands and
thousands of photos in your library, you can find the one you want quickly
and easily by searching by titles or comments, by date, or by ratings you can
assign to photos.

Even better, you can organize the photos in separate photo albums — and

in each album, you can arrange the photos exactly in the sequence you want
for slideshows and photo books. iPhoto even offers “smart” albums that, like
the “smart” playlists in iTunes, update themselves with new photos automat-
ically based on the criteria that you set.

With iPhoto, you can produce slideshows, photo portfolios, and even nicely
bound coffee-table photo books and school yearbooks. All you have to do is
organize the photos in an album, select a theme and a layout, and bingo,
iPhoto creates the book in electronic format. You can then print out the
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pages on your own printer, or you can order professionally printed and bound
books from a service directly from iPhoto. (The service is available not only in
the United States, but also in Japan and Europe.) In the case of a school year-
book, you could get last-minute pictures into it and still make the graduation-

day deadline.

More pixels mean higher quality

When digital cameras take a picture, they

image has a total of 90,000 pixels. With a pixel

divide the image in the lens into many tiny dimension of 1,000 by 1,000, the image has a Book Il
squares, or pixels, to represent the image. Two  million pixels, or a megapixel. The more pixels, Chapter 1
factors with pixels affectimage quality. The first  or specific points of information in a picture, the
factor, controlled by the digital camera or scan-  more detail is represented, as shown in the fol- o
ner, is the spatial resolution of the image. The lowing figure. The photo on the left shows less %_
spatial resolution is the number of pixels in the  detail than the photo on the right, which was Eé
image, both harizontally and vertically. With a  taken with a higher-resolution camera. g. )
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The second factor is the number of colors your
Mac can display, which is controlled by the
Display setting in the System Preferences.
When you set the Display setting to the Millions
option, you are actually getting over 16 million
colors. You get 16 million colors because a pixel
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in a typical image can represent 256 levels of
red, green, and blue, which gives a possible
tonal range of over 16 million colors (256 x 256
x 256). Anything less than that can cause the
image to appear with splotches of the same
color rather than a subtle tonal range of colors.
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Photos are just a part of the iLife experience. iPhoto connects to the other
iLife applications, and if you explore them, you’ll find uses for your digital
photos you hadn’t thought of before, such as creating a DVD of a slideshow
using music from your iTunes library, or using photos in an iMovie project
along with video clips and music.

Saving your photos has never been easier. You can copy your entire photo
collection to another hard drive or burn CDs or DVDs with your images to
keep archives. Archiving saves all the information you have about each
photo, including date, album, film roll, keywords, and comments. After you
archive your photos on CD or DVD, you can still view them in iPhoto directly
from the disc — when you insert the disc, the archived library on the disc
appears automatically in iPhoto with its titles, keywords, and photo albums.

You can also share photos. E-mail them directly from iPhoto if you use the
standard Mac OS X Mail application, or even Eudora or Microsoft Entourage.
You can even share entire slideshows with others on the Internet using the
.Mac service, or you can post photos on Web pages. Essentially everyone
can have a copy of your photos.

We describe slideshows in detail in Chapter 5 of this minibook. You can read
all about printing photos and photo books and sharing photos online in
Chapter 6 of this minibook.

Opening Images in iPhoto

This section provides a tour of iPhoto. If you're using iPhoto for the first
time, you won'’t have photos in your photo library until you import them,
which we cover in Chapter 2 of this minibook. If you already have photos on
your hard drive (either scanned images or files from a digital photo service),
you can drag the files directly to the iPhoto window after starting iPhoto to
add them to your photo library.

Starting iPhoto

The iPhoto icon is available in the Dock, which appears typically at the bottom
of the desktop. To start iPhoto, click the iPhoto icon.

When you start iPhoto, its window takes up a good portion of your desktop,
but you may want to make it as large as possible to see all your thumbnails
and view individual images with as large a viewing area as possible. To do this,
choose Windowr>Zoom. The Zoom Window command fills the desktop with
the iPhoto window. To make the iPhoto window smaller, choose Window=>
Zoom again.
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To make the window invisible but accessible from the Dock, choose Window=>
Minimize. (If you do this and then can’t find iPhoto, click either the iPhoto
icon or the newly created minimized document icon in the Dock, and the
window reappears.) iPhoto works like all the other “i-applications” in

Mac OS X.

Changing your display settings

When you start iPhoto, you may get the message Caution: The current
screen resolution is not optimal for iPhoto. Whether accidentally
or intentionally, your color display setting is set to fewer colors than the dis-
play can actually handle, or your display’s resolution is set too low. Either
one of these settings, if not set to its highest value, causes this message to
appear. And in particular, if you use an older iBook, the settings provided for
the iBook display always cause this message to appear.

If you're unlucky enough to get this message, don’t panic. iPhoto still works
properly, but colors in images may appear in solid splotches rather than
smooth gradients, and the images themselves may not appear as good as
they would at the higher settings. The images aren’t changed, of course —
the digital information is still there. All you need to do is change your dis-
play settings.

You can change your display settings at any time in OS X and your settings
take effect immediately. However, you should first quit iPhoto before doing so.

Follow these steps to change your display settings:

1. Choose System Preferences from the Apple menu.
The System Preferences window appears.
2. Click the Display icon.

The icon appears in the Hardware row of icons (and also, typically, in
the top row of most-used icons).

The Display Preferences window appears.
3. Click the Display tab.
The Display pane appears.
4. Choose the highest pixel resolution setting in the Resolutions list.

The resolution settings are on the left side of the Display pane. Your dis-
play may be capable of 1024 x 768 pixels; you should choose that setting
or a higher one if available.
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5. Choose the Millions option from the Colors pop-up menu.

The Colors pop-up menu is to the right of the list of resolution settings,
in the Display pane. Your display should be capable of displaying mil-
lions of colors; choose that setting so that your photos look their best.

6. Close the System Preferences window by choosing System
Preferences~>Quit System Preferences.

Your display changes automatically to the new settings. Now your display
settings offer the best quality viewing for your photos.

When you start iPhoto the first time, iPhoto asks the question Do you want
to use iPhoto when you connect your digital camera? Click the Yes
button to have iPhoto start up automatically when you connect your digital
camera. If you click the No button, iPhoto will not start up automatically —
you have to explicitly launch iPhoto (or some other application) to import
photos from your digital camera.

Getting around in iPhoto

The iPhoto window is split into three major sections, or panes (as in window-
panes), as shown in Figure 1-1. The three panes are

4+ The Tools pane: The iPhoto Tools pane acts like a control center, offering
one-click access to the iPhoto tools. These tools change when you switch
modes by clicking the mode buttons, which are Import, Organize, Edit,
and Book.

4 The Source pane: The list of albums (and other sources of images)
appears in a pane on the left side of the window. You use this list to
organize your photo albums and select them for viewing. Beneath this
pane are buttons for creating a new album, playing a slideshow, showing
information about the selected photos, and rotating the selected photos.

4+ The Viewer pane: The largest pane — the viewer — displays your photo
thumbnails when you are in Organize mode. Individual photographs
show when you select one for viewing or editing.

When you first use iPhoto, the photo library appears in the Viewer pane.

As you organize photos into photo albums, the names of the albums appear
in the Source pane. You can change the Viewer pane to show only a single
album’s photos by selecting the album’s name in the Source pane. To view
the entire photo library, click the photo library at the top of the Source pane.

Use the mode buttons to switch modes of operation:

4+ Import: Transfer photos from your digital camera or memory card
reader. (You can also transfer images from hard drives and digital



93

Opening Images in iPhoto

backup media by dragging the image files to the iPhoto window or by
choosing Filec>Import.)

+

Organize: View your photo library and organize photo albums.

4+ Edit: View a single photo to make improvements, such as removing red-
eye and changing brightness and contrast.

4+ Book: Organize photos into a book layout for printing books.
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The Viewer pane of the iPhoto window shows thumbnail images of your
photos. You can change the size of the thumbnail images — make them
shrink or grow larger to see more detail — by dragging the size control slider
(beneath the Viewer pane) to the right, as shown in Figure 1-2. The size con-
trol slider has an icon of a large photo on one side and a small one on the
other.

To look at a single image, double-click the thumbnail of the image, or click it
once (to select it) and click the Edit mode button. Either way, the image fills
the Viewer pane, and the tools in the toolbar change into the Edit mode
tools, as shown in Figure 1-3.
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As you see in Figure 1-3, even in Edit mode, the size control slider is avail-
able to make the image larger or smaller, so you can zoom in on an image to
see more detail, or zoom out to see the entire picture.
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For optimum viewing, check out the following tips:

4+ Open a photo in a separate window: Hold down the Option key while
double-clicking a photo’s thumbnail for an even better way to view a
photo, as shown in Figure 1-4. iPhoto scales the photo in its proper
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proportions, rather than stretching it to fit the iPhoto viewer pane, so
the image looks exactly as it should.

If you like the separate window approach to view your photos, and you
want iPhoto to do this every time you double-click a photo (rather than
using the Viewer pane in Edit mode), choose iPhoto>Preferences, and in
the Preferences window that appears, switch the Double-click option to
the Opens in Separate Window option.

Compare several photos side by side: Open several photos, each in sep-
arate windows, by holding down the Option key while double-clicking
the thumbnails. This is where a large display comes in handy.

You can tell how large the photo is, too — whether it is a small photo
scaled to display at 100 percent magnification, which is its actual size, or
if it is a very large photo scaled at 50 percent or less in order to display
it. iPhoto displays, in the window’s title bar, the percent the photo is
scaled — for example, in Figure 1-4, the photo is scaled to 39 percent of
its actual size.

Zoom in and out of photos: The Zoom buttons on the left side of the
photo window’s special toolbar (at the top of the window) allow you to
zoom in or out of the photo. You can also scale the photo by dragging
the window’s lower-right corner to make the window larger or smaller.
The Fit button in the window’s toolbar automatically scales the photo to
fit the window. The window’s toolbar offers many of the Edit mode tools,
including cropping and rotating, in the toolbar.

Zoom

|606 tonyl (39%) =]
R =TH = _ =5 = »
3

Fit Rotate Constrain Brightness/Contrast
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You can experiment freely with the Edit mode tools to improve your photos,
as we describe in Chapter 4 of this minibook. You can, for example, click the
B & W button to turn the photo into black and white (grayscale). You can
adjust brightness and contrast, and even experiment with retouching and
cropping. It doesn’t matter how much you experiment — if you don’t like a
change you make, don’t worry: iPhoto stores originals of every photo in its
library. Simply choose Photos=>Revert to Original, and your original photo is
restored in pristine condition.



Chapter 2: Importing Photos

In This Chapter

v+ Importing your photos from a digital camera
1+~ Using a photo service to import photos
v Importing images from your hard drive

+» Scanning images into iPhoto

Wth iPhoto, you can import pictures directly from your digital camera.
Don’t have a digital camera? You still like to use that old Brownie film

camera your grandmother gave you? Don’t worry. You can use a scanner to
scan photographic prints, or you can send your film rolls to a photo service
that can convert your film to digital images on a CD or the Web. (Odds are
the photo service you already use offers this service. Next time you're there,
ask about it.) iPhoto has no problem importing images from a CD or hard
drive. In this chapter, you find out how to import your photos — even those
musty photos of Grandma’s you found in the attic — into iPhoto.

Importing Photos from Digital Cameras

If you ever need to show somebody that using a Mac is much easier than
using a PC, all you need to do is open iPhoto, connect your digital camera to
the USB port, and click the Import button. That’s all there is to it. Your photo-
graphs appear in the iPhoto Viewer pane, ready to edit, print, archive, or
whatever you want to do.

Your picture-taking skills may improve with iPhoto as you experiment more,
without the space limitations of film. Because digital cameras don’t use film,
you’ll find yourself taking many more pictures than usual, dumping them
into your Mac, viewing them, deleting the truly bad ones, and taking more
pictures. As your collection of photographs grows, you will appreciate how
easy importing and organizing your photos in iPhoto is. The photo library
allows you to view all the photos you import from your digital camera.

Connecting a digital camera

USB (Universal Serial Bus) is the most common choice for connecting digital
cameras to a Mac — the exceptions are very high-quality cameras that offer
FireWire. Fortunately, both types of connections work the same way.
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To import pictures from a digital camera, follow these steps:

1.

Connect the camera to the Mac using a USB or FireWire cable.

Digital cameras typically come with a special USB or FireWire cable

that has a very small connector on one end for the camera and a larger
connector on the other end for the computer’s USB or FireWire port.
However, if both ends are the same on the cable you are using, it doesn’t
matter which end is plugged into the camera or the computer.

Power up your digital camera by pushing the power button.

Most cameras also have a power-on switch to save battery life. (Many
smart people, including ourselves, have sat there waiting for the photos
to appear, only to find that the camera was off.)

Connect your camera before you turn it on, because the Mac may not rec-
ognize some camera models unless they are turned on while connected.
If the Mac doesn’t recognize your camera, try turning the camera off and
then turning it on again.

Click the iPhoto icon to start iPhoto (if it hasn’t already started).

When you connect and power on your digital camera, the iPhoto icon
becomes animated (or dances in the Dock), awaiting your click. Depending
on how you configure your Mac, iPhoto may automatically start when the
computer detects the camera. If you are running iPhoto for the first time,
a dialog pops up asking if you want to always run iPhoto when you con-
nect a camera. Click the Yes button.

iPhoto opens, displaying the iPhoto window.
Click the Import mode button.

The Tools pane changes to show the Import tools, as shown in Figure 2-1.
iPhoto displays either a camera icon, a disk icon, or a memory card reader
icon, depending on the type of camera or memory card reader you are
using. For example, our Nikon CoolPix 4300 shows up with a disk icon.

When you start iPhoto, you may get the message Caution: The
current screen resolution is not optimal for iPhoto. This
message means that your color display setting is set to fewer colors
than the display can actually handle or that your display’s resolution is
set to a lower number than possible. See Chapter 1 of this minibook to
find out how to change your display settings.

Choose whether or not to delete the photos in your camera after
importing.

If you want to delete photos from your camera as soon as they are
imported, select the Erase Camera Contents after Transfer option in the
Tools pane (located at the bottom of the iPhoto window). Many cameras
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have a delete function, so you don’t need to use this option. However,
using this option enables you to import and delete photos in the camera
all in one step. With the photos in the photo library, you no longer need
to keep copies in your camera or memory card, and you can make room
for new photos.
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camera. =) ZT: if;::m # rase camera contents after transfer
7
6. Click the Import button.
While the importing occurs, the Import button changes to a Stop button;
to cancel the photo transfer at any time during your import, click the
Stop button. When it finishes importing, iPhoto displays a small image
for each photo in the photo library, as shown in Figure 2-2. The size of
the images in the viewing area is controlled by the zoom slider in the
lower-right corner of the iPhoto window, just underneath the viewing
area. These small versions of your images, which can be reduced to very
small, are called thumbnails.
P If your camera has a sleep mode, make sure that you disable or set it to

a time increment long enough to allow your images to import into the
Mac. Importing 24 photos generally takes about one minute with most
digital cameras.

Disconnect the camera (eject it first if necessary).

If ejecting is required, the camera’s icon appears on the desktop. To
eject the camera, click the camera’s icon and hold down the mouse
button. The Trash icon changes to the Eject icon. You can then drag the
camera’s icon over the Eject icon to eject the camera properly. Although
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nothing really happens (nothing actually ejects from the machine, nor
do any doors open), you may find that if you don’t eject as required with
some cameras, your images may not delete from the camera even if you
have the delete option enabled.
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P Of course, if you don'’t like to drag icons (such as when you use a laptop in
an airline seat and dragging may cause you to elbow your neighbor), you can
click the camera icon and press 38+E. When the camera ejects properly, you
can then disconnect the camera.
Remember: Wait until all photos are transferred into iPhoto or click the Stop
button before disconnecting your camera.
Vg‘\\\NG! If you disconnect your camera and suddenly get a message from OS X telling

you that the device isn’t properly disconnected, this means that you didn’t
drag its icon over the Trash icon. USB devices may be in trouble if you did
this — with hard drives, for example, you could lose data if the hard drive is
disconnected improperly, and with digital cameras, the flash media for stor-
ing images may be damaged.

Importing from memory card readers

Additional memory cards are like extra rolls of film. A memory card reader is
useful if you take lots of pictures and use multiple cards. Rather than connect-
ing your camera to your Mac every time you want to transfer pictures, leave
the card reader connected to the USB port of your Mac and put the camera’s
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memory card in the card reader. If you use multiple memory cards, this
method is especially convenient.

Many cameras come with relatively small memory cards — 16MB or less,
enough to hold about 24 pictures. Memory card formats include Compact
Flash, SmartMedia, and Memory Stick. They all function in a similar manner,
but they’re different physical sizes and shapes.

If you want to get more memory cards for your camera, be sure to ask for the
right kind of card, as the wrong type won’t work with your camera. Generally,
a sample memory card is provided with your new digital camera, along with
information about which type of cards to buy.

iPhoto imports photos from a card reader just as it does with a camera,
using the same steps:

1. Connect the card reader to the Mac.

Standard USB cables generally work with card readers, so either end of
the cable can be plugged into the card reader and the computer. If you
use a memory card reader that doesn’t offer a USB connection, it may
provide a PCMCIA card for a PCMCIA slot often found in computers,
especially PCs. Some Mac models also offer PCMCIA slots, and you can
insert the PCMCIA card for the memory card reader into a slot and use it
like any other device.

2. Power up your card reader and insert a card.

Use the power button on your card reader if you have one; many card
readers power themselves on by sensing power from the USB cable.

3. Start iPhoto.

The iPhoto icon is available on the desktop in the Dock. Simply click the
iPhoto icon, and the iPhoto window appears.

4. Click the Import mode button.

The Tools pane changes to show the Import tools (refer to Figure 2-1).
You won'’t see an icon, however, unless you insert a card into the reader.

5. Click the Import button in the Tools pane.

If your card reader is connected and powered on, iPhoto displays the
card icon in the Tools pane, along with the number of photos on the
card and the Import button. While importing, the Import button changes
to the Stop button. To cancel the photo transfer at any time during your
import, click the Stop button. If you want to delete photos from the
memory card as soon as they are imported, select the Erase Camera
Contents after Transfer option in the Tools pane. With the photos in the
photo library, you no longer need to keep copies on your memory card,
and you can make room for new photos.
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6. Eject and disconnect the card reader.

Wait until all the photos transfer into iPhoto or click the Stop button
before disconnecting your card reader. After you finish importing your
photos, drag the card reader’s icon from the desktop to the Trash icon
in the Dock. However, you may find that leaving your card reader con-
nected to your Mac is useful, because you can just switch memory cards
to import more photos.

Transferving Images from Other Sources

If you don’t have a digital camera, don’t worry. You can turn your film into
digital images in many ways. You can continue to use your favorite film
camera and probably even continue using whatever services you use now
for film processing.

If your camera uses 35mm film, you can have your pictures developed by a
digital imaging service, such as PhotoWorks (www.photoworks.com) or the
“You’ve Got Pictures” service on America Online (sponsored by Kodak).
Many services offer digital processing of film and choices on how to deliver
the digital images — on a floppy disk or CD, or posted on the Web for easy
downloading to your Mac.

Suppose that you have photographic prints or slides. You may think that
prints or slides can’t be included in the photo library. But you’d be wrong. In
fact, you can not only include them and organize them into albums, but you
can also improve these photos. Then you can create new prints and do any-
thing with them that you can do with your digital images.

Using a photo service

Many photo services offer photos on CDs, which can be mailed to you or
picked up at your convenience. Typically, the service offers either the Kodak
Picture CD or Photo CD formats, but it may offer a special format that requires
software from the service.

We should mention here that professional photographers using film cameras
should investigate professional services that offer at least the Photo CD
format. Services offering high-resolution film scanning most likely offer
Photo CD discs that you can use with your Mac and iPhoto, as well as high-
resolution digital files that can be transferred by network or high-speed
Internet connection. The Photo CD format offers resolutions high enough
for even magazine-quality photo prints.

If the format is Photo CD or Picture CD, you import the photos by following
these steps:
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1. Insert the CD into your CD-ROM drive.
An icon representing the CD appears on the desktop or Sidebar.
2. Click the CD icon to view the files in the Finder.

3. Open iPhoto by clicking its icon in the Dock (or by double-clicking the

iPhoto application in Applications).
iPhoto opens.

4. Drag the individual files (or folder of files) containing the photos to
the iPhoto Viewer pane (as shown in Figure 2-3).

5. Close the Finder window by clicking the button in the right corner of

the title bar when the files finish copying.
6. Drag the CD icon to the Trash icon to eject the CD from the CD-ROM
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If you drag a folder, a film roll is created with the folder’s name. If the folder
you import contains subfolders, film rolls are created with each subfolder’s
name. We describe how to edit the film roll information in Chapter 3 of this

minibook.

If a service offers images on floppy disk, you may want to choose that
medium. However, floppies hold only about 1MB of image data, compared

to nearly 600MB available on a CD. You also need to have a floppy disk drive

for your Mac, which is not included in the newest Mac models.
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If a service offers a format that is not Photo CD or Picture CD, it most likely
offers software you can download that extracts the images from the CD and
saves them as image files on your hard drive. Although having every service
use the same or similar format would be convenient, some services offer
proprietary formats. For example, PhotoWorks offers a CD format that
requires use of the service’s special software, but this software offers the
ability to organize photos into albums, much like iPhoto itself. PhotoWorks
offers this software not to compete with iPhoto, but to provide iPhoto-like
functions for people who use PCs and older Macs that can’t run iPhoto. The
software is free and very easy to download, and it is also supplied with the
CD in case you don’t want to download it.

When a service offers a proprietary format with special software, make sure
that the software can save the image in one of the following formats: TIFF,
PICT, JPG (or JPEG), or EPS. You don’t need to know anything about these
formats to import them, except that TIFF is the preferred format for photos
because it guarantees the highest quality without compression. iPhoto can
import images in any of these formats automatically.

Importing images from your hard drive

If you save images to your hard drive in one of the appropriate formats, you
can then import each file or a folder of files. Follow these steps to import files:
1. With iPhoto open, choose File=>Import.
The File Import dialog appears.

2. Use the Mac Finder browser to find the folder containing the image
files.

3. Select the image file or files to import.
4. Click the Import button.

Your images import to the photo library.

You can delete the image files from your hard drive after importing them.

Using a scanner

A scanner optically scans a photographic print, slide, or negative, and then
creates a digital image. A scanner can be controlled directly by a Mac using
the Image Capture application.

Unless you have a consistent need for scanning, you may get by with using
a scanning service at a local copy shop. Many shops offer self-service scan-
ning with instructions, and others do the scanning for you. All you need to

know to order scans of photographic prints is the following:
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4 Ask for the highest color depth. The Mac can handle millions of colors,
which is also known as 32-bit color in the world of PCs.

4+ Ask for the highest affordable resolution. Many services offer scanning
at 600 dots per inch (dpi), which is acceptable for most personal uses.

4+ Select the TIFF file format. TIFF files are better than any other com-
pressed file format (such as JPEG) for images that you still want to work
on — to edit or retouch, as we describe in Chapter 4 of this minibook.

If your scanner is connected to your Mac (most likely with a USB cable),
install the Mac OS X software that was provided with it. If you don’t have the
software, check with the manufacturer of the scanner to see if it works with
Mac OS X. If it does, you can use the Image Capture application, located in
the Applications folder, to scan photos:

1. Open Image Capture and click the Full Screen button to see the whole
image.

2. Use the selection tool in the toolbar to zoom in and define the image
scan area.
You can select either a portion of the image to scan or select the entire
image.

3. When you’re satisfied with the results, click the Scan button to create
a TIFF file and save the file on your hard drive.

Image Capture provides a dialog for saving the TIFF file in a folder on
your hard drive.

Use the Options button in the toolbar to change the scanner’s settings to set
image-related options, such as resolution if you don’t like the outcome of the
file. Check the documentation that came with your scanner for more infor-
mation about its capabilities.

If you want Image Capture to open automatically when you press a button on
your scanner, choose the Preferences option from the Image Capture menu.
In the Preferences dialog, select the Image Capture option from the When a
Scanner Button Is Pressed, Open menu.

Finally, import the TIFF file into iPhoto by following these steps:

1. Choose File~> Import.
The File Import dialog appears.
2. Navigate to the folder containing the image files.

3. Select the image file to import.
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4. Click the Import button.
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The files are imported into iPhoto.

After you import image files, the images in those files become part of the
photo library. You can delete the image files after importing them.

Scanner talk

Before digital cameras became widely avail-
able, the only way to get a photo into digital
form was to use a scanner — a machine that
optically scans a photographic print or slide in
the same way that a copier can optically scan
a piece of paper and reproduce it.

In fact, most copiers are essentially scanners,
and many of today’s office copiers double as
image scanners when connected to a com-
puter. The typical flatbed scanner is popular
because you can put anything on the scanning
surface — a photographic print, a book page,
a newspaper, an object, or even a body part
such as your hand — and scan the material.
Sheet-fed scanners look more like copiers and
accept only flat pieces of paper, making them
not as useful for scanning photographic prints.

Slide scanners are designed for scanning
35mm slides. They are a bit more expensive
than your average flatbed scanner. If you have
slides that need to be scanned, you may want
to instead use a photo service, as many of them
offer slide scanning. Slide scanners aren't con-
venient to buy because of the expense and

because digital cameras are cheaper and
easier to use. If you really need slides, a photo
service can take your digital photos and create
slides from them.

If you are even semi-serious about getting a
scanner, check out Scanners For Dummies by
Mark L. Chambers (published by Wiley Publish-
ing, Inc.). Image Capture works with scanners
that have driver software for Mac 0S X. Image
Capture also works with TWAIN drivers that
are Mac 0S X-compatible. Other applications
that can control scanners using Mac 0S X or
TWAIN drivers include GraphicConverter,
Photoshop, and Photoshop Elements (Graphic-
Converter is currently included on some Mac
models). TWAIN is a standard protocol for
controlling scanners from computers and has
nothing to do with Mark Twain, nor is it an
acronym — it refers to Rudyard Kipling's “The
Ballad of East and West” and its famous line,
“...and never the twain shall meet...” —an
ironic reflection on the difficulty, at that time, of
connecting scanners and personal computers.




Chapter 3: Organizing Photos

In This Chapter

1+ Organizing photos into photo albums and smart albums
1+~ Using iPhoto as a digital contact sheet
v Arranging, sorting, and searching for photos

v Backing up your photo library and sharing it over a network

Fee photos are a wonderful thing. After you see how easy taking pictures
with a digital camera is, and how you can save your photos on the Mac
without spending money on film and share them with others by printing
them yourself or sending them by e-mail, you'll start experimenting at will.
Go ahead, take another shot. If you run out of space on your digital camera’s
memory card, connect your camera or card reader to your Mac, download
the photos to the photo library, and delete them from the memory card.
Then go back and take more pictures!

The iPhoto photo library can hold any number of photos; the number is lim-
ited only by available hard drive space. At an average size of 1MB per photo
(and many photos occupy less space), you can store 20,000 photos in a 20GB
hard drive. And, of course, you can expand a photo library over multiple
hard drives or create multiple libraries. The number of digital photos that
you can manage has no practical limit, especially if you use backup storage
devices and media, such as DVDs. For all practical purposes, you can keep
shooting pictures forever.

Fortunately, you can organize even massive quantities of photos in the
photo library. You can add keywords, titles, and film roll information to each
photo automatically, to make locating a particular photo very easy. iPhoto
also provides a very convenient organizing metaphor for assembling sets of
related photos: the photo album. You can organize hundreds or thousands of
photos into albums to make the photos easier to locate. This chapter shows
you how to organize your photo library and photo albums, assign titles and
keywords to photos, and manage your library.

Photo Albums for All Occasions

You’ve probably seen photo albums with plastic sleeves for holding photo-
graphic prints. A digital photo album is similar in concept but holds digital
photo files instead of prints. In both cases, an album is simply a way of
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organizing photos and placing them in a proper sequence. When you create
a photo album in iPhoto, you select the photos from your photo library and
arrange them in the order you want.

You can use photo albums to assemble photos from special events, such

as a vacation, or to display a particular subject, such as your favorite

nature photos. You can also use albums to organize photos for a slideshow,
QuickTime movie, or Web page. Students on a class trip can contribute
photos from their cameras to the same photo library, and you can create a
set of albums that document the trip, and then post the documentary as a
slideshow on the Web. You can organize a photo album of a band on tour and
add music from the tour to create a slideshow — just like a rockumentary!

You can make as many albums as you like using any images from your photo
library. Because the albums are /ists of images, they don’t use up hard drive
space by copying the images — the actual image files remain in the photo
library. Like an iTunes playlist, an iPhoto photo album is a list of references
to photos in your library. You can include the same photo in several albums
without making multiple copies of the photo and wasting hard drive space.
You can even delete a photo from an album without actually removing it
from your library, as we show in this chapter.

Creating albums and adding photos

To create a new photo album and add a photo to it in iPhoto, follow these
steps:
1. Click the Organize mode button.

The photos in your library appear as thumbnails in the Viewer pane, as
shown in Figure 3-1.

2. Click the + button.

The + button is underneath the Source pane (refer to Figure 3-1).
Alternatively, choose File> New Album or press $8+N.

The New Album dialog appears.
3. Type the album name and click OK.

The default name appears highlighted in the New Album dialog. Type a
name for the album (other than “Album-1” — something descriptive), as
shown in Figure 3-2.

4. Click a photo in your library and drag it into the album.

You know the photo is selected when an outline appears around it —
drag the photo over the name of the album in the Source pane.

5. Repeat Step 4 until you drag all the photos you want for this album.
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When you click an album name in the Source pane, only the photos you
dragged to the album appear in the Viewer pane, not the entire library.
You can switch back to the entire library by clicking Photo Library in the
Source pane. Find out how to organize your album later in this chapter
in the “Arranging photos in albums” section. To view the entire photo
library again, select the photo library in the Source pane.
Figure 3-2: New Album New Album
Type the Please enter a name for the new Album: Please enter a name for the new Album:
new photo Plbum-1 Vacation-Spring 2003{[
album,s { Cancel ) @ { Cancel ) @
name.

You can select multiple photos for dragging by clicking the first one and hold-
ing down the Shift key while clicking the last one — the first, last, and all the
photos between them are selected automatically. You can then drag the selec-
tion over the name of the album in the Source pane, as shown in Figure 3-3. A

number appears, showing the number of selected photos in the range.

The same selection rules that apply to files in the Finder also apply to
photos in the iPhoto viewer:
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+

Click the photo once to select it. You can then drag the photo.

Click the first photo and Shift+click the last photo to select a range of
photos. You can then drag the entire selected range.

After making a selection (single or a range), you can add a noncon-
secutive photo to the selection by $+clicking a photo. You can also
88 +click a selected photo to remove it from the selection.

iPhoto
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Another way to select multiple photos is to first reduce the thumbnail size
with the size slider, and then drag a selection rectangle around all the
thumbnails. You can then drag the selection over the album name to add all
the photos at once. Of course, with thumbnails that small, you may not be
able to determine which photos belong and which don’t. Don’t worry — in
the next section, “Arranging photos in albums,” we show how to remove
unwanted photos from an album.

P You can also create an album by dragging a folder of photos from the Finder

into the iPhoto Source pane. iPhoto creates an album with the folder’s name
and imports all photos contained in the folder. Using the Finder, you can add
a photo to an album directly from a CD or from another location on your
hard drive.

Arranging photos in albums

To see the photos gathered into an album, click the name of the album in the
Source pane.
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All your photos are still in the library; the Viewer pane shows only the photos
you added to the album. You can organize the photos within your album with-
out having to wade through all the other photos.

The order that your photos appear in the album is important — it defines the
order of photos in a slideshow or a book layout. You will probably always want
to change the order of photos after you create an album. To change the order
of photos in an album, follow these steps:

1. Click the album name in the Source pane.
2. Click the Organize mode button.

iPhoto switches to Organize mode, with organization tools in the Tools
pane and photo thumbnails in the Viewer pane.

3. Click a photo and drag it to a new location or select multiple photos
and drag them to a new location.

Figure 3-4 shows the four lake photos as they are dragged to a new loca-
tion near the end of the photo album.

4. Repeat Step 3 until all your photos are arranged as you want them in
the album.

You can also use the Cut, Copy, and Paste commands in the Edit menu to
organize your photos. Use the Cut command (Edit=>Cut) to move one or more
selected photos from one location into another location (Edit>Paste). Use the
Copy command (Edit=>Copy) to leave the selected images in the original loca-
tion and repeat them in the new location. Using the Copy and Paste commands,
you can repeat images throughout an album as many times as you like.
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To use the same photo in more than one album, simply drag the thumbnail
for that photo over one album, and then select and drag the thumbnail over
another album. The photo appears in both albums without having to create
duplicate copies of the image and waste hard drive space. You can also use
the Copy command (Edit=>Copy) to copy a selected photo from the library
to an album — after using the Copy command, select the album in the
Source pane, and use the Paste command (Edit=>Paste).

You can also duplicate an entire photo album, in case you want to arrange
the photos in different ways. You don’t actually duplicate the photos, so
hard drive space is not wasted. To duplicate an album, select the album
name in the Source pane and then choose Photos=Duplicate. A new album
is created with the same name and “--1” is added to the name. You can then
rename the album if you want.

Removing photos from albums

You may have been a bit hasty with your selections in the photo library when
dragging them over to the new photo album. Or perhaps you just noticed that
useless shot you accidentally took of the side of a barn. Never mind — to
delete a photo, just select the photo in the album and press the Delete key.

If you are squeamish about pressing the Delete key (and who isn’t?), select
the photo and choose Photos>Remove from Album.

When you remove a photo from an album, the photo is not deleted. It remains
intact in your photo library. The only way to delete a photo from the library is
to select the Photo Library in the Source pane, select the photo in the library,
and then press the Delete key or choose Photos=>Move to Trash. You can also
select the photo and press 88+Option+Delete, or you can simply drag the
image from the library to the Trash icon in the Source pane.

Photos you delete from your library are still available in the iPhoto Trash
until you choose Filem>Empty Trash. After emptying the trash, the photos are
truly deleted.

If you delete something that you didn’t want to delete, you can usually undo
the operation by choosing Edit=>Undo. If you perform some operations after
deleting the photo, you may have to choose Edit>Undo several times and
undo all the subsequent operations before you can undo the deletion.

Using an album for desktop and screen effects

One of the surest ways to demonstrate your skills with a Mac is to personal-
ize your settings for Desktop & Screen Saver (or separate Desktop and Screen
Effects in previous versions of OS X) to show your iPhoto library of photos.
The Desktop is the background image behind the Finder.
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The Screen Saver (or Screen Effects) function displays animation when your
computer is inactive. In typical computer jargon, the screen animation is
called a screen saver. To protect your display from prying eyes, you can set
the Screen Saver (or Screen Effects) setting to display animation if your com-
puter hasn’t been used for a certain number of minutes. Apple provides a set
of effects, but you can use an album from your photo library as your screen
saver — the photos appear one after the other, like a slideshow.

To set your Desktop and Screen Saver (or Screen Effects) settings to a photo
album, follow these steps:

1. With iPhoto open, click the Organize mode button in the toolbar.

2. Select an album or group of photos.

3. Click the Desktop icon in the Tools pane.

In OS X version 10.2 and earlier, the Screen Effects tab appears, as shown
in Figure 3-5, with the Pictures Folder selected. This pane is also available
by clicking the Screen Effects icon in System Preferences.
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In OS X version 10.3 and newer, the Desktop & Screen Saver pane of
System Preferences appears, and your desktop background is automati-
cally set to the first photo (or the selected photo) of the album.

4. Click the Screen Saver button and choose iPhoto Selection, as shown
in Figure 3-6 (or click the Screen Effects tab in older versions of OS X,
and choose Pictures Folder).

In OS X version 10.2 and earlier, the Screen Effects tab opens the pane
that lets you assign a screen effect. Click the Pictures Folder choice in
the list of screen effects, if it is not already selected.
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In OS X version 10.3 and newer, the Screen Saver button opens the pane
that lets you assign a screen saver. Click the iPhoto Selection choice in
the list of screen savers, if it is not already selected.
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Your pictures are now used for the screen effects; to see them working, just
leave your computer inactive for the time it takes to launch the screen effects.
If you’re impatient, you can see the effects right away by clicking the Test
button.

In OS X versions 10.3 and newer, the Screen Saver pane provides an Options
button — click it to access the display options. In OS X versions 10.2 or ear-
lier, use the Configure button. You can control cross-fading between slides,
zoom back and forth, crop slides to fit the display, and so on by selecting the
check boxes:

4 Cross-Fade between Slides: On. A cross-fade is a smooth transition from
one image to another.

4 Zoom Back and Forth: On. The screen effect zooms into the image to
show more detail, and zooms out to show the entire picture.

4+ Crop Slides to Fit on Screen: On. This option draws a smaller rectangle
inside the image and cuts away everything outside the rectangle in order
to fit the image on-screen.



Figure 3-7:
Change the
hot corner
settings for
your screen
saverin
0SX10.3
and newer.

Photo Albums for All Occasions 115

4+ Keep Slides Centered: Off. When you select this option, the pictures are
always centered on-screen without the need for cropping.

4+ Present Slides in Random Order: Off. When you select this setting, the
images appear in random order rather than in the sequence you arranged
for the photo album in iPhoto.

In OS X 10.3 and newer, the Screen Savers pane offers a slider for setting the
number of minutes before the screen effects turn on (refer to Figure 3-6). You
can also click the Hot Corners button to open a window, as shown in Figure 3-7,
that enables you to set hot corners — corners of the display that activate the
screen effect when you drag your mouse into them. You can use the pop-up
menus for one, two, three, or all four corners, and you can choose whether to
start or disable the screen saver (or choose other actions, such as exposing all
windows, or no action at all).

In OS X version 10.2 and previous versions, the Screen Effects pane offers
controls over activation with the Activation pane, and the ability to set hot
corners in the Hot Corners pane. Click the Activation tab for the Activation
pane and drag the pointer in the timeline to set the number of minutes
before the screen effects turn on.
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Why use screen effects?

Screen effects are primarily eye candy. At one
time, there was a need for protective measures
to keep your display in good condition. Old
cathode ray tube (CRT) monitors were vulnera-
ble to prolonged use: Pixels could burn out over
time if they did not change their color values.
The pixel would freeze on a certain color value
and stay that way. When this happened, the
pixel appeared in a strange color in the context
of the other pixels around it. Eventually, if
enough pixels died, your display wouldn't look
so good.

With animation, each pixel of the display
changes over time, so that it doesn’t burn out
and freeze on one color. Photos were also con-
sidered good to use because, typically, every
pixel in a photo has a different color value. The
best animation for screen saving was switch-
ing from one photo to another (as in a slide-
show), because the switching exercises all the
pixels in the display.

And so, the screen saver was born, and some
are even famous today, such as the flying
toasters of the After Dark package, the scenes
from Star Trek, and custom screen savers from
rock stars such as Todd Rundgren, David
Bowie, and the Grateful Dead.

Even so, the only monitor Apple currently sells
that could possibly use a screen saver as a pro-
tective measure is inside the eMac, and it has
special circuitry that dims the screen even if
the screen saver is running. In other words, a
screen saver is mostly useful as a privacy
screen and as eye candy.

Screen effects do not protect LCD displays in
laptops. The most important display part in a
typical laptop is the backlighting, which is not
affected by screen effects. In laptops, use the
Sleep and Energy Manager settings to protect
hardware and save energy.

P You can also set the screen effect to ask for a password when waking from the
screen effect. With a password, you can leave your computer inactive on your
desk, running the screen effects, and prevent any unauthorized use. In OS X
version 10.3 and newer, open System Preferences, click Security, and select
the Require a Password to Wake This Computer from Sleep or Screen Saver
option. In OS X version 10.2 and earlier, select the Use My User Account
Password option in the Activation pane.

Your desktop background doesn’t have to change for any reason other than
you want something nice to display, perhaps to show a part of your personal-
ity. In OS X version 10.3 and newer, the Desktop & Screen Saver pane of System
Preferences appears when you click the Desktop icon in iPhoto, and your
desktop background is automatically set to the first photo (or the selected
photo) of the album. You can change the photo by following these steps:

1. Open System Preferences and click Desktop & Screen Saver.

2. Click the Desktop tab to see the Desktop pane.
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3. Select iPhoto Selection from the list of desktop image choices.

Your photo album appears in the viewer section of the Desktop pane.

4. Click a photo thumbnail in the viewer section of the Desktop pane.

Your desktop background is automatically set to the photo you choose.
You can switch photos by clicking another photo, or switch to another
type of desktop image by clicking a choice in the list of desktop image

choices.

In OS X version 10.2 and earlier, you can place images from your photo
album into the collection of images used with the Desktop Preferences set-
tings. The Desktop Preferences settings control the background displayed
behind the Finder. To access the Desktop Preferences settings, open the
System Preferences window and click the Desktop icon. The Desktop
Preferences window appears, as shown in Figure 3-8, with preview images.
Your album name appears in the Collection menu, and images from your
album appear below that menu in thumbnails. Click a thumbnail image to
make that picture the background picture for your desktop.

8o

Desktop (=]

b3
Show All

2@ o

Sound Network Startup Disk D\.sp\ays Sharing

Current Desktop Picture:

Select an image from the collections.

Collection:  iPhoto Selection

[ _ )

| Change picture

Creating a smart album

iPhoto lets you create smart albums, which automatically add photos to the
album based on prearranged criteria. You can set up a smart album that
decides which photos to include based on the ratings you assign to them
(see the “Adding ratings to photos” section, later in this chapter). For exam-
ple, you might want to set up a smart album with only the highest-rated
photos taken during the last six months.
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To create a smart album, follow these steps:

1. Choose FileZ>"New Smart Album; in the dialog that appears, type a
name for the album in the Smart Album Name field.

2. Select options from the pop-up menus to set the criteria for including
photos in the smart album, as shown in Figure 3-9.

Figure 3-9 shows that we specified that only high-rated photos taken
after September 1, 2003 should be included in this smart album. Select a
condition from the first pop-up menu and choose a comparison, such as
the greater than or less than, from the second pop-up menu.

Figure 3-9:
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3. Combine conditions for better results.

To add additional matching conditions, click the Add (+) button. Then
decide whether to match all or any of these conditions by choosing
either option from the Match pop-up menu.

4. When you're finished adding conditions to establish the smart album
criteria, click OK to save your smart album.

iPhoto automatically updates your smart album when any photo that
matches the criteria is added or removed from the library. Smart albums are
indicated by a gear icon in the Source pane.

You can look at and change the criteria for a smart album by first selecting
the smart album in the Source pane and then choosing File=>Smart Album.
You can then make changes to the criteria and click OK to save them.

The Digital Contact Sheet

In commercial photography, a contact sheet is a quick print of photos in a

thumbnail size with titles and information about the negatives. If you were
ordering wedding pictures, for example, you may be presented with a con-
tact sheet for choosing the pictures you want developed. You may mark a
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few pictures for large prints that can be framed, and several dozen more to
be developed at normal size for your photo album, and tell the photographer
to discard the rest in order to save money.

If all this sounds familiar, it’s because you can perform all these functions
(and more) with iPhoto — and you wouldn’t even have to discard any to
save money. In fact, iPhoto is set up to look like a contact sheet, with thumb-
nail images arranged in any order you choose. A huge difference exists, how-
ever: iPhoto is a digital contact sheet. You can find photos faster, sort them
easier, and save the information about them more securely than with an old-
fashioned contact sheet.

Every picture tells a story, but you still need words to describe your pic-
tures. A title, for example, may be all you really need to identify a particular
photo. iPhoto allows you to arrange the photos by title, so you can easily
find the photo you’re looking for. You can also sort your photos by film roll
information.

Amateur and professional photographers can use the iPhoto sorting and
searching functions and assign keywords to photos, turning your photo
library into a simple database. With keywords, you can search and display
photos related by topic, or assign a check mark or “favorite” label to certain
photos and find them instantly. After a keyword search, you can quickly
arrange the found photos in a certain order to create a new photo album.
You can also add comments to each photo that can be useful as descriptions
in a book of photos (we describe how to create photo books in Chapter 6 of
this minibook).

Displaying photo information

When iPhoto imports pictures from a digital camera, it finds out how the pic-
ture was taken. The photo information includes the type of camera, shutter
speed, aperture, focal length, exposure data, whether the flash was on, the
resolution of the image, and so on.

To see information about a photo, select the photo in Organize mode (either
in the photo library or in a photo album) and choose Photos=>Show Info.
iPhoto opens the Photo Info window, shown in Figure 3-10.

The Exposure tab (on the right in Figure 3-10) provides information about
the camera’s shutter, aperture, exposure bias, and so on. The Photo tab

(on the left in Figure 3-10) offers the image resolution in pixels, the date the
photo was taken, the dates it was digitized and imported, the filename and
file size, and the camera make and model. A lot more information is found in
iPhoto than is found on a typical contact sheet, and the information is useful
for learning how to take better pictures or for choosing photos to use in
projects.
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Adding and editing titles

Titles are the most convenient way to identify photos. A title is the name or
a short description of a photo. Every photo has a title when imported —
iPhoto simply assigns the film roll and photo number to the title, usually in
an eight-character name that also doubles as the filename (with a JPG exten-
sion, as in DSCNO015.JPG).

Of course, DSCN0015.JPG is not very descriptive. You can edit the title of
each photo by typing directly into the Title field that appears below the
Source pane in either Organize or Edit mode, as shown in Figure 3-11. You
can change the title of a photo assigned to an album, and it automatically
changes the title of the same photo in the photo library. If the Title field is
not visible, click the “i” button in the toolbar, which displays brief informa-
tion, including titles and comments.

Editing a photo’s title changes it in the photo library and in all albums and
books where the title appears.

Titles can be useful for sorting purposes, and for automatically choosing
photos for smart albums. You can arrange your photos alphabetically by
title, which can be quite useful if your titles are “Beach 1,” “Beach 2,” “Beach
3,” “Trail A,” Trail B,” and so on, but not quite so useful if your titles are
more like “Several Species of Small Furry Animals Gathered Together in a
Cave and Grooving with a Pict” (your titles can be quite long if you want).

To see titles under each thumbnail image in the Viewer pane, choose
Viewr>Titles to enable the viewing of titles. (Choose it again to turn it off.)
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To see titles properly in the Viewer pane, you may want to increase the size
of the thumbnails in the pane by dragging the size slider on the right side of
the iPhoto window under the Viewer pane.

You don’t necessarily have to type a title for every photo. You may be happy
with using the filename supplied by iPhoto, which usually consists of three let-
ters identifying the source, a film roll number, and a picture number. However,
one very cool feature of iPhoto is the ability to automatically assign a title to a
set of photos. You can choose to automatically assign the date and time, or
the filename, or the film roll info, or any text you specify to the title.

For example, you can assign the date and time to a set of selected photos by
following these steps:

1. Select the photos you want to assign titles to.
You can select photos in the photo library or in a photo album.

2. Choose Photos-’Batch Change.

The Batch Change dialog appears with a pop-up menu for Title, Date,
or Comments, and another pop-up menu with values for Title, Date, or
Comments.

3. Choose Title in the first pop-up menu and a selection from the second
pop-up menu.

As shown in Figure 3-12, you have choices for short, abbreviated, or
long date formats, and 12-hour or 24-hour clock formats with or without
seconds.
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Figure 3-12:
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4. Click OK.

The photos now have titles consisting of the date and time, as shown
in Figure 3-13. Find out how to sort photos by date and time, in the
“Arranging and sorting photos” section, later in this chapter.
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Keeping track of film rolls

After taking lots and lots of pictures, you will want iPhoto to help you keep

track of them. iPhoto already knows which picture came from which film roll
or camera. Even though you are not actually using film with digital cameras,
iPhoto still uses the quaint language of pre-digital photography and refers to
a set of pictures from a memory card (or any import operation) as a film roll.

You can keep track of each film roll by viewing the thumbnail images in the
photo library with film roll information. First select the entire photo library
(select the photo library in the Source pane), and then choose View=Film
Rolls. iPhoto separates the display of thumbnails into film rolls, as shown in
Figure 3-14.
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1 Trash

1yl
i Pz 0§
-l §
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i ,v
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Size: 1600x1200
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Figure 3-14: Music: Minuet in G | r s
Keep track el llallcotne (. B o o) nr—————
el 2w 8 2@ e ®oB R
. Print Slideshow Email Order Prints  Order Book HomePage Mac Slides Desktop iDvD Burn %
Viewing your photo library by film roll gives you a useful way of sorting
photos. Click the triangle next to a film roll to hide photos. As shown in
Figure 3-15, iPhoto displays a list of film rolls, just like Finder folders. The
photos are still there — just click the triangle again to see them.
P If you have a lot of photos and begin to experience slow performance, view

your photos by film roll and hide the photos you don’t need to look at.
Viewing photos by film roll increases performance because iPhoto won’t
have to display so many thumbnails at once.
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Figure 3-15:
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To see only the photos from a particular film roll, you can choose to look at
one of the smart albums that iPhoto automatically created for you — the
Last Roll and Last 12 Months items in the Source pane. (Refer to the “Creating
a smart album” section in this chapter.) For example, to limit your viewing to
only the photos from the last film roll, click the Last Roll item in the Source
pane, as shown in Figure 3-16.
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Arranging and sorting photos

Although you can’t rearrange the photos in the photo library by dragging
them, as you can in a photo album, you can view them by different methods,
including by title, by date, and by film roll.

After initially importing photos, the iPhoto Viewer pane displays thumbnails
arranged by film roll (View=>Arrange Photos=By Film Roll). You can view
each film roll separately by choosing Viewr=>Film Rolls (choose it again to
view all the film rolls).

To arrange your photos by title, choose Viewr>Arrange Photos=By Title.

Arranging by date is just as easy: Choose Viewr>Arrange Photos~By Date.
The photos are arranged by the date you imported them into iPhoto.

Adding comments

An old Chinese proverb, often misquoted, says, “One picture is worth more
than ten thousand words.” But sometimes a few words can help explain the
picture. Those photos you took years or even months ago — do you remem-
ber what was so important about them? You may want to share information
with others about each photo, or simply add comments to photos to remind
yourself what was so significant about them or what details to look for in the
photos.

You may want to use comments as descriptive captions, as in magazines and
books. The comments you add to photos can optionally appear as captions
in printed photo books and as messages accompanying the photos you send
by e-mail, as well as on Web pages.

To add a comment to a photo, follow these steps:

1. Select a photo in Organize or Edit mode.

You can select any photo appearing in the Viewer pane for an album or
for the entire photo library.

2. Click the “i” button in the toolbar.

Typically the Comment field is not visible, even when the Title and Date
fields are showing. Clicking the “i” button once shows the Title and Date
fields, and clicking it again shows the Title, Date, and Comment fields.
Clicking it a third time makes them all disappear.

3. Type the comment in the Comment field.

Each line of text wraps to the next line as you type. The comment is
automatically saved with the photo.
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Adding and using keywords

Titles are useful for identifying individual photos. Film roll and date informa-
tion can be useful for identifying sets of photos taken at the same time or
with the same type of camera. Photo albums serve nicely as collections of
photos. But you can organize photos in another way: by keyword.

Keywords give you the power to organize your photos by topics or other
characteristics that likely appear throughout your photo library — photos of
your kids, pets, vacations, and so on. The larger your photo library, the more
useful keywords can be. After you assign keywords, you can quickly search
and locate photos using the keywords. You can also use keywords with con-
ditions for choosing photos in smart albums.

For example, you can assign the keyword “Birthday” to photos related to
birthdays, and find all the birthday shots in one search. All the photos related
to vacations can have the keyword “Vacation” assigned to them. And what if
a birthday occurred during a vacation? You can assign both keywords to
those special photos, so that a search on either “Vacation” or “Birthday”
finds those photos — indeed, a search for “Vacation” and “Birthday” finds
only those photos.

Apple thoughtfully included a set of keywords that most people find useful,
but you can rename any of them and add your own keywords as well. To see
the keywords list (shown in Figure 3-17), edit the keywords, and assign key-
words to photos, choose Photos=>Show Keywords (or press &+K).

To assign a keyword to one or more selected photos, follow these steps:
1. Click the Organize mode button to switch to Organize mode (if you're
not all ready in Organize mode).

2. Select one or more photos.

Shift+click to select a range of photos, and 3 +click to add photos to a
selection.

3. Choose Photosc>Show Keywords (or press 38+K).
iPhoto displays the keywords list (refer to Figure 3-17).
4. Select one or more keywords.

Shift+click to select a range of keywords and 38+click to add keywords to
a selection.

5. Click the Assign button.
The selected photo or photos are assigned a keyword or keywords.
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You don’t have to add all the keywords at once. You can, for example, add

\\J
the keyword “Vacation” to a set of photos, and then go back and add “Kids”
to a subset of those photos. The subset has two keywords: “Vacation” and
“Kids.”
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The supplied keywords may not be as useful as your own would be, so
iPhoto gives you a way to rename the supplied keywords, delete keywords,
and create your own keywords.
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Renaming a keyword changes that keyword in any photos to which you
assigned it. Be sure you truly want to rename the keywords assigned to the
photos, because it happens automatically.

To rename an existing keyword, follow these steps with the keywords list
open:
1. Select the keyword in the keywords list.

2. Choose the Rename option from the Keywords pop-up menu at the top
of the keywords list.

The keyword becomes highlighted.

3. Type the new keyword replacing the old one and click outside the
keyword’s text field to finish.

The new keyword replaces the old keyword wherever it is used.
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To create a new keyword, follow these steps with the keywords list open:

1. Choose the New option from the Keywords pop-up menu at the top of
the keywords list.

A new “untitled” keyword becomes highlighted, as shown in Figure 3-18.
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Figure 3-18: \ Assign Remove
Create
anew { Show All \ (" Search )
keyword.

2. Type the new keyword in the empty text field and click outside the

keyword’s text field to finish.

If you previously selected a keyword, the new keyword is inserted right
after it. You can add as many keywords as you want. Although previous
versions of iPhoto supported only 14 keywords, the current version
allows a lot more (we stopped at about 30, which is way more than we
needed).

iPhoto provides a special keyword that you can’t rename or delete: the check
mark keyword at the top of the list. When you assign the check mark to one
or more photos, a small check mark appears superimposed over the bottom-
right corner of the thumbnail image. (The check mark doesn’t change the
photo in any way — it appears only on the thumbnails in Organize mode.) You
can then easily search for all the photos marked with a check mark. Marking
photos with a check mark is simply the electronic version of marking photos
on a contact sheet with a magic marker or felt-tip pen.

Searching by keyword

After assigning keywords to photos, you can search your photo library for
photos that match your keyword selections. iPhoto assembles the thumbnails
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of the located photos in the Viewer pane so that you can easily add them to
a photo album, edit and improve them, assemble a slideshow with them, and
SO on.

To search by keyword, follow these steps:
1. Click the Organize mode button to switch to Organize mode (if you’re
not all ready in Organize mode).
2. Select the photo library in the Source pane.
3. Choose Photos->Show Keywords (or press $8+K).
iPhoto displays the keywords list (refer to Figure 3-18).
4. Select one or more keywords.

In Figure 3-19, we’re searching for all the photos that have the keyword
“Band tour.”

5. Click the Search button.

iPhoto locates one or more photos that have the selected keywords
assigned to them (in this case, “Band tour”) and displays thumbnails in
the Viewer pane.

By assigning the “Vacation” and “Kids” keywords to photos that show the
kids on vacation, you can search for either “Vacation” or “Kids” to locate those
photos, and you can narrow your search by looking for photos that match
both keywords. You can then sort the photos by title, date, or film roll.
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By creating your own keywords, you can set up a hierarchical organization
for photos. A photographer may use client names for keywords, and thereby
quickly locate photos for clients and create several photo albums for a single
client. Titles can be used to sort specific projects for clients, while the photo-
grapher can still sort by date or film roll.

Adding ratings to photos

Adding ratings to photos — are we talking about adult content? That’s one
use, but we really mean ratings that can help you decide which photos are out-
standing, which are good, which are mediocre, and so on. After you categorize
your photos, you can then use this rating system of one to five stars to decide
which photos get selected for albums. You can make this task automatic by
creating a smart album (as described in the “Creating a smart album” section,
earlier in this chapter) that selects photos based on your ratings.

To assign a rating to one or more photos, select the photo or photos and
choose Photos>My Rating. Choose a rating (or None) from the submenu of
ratings. You can also press 88+0 for no rating, 38+1 for one star, 88+2 for two
stars, and so on, up to 88+5 for five stars. To view the ratings of photos,
choose Viewr>My Rating.

Maintaining a Photo Archive

WING/
&

Whether or not you manage files on your hard drive, you may want to know
where these photos are stored, so that you can go about your usual file man-
agement tasks — such as backing up current files and archiving files you no
longer need at hand.

You may also want to move the whole photo library to another Mac — after
all, these Macs just keep getting better year after year. Make copies of all
your photos and create CDs or DVDs as archives. They’re your photos, and
why shouldn’t you have multiple copies of them? The cost of a single blank
CD or DVD is very low compared to the cost of the film you used to buy just
to take pictures (not to mention the fact that some of your photos are
undoubtedly priceless).

The operations we describe in this section make use of the Mac Finder and
the iPhoto Library folder, which is the folder that contains the individual
photo files that comprise your entire photo library. If you move, delete,
rename, or otherwise tamper with files or folders inside the iPhoto Library
folder, you may be unable to see your photos in iPhoto.
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Backing up your library

You should routinely copy your photo library to another hard drive or remov-
able storage device, or burn a CD or DVD, or even use the backup iDisk serv-
ices provided by .Mac.

We say “even iDisk” because, frankly, iDisk doesn’t offer enough storage
space (at 100MB) for most photo libraries, and it is slow to access using a
dial-up modem. We use iDisk to transfer photo albums and large files to
others, and to back up very important documents. But you are better off
using CD or DVD as a backup medium for your photo library. We describe
how to burn a CD or DVD with your photo library later in this chapter, in
the section, “Burning a CD or DVD.”

To copy the photo library to another hard drive, locate the iPhoto Library
folder using the Finder. The folder is usually located within the Pictures folder
in your User folder. Drag this folder to another hard drive or backup device,
and you're all set. The copy operation may take some time if the library is
huge — you can stop the operation anytime, but the newly copied library
may not be complete. For best results, allow the copy operation to finish.

If you subscribe to the Apple .Mac service, you can use its hassle-free
Backup 2 software with your iDisk to copy specific folders, such as a folder
of exported images from your iPhoto library. With Backup 2, which comes
free with a .Mac membership or can be purchased from Apple, you can
quickly and easily store important files on your iDisk or on CD or DVD.
Backup 2 allows you to save the latest versions of your files regularly and
automatically, so you never have to worry about losing photos or any other
important documents.

If you don’t have Backup 2, follow these steps to download and install it:

1. Download Backup 2 installation package by going to the .Mac main
page (www.mac.com), clicking the Backup button, and then clicking the
Download Backup link.

The software may also be available in the download section of the main
Apple site (www.apple.com). (You need to stay connected to the Internet
to complete the next steps.)

2. Read the instructions.

Instructions are available on how to download and install Backup 2.
These instructions have probably changed since we wrote this — the
helpful people at .Mac are always trying to make things easier for you.

3. Double-click the installation package to install it.

When the installation completes, the Backup application is placed in the
Applications folder on your hard drive.
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To use Backup to copy folders to your iDisk, to a recordable CD, or to a hard
drive, follow these steps:

1. Double-click the Backup icon.

The Backup software displays a list of items to back up and a check box
next to each item.

2. Select the folders for backup.

You can add any folder you like to the backup list by clicking the + (plus
sign) button and choosing your library in the Open File dialog.

3. Choose a backup destination in the Backup to iDisk pop-up menu.

You can choose CD or another hard drive rather than iDisk for your
backup.

4. Click the Backup Now button or schedule a backup to happen later.

The Backup Now button saves your files to the backup destination
immediately. You can schedule automatic backups by clicking the calen-
dar button, specifying the time and date you want the backup to occur,
and then clicking OK.

5. Quit Backup.

Moving and switching between libraries

Moving a photo library involves copying it to a new location (and then delet-
ing the original version if you wish). You can copy the iPhoto Library folder
to any other hard drive by placing the folder inside the Pictures folder of
anyone’s User folder, which replaces the existing iPhoto Library folder. When
you start iPhoto, it unhesitatingly opens whatever it finds in the iPhoto
Library folder in the Pictures folder.

When you buy a new Mac, its iPhoto Library folder is most likely empty. You
can copy your library folder from your regular Mac to the new Mac, replac-
ing the empty library folder on the new Mac. When you start iPhoto on the
new Mac, it automatically opens the library you copied over.

If you don’t want to replace the library on the new Mac, you can rename the
new Mac’s library folder or move it to a new location on the hard drive to
preserve it. Then you can copy the older iPhoto Library folder into the
Pictures folder of your User folder on the new Mac without copying over the
new photo library. When you start iPhoto on the new Mac, it automatically
opens the older library you copied.

You can also switch between two or more photo libraries. To open another
photo library, follow these steps:
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1. Quit iPhoto by choosing iPhoto=>Quit iPhoto.

2. In the Finder, rename the current iPhoto Library folder, or move it to
another location.

Essentially, you are hiding the library folder from iPhoto, tricking it into
starting a new one.

3. Open iPhoto.

iPhoto can’t find the library folder, so it asks if you want to find it or
create a new one.

4. Click the Find Library button.

5. Choose the library you want to use, and click Open.

You can also start a new library by clicking the Create Library button.

Burning a CD or DVD

A great way to maintain several photo libraries is to burn CDs or DVDs with
them. If you have an Apple-supported CD-RW or DVD-R drive (such as the
Apple SuperDrive), you can create your own CDs and DVDs to store your
photos. This process is called burning because when you save (or write)
information to a disc, your drive burns the information onto the disc’s sur-
face with a laser.

A CD burned with iPhoto can be used only on a Mac. To burn a recordable
CD for a Windows user or print shop that doesn’t accept Mac CDs, use the
Finder (or an application such as Toast, described in Book VII, Chapter 2) to
burn the CD.

To burn your own CD or DVD using iPhoto, follow these steps:

1. Click the Organize mode button.
2. Select the photo library or a specific album.

You can select the entire library, a specific album, or individual photos
to burn to a disc. You can fit quite a lot of photos on a CD or DVD, so you
may want to select your entire photo library for a CD or DVD burn oper-
ation to use up the entire CD or DVD space.

3. Click the Burn icon.
The Insert Disc dialog appears, prompting you to insert a blank disc.
4. Insert a blank disc and click OK.

A disc icon appears on the information panel. The green area on the disc
icon on the left side represents the amount of space on the blank disc
that your photos will require in order to burn them onto the disc.
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Figure 3-20:
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Burn Disc
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5. Click the Burn button in the Tools pane a second time.

This time the Burn button should have a radioactive symbol on it. Click
it again. (Clicking it the first time, and then again this time, is a safety
precaution.) The Burn Disc pane appears, offering options for burning
the disc. You can cancel the operation with the Cancel button, or click
the Eject button to eject the disc, or click OK to begin burning.

You can also set options, as shown in Figure 3-20, by clicking the down-
arrow button in the top-right corner of the Burn Disc pane. Set the burn
speed in the Speed pop-up menu, and set options to verify the burn and
either eject the disc or mount it on your desktop when finished.
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6. Click the Burn button in the Burn Disc pane.

The burn operation starts. It may take several minutes to burn the disc;
when it is done, you hear a chime and the disc automatically ejects. You
can cancel the burn by clicking the Cancel button next to the progress
bar, but you will not be able to use the blank disc after canceling.

You can show other photo libraries you burned to a CD or a DVD while using
your current photo library. You can’t modify the photo libraries on the CD or
DVD, but you can view and copy any photos and albums they contain.

To open a photo library on a CD or a DVD, follow these steps:

1. Insert the CD or DVD disc into your Mac.
An icon for the disc appears in the Source pane.
2. Click the disc’s icon in the Source pane.

iPhoto displays the photos and albums on the disc. Click the triangle
next to the CD’s title to see the photo albums on the CD, as shown in
Figure 3-21. You can copy them to your current library to work on them.
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If you want to edit the entire photo library on the disc, you can copy the
library to your hard drive and then switch to that library, as described ear-
lier in this chapter, in the section “Moving and switching between libraries.”

You can use photos and DVDs in many ways, such as assembling
documentary-style slideshows. We cover these and many other DVD topics
in Book IV.
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Sharing Photos in a Network

You may want to allow your photo library to be shared over a local-area net-
work in the same way you share your iTunes library (as described in Book I,
Chapter 2). You could then allow others on the network to view, copy, and
even edit the photos. A professional photography or design firm could use
this method to distribute photo work among employees.

To share your library, follow these steps:

1. Choose iPhoto->Preferences and click the Sharing button.
The Sharing window appears, with the options for sharing photos.
2. Select the Share My Photos option, as shown in Figure 3-22.

3. Select either the Share Entire Library option or the Share Selected
Albums option.

If you want to share only selected albums, you must also choose the
albums to share.
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Figure 3-22:
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4. Type a name for the shared library and add a password if you want.

The name you choose appears in the Source pane for other computers
that share it. The password restricts access to those who know it. (Pick
a password you don’t mind sharing with others; for example, your name
is a good password, but your secret password for digital photo services
isn’t.)

Tell the others on the network to follow these steps to use the shared library:

1. Choose iPhotor>Preferences and click the Sharing button.
The Sharing window appears (refer to Figure 3-22).
2. Select the Look for Shared Photos option.

After selecting this option, any shared libraries or albums appear in the
Source pane.

3. Click the shared library or album to open it.

What’s really nice about sharing a photo library is that you can use it over a
wireless AirPort network. You can designate one computer as the “library”
Mac and show a slideshow anywhere in your house or office with your wire-
less laptop and other computers on the LAN.



Chapter b: Improving Photos

In This Chapter

+ Rotating and cropping
1 Changing brightness and contrast
+* Removing red-eye and retouching

+ Changing to black and white or sepia

p hotos are records of reality, but reality doesn’t always comply with
your wishes — the sun may be too bright, or the forest too dark, the
subject too far away, or the combination of light, shadows, and distance
make the scene too blurry to show details. Cameras offer automatic settings
for taking pictures that compensate for some of these factors, but these set-
tings don’t always give you the best pictures.

Digital photography, on the other hand, offers unlimited ways to change
images without adversely affecting the quality of the image. Unlike the tech-
nology involved with developing film, in which successive modifications to
the film degrade the image quality, digital technology allows you to experi-
ment with images at will, and we encourage experimentation. Not only can
you save the original version of the image in pristine condition and experi-
ment on a copy, you can also directly change the pixels of an image without
changing its resolution. The image resolution remains as high as when you
started.

So go ahead and have fun with your photos. This chapter is all about using
iPhoto to its fullest potential for improving and enhancing images. You find
out how to adjust the brightness and contrast, remove the annoying red-eye
effect in the photo subject’s eyes, and retouch photos to remove blemishes
and image artifacts. As influential writer Arthur C. Clarke once said, “Any
sufficiently advanced technology is indistinguishable from magic.” He could
have easily been talking about the editing capabilities of iPhoto.

Modifying Photos

The most obvious advantage digital photos have over prints is that you can
change your digital photo instantly. You can also make copies quickly and
easily, and you can make changes to the copies without affecting the originals.
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Whether you're viewing photos within a photo album (after selecting the
album in the Source pane), or in the entire photo library (after selecting the
photo library in the Source pane) doesn’t matter when you change them.
The changes are recorded in the original photo stored in the library.

You can make some changes while in Organize mode, but certain changes
are easier to make in Edit mode. For example, you can rotate a photo or a
group of photos quickly in Organize mode. But if you want to see the images
up close while rotating, or if you want to make other changes and see those
changes in detail, use Edit mode by selecting the photo and clicking the Edit
mode button. Alternatively, you can open the photo in a separate window, as
we describe in Chapter 1 of this minibook.

Keep the following tips in mind when enhancing photos:

v@\l\lc;! ‘ ‘
S 4+ Any changes you make to a photo, such as cropping, rotating, or chang-
ing a photo’s brightness or contrast, changes the photo’s appearance in

the photo library and in every album where it appears.

4+ To change a photo without changing it everywhere, make a duplicate of
the photo by selecting the photo and choosing Photos=>Duplicate (or
press 38+D). Then you can change the duplicate without changing the
original.

4+ If you make a mistake, you can always revert a photo to its original ver-
sion by choosing Photos=Revert to Original.

4+ To quickly compare the adjusted version of the photo with the original,
press and hold down the Control key. iPhoto displays the original ver-
sion as long as you hold down the Control key. By holding and releasing
the Control key, you can toggle back and forth to compare the original to
the adjusted version.

Cropping and Rotating Photos

In traditional commercial printing and photography, a light table — a translu-
cent piece of plastic or glass fitted on top of a box with internal light — is
used for trimming photographic film negatives or positives and preparing
them for printing in magazines, newspapers, books, and so on. Because light
illuminates the film from below, the image can be seen and trimmed.

The professionals who know how to trim photos on a light table wield preci-
sion knives with wild abandon, and most importantly, they know how to cut
in straight lines. They use words such as cropping to describe cutting away
the outer edges of a photo, bringing the center of the photo to the forefront;
and retouching to describe brushing away artifacts in the image.
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The fact that iPhoto uses the same terms as professional photographers and
provides all of the functionality of a light table in the digital world is no acci-
dent. You can crop a photo to remove extraneous parts of the picture to
better frame the subject, showing only what you want the photo to show;
rotate a vertical photo horizontally; and combine cropping and rotating to
show only part of an image at the proper angle. And you don’t even need to
be able to draw or cut a straight line.

Rotating photos

If you hold your camera sideways to take a picture of something tall, such as
a redwood tree, when you import the picture into iPhoto, you end up with a
photo that is horizontally oriented (the tree is on its side). You probably want
to rotate the photo to be vertically oriented.

You may want to rotate a photo for other reasons as well — for example, you
may want to rotate photos shot by a camera held upside down or pointed
down.

You can quickly and easily rotate photos to the right in Organize mode in the
Viewer pane. You can also rotate a photo after selecting it and clicking the
Edit button to edit it. Either way, iPhoto rotates the entire image in 90-degree
increments (right angles).

To rotate a photo, follow these steps:

1. Select a photo by clicking its thumbnail in the Viewer pane of Organize
mode.

2. Click the Rotate button.

The photo rotates 90 degrees, as shown in Figure 4-1. Each time you
click the Rotate button, the photo rotates 90 degrees.

Choose Photos=>Revert to Original if you don’t like how the rotation
turns out.

You can reverse the direction that an image rotates (to the left rather than
right) by pressing the Option key while clicking the Rotate button. The icon
on the button changes to indicate the new direction.

You can set the direction for the Rotate button to always start in either left
or right direction. Choose iPhotor>Preferences; in the Preferences window
that appears, click the General button. Choose the direction for the Rotate
option by clicking the Left-rotate or Right-rotate button.

Book I
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P You can rotate a photo in Edit mode as well as in Organize mode. The Rotate
button is available in both modes and also in the toolbar of a photo opened
in a separate window. If you want to rotate a group of photos and you don’t
need to see them up close, you can rotate them in Organize mode; if you want
to see a photo up close while rotating, use Edit mode by clicking the Edit
mode button, or open the photo in a separate window, as we describe in
Chapter 1 of this minibook.
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Cropping photos

Cropping enables you to keep only a rectangular portion of the photo and
remove the outer edges. You can use cropping to do the following:

4 Get rid of something you don’t want. You can eliminate the outer por-
tions of a photo to remove wasted space, crop out an ex-boyfriend that
shouldn’t be in the picture, or you can remove the fuzzy outline of a car
window in a photo shot from a car.

4 Focus on the subject. By cropping a photo, you can adjust where your
subject appears in the frame of the picture, drawing more attention to
your subject and improving the overall composition. Professional pho-
tographers, for example, may crop tightly around a person’s face, remov-
ing most of the background.

4+ Fit the photo to a specific proportion. You may want to adjust the pro-
portions of your photo to fit sizes for book layout or prints, which iPhoto
makes easy with a Constrain feature that draws exactly the right propor-
tions for you. Cropping is often better than stretching or resizing a photo,



Figure 4-2:
Crop the
photo in Edit
mode.

141

Cropping and Rotating Photos

because the pixels within the cropped area do not change. By constrain-
ing the cropping selection, you get better results with prints and books
because the picture is framed properly for the size of the print or book
layout.

Make a copy before cropping the photo. Find out how to make a copy and
other tips in the “Modifying Photos” section, earlier in this chapter.

To crop a photo to get rid of the outer edges and improve the composition
(without using the Constrain feature), follow these steps:

1. Click the thumbnail image of the photo in the Viewer pane.
2. Click the Edit mode button for Edit mode.

After switching to Edit mode, the selected photo fills the entire Viewer
pane.

3. Click a starting point and drag diagonally across the photo in the
Viewer pane to create a cropping rectangle.

Click at one corner of the photo in the area you want to crop and drag
across the image. The cursor’s pointer turns into a crosshair. As you
drag, the portions of the photo outside the selected area dim to show
that the area will be cut from the photo, as shown in Figure 4-2.
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4. Adjust the edges of the cropping rectangle, as shown in Figure 4-3.

If your cropping rectangle isn’t perfect the first time, move your mouse
pointer close to the edge or corner of the cropping rectangle and drag to
reshape the rectangle.
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See how we dragged the top edge up a little bit in Figure 4-3? We didn’t
like our original cropping area in Figure 4-2, so we adjusted the cropping
area a little more. Besides adjusting a side of the crop selection area, you
can click inside the crop selection so that the cursor changes to the
browse “pointing finger” cursor, and then move the entire selection
rectangle.
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Cropping changes the actual photo. Be sure you define the edges per-
fectly before clicking the Crop button in the next step.

5. Click the Crop button in the Tools pane at the bottom left of the
iPhoto window.

The Crop button reduces the photo dimensions to the selected area, as
shown in Figure 4-4.

Constraining cropping for print sizes

You can use the Constrain feature to crop a photo to a specific proportion.
Constrain keeps the proportions accurate while you drag the cropping rec-
tangle, so you don’t need rulers, math expertise, or graphics skill to get it
right for specific print dimensions. As you drag, the Constrain feature keeps
the rectangle accurate.

The Constrain pop-up menu, to the left of the Crop button, offers a list of
print sizes like 4 x 6 (Postcard), 4 x 6 (Portrait), standard 8 x 10, 8 x 10
(Portrait), and so on. You even find sizes such as 1024 x 768 pixels, for desk-
top pictures and screen effects. Using the preset choices from the Constrain
menu guarantees the cropped photo fits nicely in the format you need.
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Although most of us don’t need to be extremely precise with cropping our
photos, graphic artists and print-layout specialists may want very precise
image sizes for reproducing on printing presses. iPhoto allows you to do pre-
cise cropping when you open your photo in a separate window. Open the
photo in a separate window by holding down the Option key while double-
clicking the photo. The Crop button and Constrain pop-up menu are avail-
able in the window’s toolbar. (If you don’t see the Crop button on the right,
click the double-arrow on the far-right side of the toolbar to reveal the Crop
function and other functions not visible due to the size of the window.) You
can crop a photo any way you like, but you will get much better results from
photo printing services if you crop using the standard photo sizes available
in the Constrain menu.

To crop a photo with the Constrain menu in a separate window, follow these
steps:

1. Hold down the Option key while clicking the thumbnail image of the
photo in the Viewer pane.

If you open the photo in a separate window, you can see the photo at dif-
ferent sizes. Figure 4-5 shows a photo opened in a window scaled at 30
percent of its actual size.

2. Click the Constrain pop-up menu and choose a format, as shown in
Figure 4-5.
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Figure 4-5:
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Click in one corner of the area you want to crop and drag the mouse
across the image to the far corner of the cropping area.

The mouse pointer turns into a crosshair. As you drag, the portion of the
photo outside the area dims to show that it will be cut from the photo,
as shown in Figure 4-6.

Adjust and resize the cropping rectangle.

If your cropping rectangle isn’t perfect the first time, move your pointer
anywhere inside the cropping rectangle until the cursor turns into a point-
ing finger, and then drag to adjust the rectangle’s position. You can also
drag the edges of the cropping rectangle to make it larger or smaller, but
still in the same proportion, because the Constrain feature is on: Move
your pointer close to the edge or corner of the cropping rectangle and
drag to make it larger or smaller.

Notice also that the Custom fields fill in with the proportions for your
Constrain choices (10 x 8 in Figure 4-6). After opening a photo in an indi-
vidual window, the Custom fields allow you to specify your own propor-
tions for constraining the cropping, so you can be as precise as you want.

Click the Crop button.

Be sure you want to crop the photo. Cropping changes the photo every-
where it appears.

The Crop button reduces the photo dimensions to the selected area,
which, due to the Constrain feature, is in the correct proportion for your
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print or display choice. After clicking the Crop button, the photo con-
sists of only the selected area, as shown in Figure 4-7; the rest of the
photo is thrown away.
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Solving printing problems with cropped images

Problems can crop up, punintended, when you
print photos that have been cropped or resized.
Prints typically come in specific sizes such as
4x6,5x7,and 8 x 10 inches. However, photos
from most digital cameras are sized at a pro-
portion of 4 (width) to 3 (height) pixels, which is
fine for computer displays, but not the right pro-
portion for typical prints. If you pay no attention
to the Constrain feature, you may find some

Although cropping doesn’t change the pixels
in the cropping area, the parts of the photo
outside of the cropping area are removed,
reducing the overall size of the photo. A photo
at low resolution may, after cropping, be too
small to print well at large sizes because the
printer resizes the photo to fill the paper size,
which makes the pixels larger and produces
jagged edges. High-resolution cameras can

photos have white margins on the finished
prints. Use the Constrain feature if you're crop-
ping a photo you intend to print.

produce higher-quality prints at large sizes,
even if you crop the image.

Fine-Tuning Photos

Your vacation is over, and you’re looking over your photos. The beach shots
look washed out from way too much sunlight, and the forest shots look as
dark as inside a dungeon. And your youngest son is in the gift shop imper-
sonating a red-eyed Martian.

You can work magic with the iPhoto editing tools, improving photos that
would otherwise be fuzzy, too dark, or too bright. Poor lighting is often the
biggest problem with photos. But the iPhoto Brightness and Contrast controls
can make photos look better, with more saturated colors, or with sharper,
crisper details. The iPhoto Red-Eye button removes the red spots in your sub-
ject’s eyes created by the camera’s flash. The Red-Eye button also reduces the
amount of red in any selected area of a photo.

Improving brightness and contrast

Some of the best indoor photos are taken with light streaming through a
window, using only the ambient light from the sun. (Why, then, when you sit
for a portrait photo, does the photographer spend more time on lights than
anything else?) With natural, ambient light, your camera reads the lighting
for the entire room and reveals more depth in the background and surround-
ings. Ambient light from various sources, such as lamps and overhead lights,
produces a softer, more balanced photo with less contrast. With a flash, only
about ten feet in front of the camera is illuminated, and everything beyond
fades to black.
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Whatever the lighting conditions are when you take your photos, you can
regain some of the detail lost in the darkness by using the Brightness and
Contrast sliders. The sliders allow you to change the brightness and con-
trast and see the effect immediately. Find the sliders in Edit mode and also
in the toolbar of a photo opened in a separate window.

When in Edit mode, the Brightness or Contrast sliders are located in the
Tools pane. Drag the sliders left or right, as shown in Figure 4-8. The top
slider controls the brightness, and the bottom slider controls the contrast.
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Brightness / Contrast

With the Brightness and Contrast sliders, you can bring out details in photos
taken in poor lighting conditions. The sliders enable you to make incremen-
tal adjustments. You can

4 Adjust each slider gradually until you get the effect you want.

4 Click the icons at either end to set minimum or maximum brightness
and contrast settings. For example, in Figure 4-9, we clicked the dim sun
icon on the left side of the Brightness slider for minimum brightness,
and then moved the Contrast slider to get the desired effect.

4+ Click anywhere along the slider bar to jump directly to a setting.
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7
Removing red-eye and red tint
Red-eye is light from the camera’s flash, reflected off the retinas in your sub-
ject’s eyes. Red-eye happens even with your dog or cat’s eyes, making docile
Spot look quite vicious. The red is the color of the eye’s retinal tissue; you
get green-eye or yellow-eye from a creature whose retinal tissue is greenish
or yellowish. Red-eye can be more prominent in photos shot in dim rooms,
because the pupils are dilated, exposing more of the retina.
The red-eye effect is a common problem in flash photography — so common
that many digital cameras come with built-in red-eye reduction. But our shots
prove that our digital camera still zaps people’s eyes with red even with this
reduction feature; either that or it proves that we don’t know how to use the
camera’s reduction feature.
It doesn’t matter. iPhoto provides you with a magic wand that zaps red-eye.
Follow these steps:
1. Click the thumbnail image of the photo in the Viewer pane.
\\J

You can also perform this operation in a separate window. Hold down
the Option key while clicking the thumbnail image of the photo in the
Viewer pane, and skip to Step 3.

2. Click the Edit mode button for Edit mode.
The selected photo fills the entire Viewer pane.

3. Zoom into the photo.
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In Edit mode, use the size control slider to zoom in, as we have in Fig-
ure 4-10. When viewing a photo in a separate window, use the Zoom
buttons.

Click and drag with your mouse across an eye to select the image area.

Be sure the Constrain pop-up menu is set to the None option, so that
you select an image area of any shape.

The Red-Eye button doesn’t know the difference between an eye and a
nose — all it does is reduce the red tint in the pixels that are concen-

trated in a circular shape. Therefore, keep the selected area as close to
the red-eye as possible, so that you don’t change any other part of the

Click the Red-Eye button.

Be absolutely sure that you're ready to remove the red-eye. Removing
red-eye changes the photo in the photo library and in every album.

The Red-Eye button, found in the Tools pane, removes red tint from the
selected area (as shown in Figure 4-10). The eyes may now be a lot
darker than before, but at least they don’t look bright red.

u can use the Red-Eye button to remove red from any part of a photo. The
d-Eye tool simply removes some of the red from each pixel.
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Compare the improved photo with the original (red-eyed) version by press-
ing and holding the Control key.
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Retouching and enhancing photos

Here’s where photos can depart from reality. (Removing red-eye is, after all,
just removing something that the camera’s flash put there.) You can literally
alter the photo with iPhoto in such a way that even a judge and jury couldn’t
tell the difference. You can remove anomalies and blemishes with the Retouch
brush and enhance the colors in a photo with the Enhance wand. Both tools
are available in Edit mode and when viewing a photo in a separate window.

Before making any changes, make a copy of the photo in case you make any
changes you don’t like. We cover this and other tips in the section, “Modifying
Photos,” earlier in this chapter.

To use the Retouch brush, follow these steps:

1. Click the thumbnail image of the photo in the Viewer pane.

Choose a suitable image for retouching, such as a photo that was digi-
tized and imported and has spots from the scanning process.

You can also perform this operation in a separate window. Hold down
the Option key while clicking the thumbnail image for the photo in the
Viewer pane and skip to Step 3.

2. Click the Edit mode button for Edit mode.
The selected photo fills the entire Viewer pane.
3. Zoom into the photo.

In Edit mode, use the size control slider to zoom in as much as possible.
When viewing a photo in a separate window, use the Zoom buttons.

4. Click the Retouch brush.

The Retouch brush icon is in the center of the tool. The pointer turns
into a crosshair.

5. Use your mouse pointer as a brush and repeatedly scrub a small area
that you want to deemphasize or remove.

Repeatedly drag over a small area as if using a brush. Slowly the area
blends into the surrounding pixels, as shown in Figure 4-11. The blemish
or spot disappears. Life would be so much easier if getting rid of a real
blemish was this simple.

The Retouch tool actually clones neighboring pixels and uses them to replace
the pixels you are brushing over, blending them in by manipulating color
values. (And you thought cloning was for sheep!)

The Enhance wand works on the entire photo. It performs a combination of
operations, including subtle adjustments to the brightness and contrast and
other changes to the colors to bring out more clarity and saturated color in



Figure 4-11:
Retouching
a photo.
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the image. The essential effect of Enhance is to make the colors, and the
overall photo, more vivid.
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To use the Enhance wand, follow these steps:

1. Click the thumbnail image of the photo in the Viewer pane.
2. Click the Edit mode button for Edit mode.

The selected photo fills the entire Viewer pane.
3. Click the Enhance wand.

The Enhance wand icon is toward the right in the Tools pane. It may take
a second for iPhoto to respond after you click the Enhance button (the
cursor may spin for a while). Don’t click the Enhance button a second
time unless you want a double dose of the Enhance function — which
might be useful with photos that could use a bit more enhancing.

Converting to sepia or black and white

Some scenes just look better in black and white, and some look better with
an antique-looking print. You can change your photos to either black and
white or sepia, which is the color of a faded print.

Technically, a “black and white” photo uses multiple shades of gray, but we
call it black and white, or B & W. Black and white images can evoke a moody
atmosphere. Black and white can also be effective for portraits, for obtaining
greater contrast and enhanced starkness, and for trying to achieve an Ansel
Adams look.
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To convert a color photo into black and white, choose the photo in the
Viewer pane, click the Edit mode button for Edit mode, and then click the
B & W icon toward the right in the Tool pane.

To convert a color photo into sepia, choose the photo in the Viewer pane,
click the Edit mode button for Edit mode, and then click the Sepia icon.
§“v(,\l\f-"':'lf
& Make a copy before you make any irreversible changes to your photo. Find
out how to do this and other tips in the “Modifying Photos” section, earlier
in this chapter.

Customizing the separate edit window

To be more precise about cropping and
retouching, you can open the photo in a sepa-
rate window by holding down the Option key
while double-clicking the photo. You can also
customize the window’s toolbar to show only
the editing tools you need (or to show tools that
don't appear when the window is sized to be
small).

To customize the window, click the Customize
icon in the toolbar; if it does not appear, click
the double-arrow icon in the top-right corner of
the window and choose Customize from the

pop-up menu. The customize panel appears, as
shown in the following figure. You can drag the
icons to the window's toolbar. You can also
drag icons out of the toolbar to remove them. If
you drag more icons than iPhoto can fit in the
toolbar, the double-arrow icon provides access
to them in a pop-up menu (the same pop-up
menu you used to select Customize). The cus-
tomize panel also offers the default set of icons
inside the box at the bottom of the panel, which
you can drag in its entirety to the toolbar.
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Chapter 5: Making Slideshows

In This Chapter

v Creating a slideshow
1 Controlling slideshow playback and adding music
v Sharing slideshows online

1+ Exporting slideshows to QuickTime and iDVD

ou may remember the old days when slides were projected onto a

screen, white walls, or white sheets, and how the click-clack sound of
the slide carousel on the projector drowned out everything else. Slideshows
of this sort used to be the only way to exhibit photos to a group of people.

Photos can display on computers, and with laptops to connect directly to
video projectors, you can put on shows that are nothing like your grandfa-
ther’s slideshows. Not only do the photos look fantastic, but you can set
them to music, fade between each photo, repeat the slideshow in a loop
endlessly, and generally look as good as a professional slideshow in a kiosk
or boardroom. In this chapter, you discover how to change these and other
settings to fine-tune your slideshow. We also describe how to choose the
best pictures, how to share slideshows with friends, and how to create a
movie from a slideshow.

Playing a Slideshow

Words can’t express the feeling you have when you first look at the photos
you've taken in an iPhoto full-screen slideshow. Your display fades to black,
and your entire photo library (or the album you select) starts to appear,
photo by photo, filling the screen for two seconds before fading out while
the next photo fades in. You hear the music of J.S. Bach — “Minuet in G” —
which is the default setting for music during slideshows.

Within the Organize mode in iPhoto, you can create and play slideshows.
Follow these steps to play a slideshow with a particular selection of photos
in mind:

1. Select the photos for the slideshow in the Viewer pane.

2. Click the Play button in the toolbar.

The Play button looks like a CD-player play button.



15 4 Playing a Slideshow

\\J

S

A\

The slideshow plays in an endless loop until you stop it by clicking the
mouse or pressing the Esc key. Of course, running in an endless loop, with
two seconds per slide, may not be the ideal setting for your slideshow, but
don’t worry. We describe how to change that setting later in this chapter,
in the section, “Changing Playback Settings.”

You can also press the spacebar to show the semi-transparent Slide Show
control panel, which pauses the slideshow when you press the spacebar
again, or moves forward or backward through the show if you press the
right-arrow or left-arrow key.

If your slideshow doesn’t look as good as you expect, check your display set-
tings. To find out how to change your display settings, see Chapter 1 of this
minibook.

iPhoto offers different ways to play a makeshift slideshow on the fly:

4+ Show your entire library or an entire album from the beginning:
Select either the photo library or the photo album in the Source pane,
without selecting any photos, and click the Play button. The slideshow
consists of all the photos in the Viewer pane, starting with the first.

4+ Show your entire library or an entire album starting at a photo (not
at the beginning): Click a single photo, in either the photo library or
an individual album in the Viewer pane. The slideshow starts with the
photo immediately following the selected photo. (We know, starting on
the selected one is logical, but it doesn’t work that way.) The show con-
tinues and then loops back to the first photo in the Viewer pane.

4+ Show selected photos only: Select multiple photos in the Viewer pane —
either a range of photos in consecutive order, or individual photos in
nonconsecutive order. The slideshow uses only those photos, endlessly
repeating them.

You may want to play a makeshift slideshow of selected photos just to exper-
iment with them to see if they would work well in the final version of the
slideshow. Not all photos are cropped or rotated properly for slideshow
viewing.

Pausing and playing
When playing a slideshow, you can pause it and resume playing whenever
you want.

To pause a slideshow while playing, press the spacebar. A pause indicator
appears briefly on-screen and then disappears, leaving the slideshow paused
on the photo. When you pause a show, the music keeps playing — which
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means you can’t really synchronize photos to music. However, you can use
iMovie to create a synchronized slide-and-music show (see Book II), and you
can use iDVD to burn a DVD of the slideshow (see Book IV).

To resume playing the slideshow, press the spacebar again. When the show
resumes, a play indicator appears briefly and then disappears, and the
slideshow continues.

Advancing manually and controlling the speed

Usually slideshows run in auto-play mode with timing you can adjust in the
Slideshow window, which we describe in the section, “Changing Playback

Settings,” later in this chapter. However, you can override the settings by c::":;lrlr‘
manually advancing or reversing the slides and increasing or decreasing the v
speed of the slideshow. =
-
=
To advance manually, slide-by-slide, press the right-arrow key on your key- a
board. To go backwards, press the left-arrow key. =
o
(1]
When you press either of the arrow keys, the slideshow jumps to the next or %
previous slide. The slideshow then pauses while the music continues play- S

ing. You can then manually move forward or backward, slide-by-slide, by
again pressing the left-arrow or right-arrow key:.

To return to normal playback speed, press the spacebar to bring the
slideshow out of pause mode.

P You can speed up or slow down a slideshow temporarily by pressing the up-
arrow or down-arrow key. Pressing the up-arrow key speeds up a slideshow,
decreasing the time that each slide is shown, while pressing the down-arrow
key slows down a slideshow, increasing the time that each slide is shown.
The slideshow continues at that speed until you change the speed again by
pressing the up-arrow or down-arrow key. However, this speed change is
temporary — speeding up or slowing down the slideshow does not affect the
slide playback timing you define in the Slideshow window, described later in
this chapter, in the section, “Changing Playback Settings.” When you rerun
the slideshow after stopping it, iPhoto uses the saved settings for timing the
presentation.

Assembling a Slideshow

Although you may find a slideshow of the photos in your library (in what-
ever order those photos are sorted) to be interesting, your friends may not
feel the same way. Create slideshows for others that are at least appealing,
if not dazzling. You can do this by choosing the best pictures and the most
appropriate music.
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Arranging a photo album for a slideshow

Arranging photos in an album allows you to determine the order of your
photos in a slideshow.

After you choose the photos you want for a particular slideshow, the best
way to organize that slideshow is by assigning the photos to an album. You
can make a separate photo album for each slideshow, because albums are
just lists of images and they don’t use up hard drive space.

Creating a photo album for a slideshow is no different than creating a photo
album for any other reason. We describe how to arrange photos in photo
albums in more detail in Chapter 3 of this minibook.

The order of your photos in the album defines how your slideshow plays.
Photo albums are convenient for this process because you can rearrange
your photos in any order you like. The final arrangement determines the
order in which people see the images in the slideshow.

Choosing photos that display well

The important thing to remember about photos in slideshows is that not all
photos fill the screen properly. You may want to use only photos that look
good at full-display dimensions.

iPhoto uses the entire display resolution when putting on a slideshow, and
for many Mac users, that means at least 1024 x 768 pixels. If your photos are
smaller, iPhoto stretches them to fill the display, often with undesirable
results (jagged lines and visible pixels, to name a couple).

You can determine whether a photo works well in a slideshow in two ways:

4+ Select the photo you want to check and select another photo (it doesn’t
matter which one), and then click the Play button. The slideshow consists
of just those two slides, over and over, and you see not only how the
photo looks at full-screen resolution, but also when fading in and out.

4+ When looking at a single image in Edit mode, hold down the Option key
and double-click the photo to open it in a separate window. Make the
window as large as you can to see how the photo looks at full screen.

You can tell the size of a photo by opening it in a separate window. iPhoto
scales the photo in its proper proportions, rather than stretching it to fit the
Viewer pane. You can tell how large the photo is by the percentage displayed
in the title bar — whether a small photo scaled to display at 100 percent
magnification or a very large photo scaled at 50 percent or less.

To make sure that your photos are large enough to look good in a full-screen
slideshow, you can check the size in two ways:
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4+ Select a photo in the Viewer pane. The Size field on the far left side of
the iPhoto window displays something like 2272 x 1704, which is the size
of the photo (2272 pixels wide by 1704 pixels high).

4+ Select a photo in the Viewer pane. You can also use this method if the
photo is open in a separate window. Choose Photos=>Show Info. iPhoto
lists the Width and Height, in pixels, in the Photo tab of the Photo Info

window, as shown in Figure 5-1.

[G] Phota Info
' Pho{o ? Exposure |
Image Book Il
Width: 2272 pixels Chapter 5
Height: 1704 pixels
Original Date: 04/20/02 11:.00:20 AM g
Digitized Date: 04/20/02 11:00:20 AM %
E a
_File
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Name: DSCNODE5JPC f—r]
Size: 788 KB %
Modified: —- g—
. Imported: — g
Figure 5-1: @
Check the . Camera
size of the Maker: NIKON
photo |n Model: E4300
. Software: E4300v1.5
pixels.

Size matters

When the iPhoto slideshow function enlarges
a narrow image to show it full screen, the photo
maintains the correct horizontal-to-vertical
aspect ratio. As a result, some images may
appear with black borders on either the hori-
zontal or vertical edges, similar to a wide-
screen movie on television (/etterboxing).

When you include low-resolution images in a
slideshow, they may stand out as jaggy-edged
and fuzzy, which might be fine if you are going
for some artistic effect. But if you plan ahead
and you know you want to use the pictures you
are about to take in a slideshow, make sure
your digital camera is set to capture photos at

a pixel resolution of at least 1024 x 768 pixels,
preferably higher.

If you are stuck with photos that are too small,
you can fix the problem with an image editing
program, such as Adobe Photoshop. With
Photoshop and iPhoto open, drag a photo
directly from iPhoto into the Photoshop window
and make changes, such as scaling the image
to be larger, or surrounding a small image with
a black border. You can then save the image as
a TIFF or Photoshop file, and in iPhoto, choose
Filec>oImport to bring the revised photo back
into your photo library.
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Changing Playback Settings

Are you ready for a performance? Possibly not — you may want to show
each photo for longer than two seconds, change the music, or even set the
show to play photos in random order. These choices are available in the
Slideshow window.

Figure 5-2:
Change the
settings
inthe
Slideshow
window.

To open the Slideshow window, follow these steps:

1.

In Organize mode, select the photo album from the albums list.

To define slideshow settings, you have to use a photo album as the basis
for your slideshow.

Click the Slideshow icon in the Tools pane (second icon from the left).
The Slideshow window appears, as shown in Figure 5-2.
Make any changes you want.

You can set a transition between each slide and change the transition set-
tings, change the speed of the slideshow’s photos, display your ratings
with the photos, and change the music. These settings are explained

in the sections, “Setting slide transitions,” “Timing your slideshow,”
“Changing the music,” and “Using iTunes music.”

Click the Save Settings button to save your settings.
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Figure 5-3:
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window.
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Setting slide transitions

Transitions between slides don’t have to be dull. You can make one slide dis-
solve into another, or show a slide turning on a cube to make room for the
next one. You can even use a mosaic flip effect that rotates sections of the
new slide into place.

In the Slideshow window, you can choose a transition between slides, as
shown in Figure 5-3. After you select a transition, you can pick other options.
For example, you can choose the Wipe transition, and then specify the direc-
tion and speed of the wipe.

These transitions can provide a dramatic flourish to your presentation, and
you can experiment with them freely — choose one, and if you don’t like it
(and you can see a preview while choosing), simply choose another. The
transitions are automatically applied to the slideshow.

e Slideshow
F Settings ! Music
Transition v None B
Cube
Direction  pigsplve

Mosaic Flip

P T

Play each slide for 2 3 seconds
| Present slides in random order

I Repeat slideshow

"] Scale photos to fill screen

" Display titles

"] Display my ratings

| Display slideshow controls

( Save Settings ) { cancel ;

As you choose a transition, the miniature preview in the Slideshow window
shows you how the transition will appear, using slides from the selected
album.

The Direction pop-up menu specifies which direction the transition occurs
from — for example, a wipe generally moves the new slide into position
while moving the old slide out, from left to right. You can change the direc-
tion to right-to-left, top-to-bottom, and so on.

The Speed slider specifies the speed of the transition relative to the overall
speed of the slideshow, which is described in the next section.

Book I
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Timing your slideshow

Your slideshows don’t have to be fixed to run endlessly, or to show only two
seconds per slide. Do you really want your audience to fidget in their seats
and keep asking for you to go back to another slide? With the slideshow
options, you're in control — you can set the slideshow so that the audience
has a chance to study each photo or make the photos go by in a flash.

In the Slideshow window, you can change the Play Each Slide for . . . Seconds
setting, so that slides appear on-screen for the duration you want before
fading. The up and down arrows allow you to adjust the number of seconds
with a maximum of 30 seconds between photos.

If you want more than 30 seconds between photos, you can type a number
higher than 30, but not higher than 60 seconds (if you do, iPhoto pays no
attention to the silly human request and refuses to highlight the Play button
until you come to your senses).

The number of seconds you choose applies to each slide in the slideshow —
you can’t set different timings for different slides (if you need that level of
control, try iMovie, which we describe in Book III).

The timing is saved with the photo album used for the slideshow. You can
try different timings by setting up multiple photo albums and changing the
settings for each one.

The number of seconds you choose for playing each slide also affects the
transition time between slides. Choosing a longer playing time produces
longer, more appealing transitions. We prefer setting the timing to 20 or 30
seconds per photo.

You can select the Repeat Slideshow option to, well, repeat the slideshow, if
you want the slideshow to loop. If you deselect the Repeat Slideshow option
(click the check box to toggle the option off), iPhoto plays the slideshow and,
at the end, returns to the Viewer pane in Organize mode. This may be useful
for previewing, but you may want your slideshows to repeat, especially if you
are using a slideshow in an exhibit or on a demonstration table. You can
always end a slideshow by clicking the mouse or pressing the Esc key.

Changing the music

Apple thoughtfully provided very nice music to go along with your slideshows.
Music makes a slideshow come alive, turning your ordinary (and extraordi-
nary) photos into something that resembles parts of a Ken Burns documen-
tary. (Okay, so maybe your family vacation doesn’t rank up there with a Ken
Burns documentary, no matter what you may think.)



Figure 5-4:
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The Music pane of the Slideshow window enables you to change the music.
To open the Slideshow window, select a photo album in Organize mode and
click the Slideshow icon in the Tools pane.

The Source pop-up menu in the Music pane typically starts out with the
Sample Music option, as shown in Figure 5-4, and the songs available in this
category (as of this writing) are from J.S. Bach: “Jesu, Joy of Man’s Desiring”
performed by Leo Kottke (our favorite), and “Minuet in G” performed by
Harvey Reid.

e Slideshow
Settings ' Music l
EFlay music during slideshow
Source: Sample Music [ }
Song Artist Time
Jesu, Joy OF Man's Desiring Leo Kottke 2:24
Minuet in G Harvey Reid 1:30
£ —
» Search 2 sangs
Playlist: Sample Music / Song: Jesu, Joy Of Man's Desiring
‘f_ Save Settings b ’ Cancel )

After selecting one in the song list, click the Play button at the bottom-left
side of the Music pane (refer to Figure 5-4) to play just the music.

Using iTunes music

Although the default songs, “Minuet in G” and “Jesu, Joy of Man’s Desiring,
are exquisite, you may become tired of them. Apple only provides them as
suggestions, anyway. You can select a tune or even an entire playlist from
your iTunes library. If you don’t have any music yet in your iTunes library,
read all about importing music into iTunes in Book I, Chapter 1.

”

To play a tune from the iTunes library, follow these steps:

1. Open the Slideshow window by selecting a photo album in Organize
mode and clicking the Slideshow icon in the Tools pane.

The Slideshow window appears.

Book I
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Figure 5-5:
Select
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slideshow's
music.

2. Click the Music tab to open the Music pane.

3. Click the Source pop-up menu to select an iTunes playlist, or select
iTunes Library to see the entire music library.

Selecting a playlist is useful if you already defined a playlist for slideshows
in iTunes (Book I, Chapter 2), and you want to play the entire playlist with
the slideshow. The songs stored in the playlist appear in the box below
the menu, as shown in Figure 5-5.

[5] Slideshow
Settings ' Music 1

EFI&V music during slideshow

Source: iTunes Library L !
Song Artist | Time
BIiE 11 GHE LIfE Flying UtRer Brothers 544
Blip in the Life Flying Other Brothers 4:45
By My Side Flying Other Brothers 2:28
By My Side Flying Other Brothers 223
Clueless Flying Other Brothers 5:42 m
Clueless Flying Other Brothers 4:56
Come Along With Me Flying Other Brothers 424
Constellation Rag Flying Other Brothers 3.03
Devil's Kitehen Flying Other Brothers 5:05
Every Stree...s Your Name  Flying Other Brothers 3:33
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If you choose the entire iTunes Library, you can sort the song list and
select a song from the library.

When you choose an iTunes playlist, the entire playlist appears as the
song list, and the entire playlist is assigned to the slideshow (unless you
select a song in the list). But if you select a song inside the playlist, that
song alone is assigned to the slideshow. You can select and play songs
(click the Play button to hear songs), and then go back and either select
an entire playlist in Source pop-up menu or select only one song.

4. Click the Play button to hear your selection.

If you select the entire iTunes library in Step 3, the list of songs is initially
sorted alphabetically by artist, but you can sort the list alphabetically by
song title by clicking the Song column header, or sort the songs by duration
(from shortest to longest) by clicking the Time column header. If you know
the specific song you want to add to the slideshow, type the title in the
Search field to narrow the choices. Figure 5-6 shows the iTunes library
sorted by duration, shortest to longest.
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You can choose only one song or playlist for a slideshow. iPhoto continues
playing the song or playlist until it ends or the slideshow ends. If the slide-
show repeats endlessly, the song or entire playlist also repeats when it ends.
They play independently — the songs and the slides are not synchronized.
(If you want to synchronize sound with photos or images, use iMovie, which
we cover in Book III.)

Saving your settings

When you are satisfied with your slideshow settings, you can save them by
clicking the Save Settings button in the Slideshow window (refer to Figure 5-6).
iPhoto saves the slideshow settings for the entire photo album. When you
view your photo album, the slideshow information appears in the Viewer pane
underneath the Source list.

If you save your settings, any new photo that you drag into the album uses
those settings while in the album. Meanwhile, the photo in the photo library
remains unchanged, and you can drag it to other albums and use the other
albums’ slideshow settings. This cool feature is a timesaver.

To play the slideshow, select the photo album and click the Play button under-
neath the Source list. The slideshow runs exactly as you set it up to run.

Sharing and Exporting Slideshow's

A slideshow on your computer is wonderful for those who can pull up a seat
and watch. If you have a PowerBook laptop or an iBook, you no doubt already
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appreciate the slideshows you can show others on the spot, thanks to the
portability of your machine. But to reach a larger audience or different audi-
ences at different times, you have some options:

4+ Share your slideshow online with the .Mac service.

The entire slideshow is available online for others to use as a screen
effect (anyone using .Mac, that is).

4+ Export your slideshow to a QuickTime movie.

You can post a QuickTime movie on a Web page and include it with
other scenes in an iMovie presentation, described in Book III.

4 Create a DVD of the slideshow.

You can export the entire slideshow, including music, to iDVD, which
gives you tools to improve the slideshow and burn a DVD. We describe
iDVD in more detail in Book IV.

In addition, you can share individual photos with others via e-mail, or pub-
lish individual photos on a Web page. We describe how to do both in
Chapter 6 of this minibook.

Sharing slideshow's online

You can really impress your friends with this trick. You can provide your
slideshow online for others to use as a screen effect (that is, a screen saver).

Apple offers the .Mac service for all Mac users (for a fee, of course). One of
its major benefits is the capability of sharing iPhoto slideshows with others
over the Internet. With the .Mac Slides feature on the .Mac service, others
can use your slideshow as a screen effect. The Screen Effects function acts
like a screen saver — animation displays on your desktop when your com-
puter is inactive.

You can subscribe in advance to the .Mac service, or you can go ahead and
click the .Mac Slides icon in the Tools pane, and iPhoto automatically con-
nects to the Internet and checks to see if you have a .Mac account. If you
don’t, iPhoto gives you the option to join the service and launches your
Internet browser to the .Mac sign-up page.

Of course, if you aren’t connected to the Internet through a network or a high-
speed modem that provides always-on service, iPhoto won’t automatically
connect to the Internet works until you connect manually by modem. Connect
to the Internet using your usual method before clicking the .Mac icon.

To share your slideshow with others over the Internet using the .Mac serv-
ice, follow these steps:
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1. In Organize mode, select the photo album or individual photos in the
slideshow.

2. Click the .Mac Slides icon in the Tools pane.

The .Mac Slides icon displays a warning: Are you sure you want
to publish a slideshow as .Mac Slides? Transferring an entire
slideshow can take some time if your slideshow contains a lot of photos.

3. Click the Publish button to publish the slideshow.

iPhoto copies the photos in the slideshow to your iDisk on the .Mac
service, as shown in Figure 5-7. You can cancel the operation by clicking

the Cancel button. Book Il
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When the slideshow finishes copying, iPhoto displays a dialog notifying you
that the photos are online, and as an option, gives you the opportunity to
announce your slideshow to others who use the .Mac service. If you click the
Announce button in the dialog, your e-mail application appears with a new
message ready to send — all you need to do is fill in the addresses. Don’t
click the Announce button unless you're ready to announce your slideshow
and send the e-mail.

\\J
You can control which e-mail program iPhoto uses by choosing iPhoto=
Preferences and selecting an e-mail application in the Mail pop-up menu.

The e-mail message provides instructions to others on how to subscribe to
the slideshow using the .Mac service. To use the slideshow, others have to
be running Mac OS X version 10.2 or newer. They need to connect to the
Internet, and then perform the following steps:

1. Open System Preferences and click the Screen Effects icon.

The Screen Effects window appears, as shown in Figure 5-8.
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Figure 5-8:
Use a
shared-
online
slideshow
as ascreen
effect.

eo

Screen Effects

16

Show All

Sound Network Startup Disk

’ Screen Effects ‘ Activation 1 Hat Corners |

Screen Effects

Preview

Computer Name
Flurry

Abstract

Beach

Cosmos

Forest

Pictures Folder

52

£ Test )

Random
World Book Screen Saver

. Configure
Use Energy Saver to increase the life of your display.

A
[ Open Energy Saver

Figure 5-9:
Set options
for the
screen
effect.

Select .Mac in the list of available screen effects.
Click the Configure button.

The screen saver options appear, as shown in Figure 5-9.

In the .Mac Membership Name field, enter the username of the

member who published the slideshow and click OK.

Choose System Preferences—>Quit System Preferences to close System

Preferences.
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Screen Effects offers settings for playing the screen saver, which you can find
out about in Chapter 3 of this minibook.

Sharing your slideshows this way is cool. What’s cooler is the fact that you
can change your slideshow, publish a new version, and your friends auto-
matically see the new version as part of their screen effects. Keep your
friends and family abreast of events and changes in your life, as told with a
slideshow of your photos.

Exporting to a QuickTime movie

Your slideshow is so fantastic you want to share it with the world. But only
.Mac users can see your slideshow.

QuickTime to the rescue! QuickTime is like a container for multimedia built
into every Mac and available to any PC user intelligent enough to know what’s
best. When you create a QuickTime movie file, even those dudes with Dells
and geeks with Gateways can play it. You send your slideshow to them as a
QuickTime burned on a CD or DVD, or you can publish a QuickTime file on

a Web site for anyone to play.

To put your slideshow into a QuickTime file, follow these steps:
1. In Organize mode, select an album from the Source pane or individ-
ual photos used in a slideshow.

2. Choose FilecoExport.

The Export Photos window displays, with tabs for different types of
export functions, as shown in Figure 5-10.
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¢ File Export: Export versions of your photos using file formats such
as JPG (for JPEG, the standard image format for Web pages) and TIFF
(the standard format for desktop publishing software). You can dis-
cover more about file formats in Chapter 6 of this minibook.

o Web Page: Export photos or an entire album to a Web page, as we
describe in Chapter 6 of this minibook.

e QuickTime: Export photos or an album set up as a slideshow to the
QuickTime format.

3. Click the QuickTime tab.
The QuickTime pane appears.
4. Change the movie options as you wish, especially the Images section.

In the QuickTime pane’s Images section, specify the pixel resolution of
your movie. If you make a movie as an experiment, go ahead with the
suggested resolution settings of 640 x 480 pixels. We outline the different
resolutions in the sidebar, “The QuickTime resolution.”

5. Click the Export button to create the QuickTime movie.
The Save As dialog opens.

6. Type a name for the QuickTime movie, and choose where to save it on
your hard drive, and then click the Save button.

You can change the following settings in the QuickTime pane of the Export
Files window:

4+ Time to display each photo: You can also control the time each photo
takes to show by typing a number in the Display Image for . . . Seconds
text field in the Images section of the QuickTime pane. (This setting
overrides the settings for the slideshow in the Slideshow Settings
window.) You can be precise about the number of seconds for displaying
the image, down to hundredths of a second. In fact, you can make a
QuickTime movie that displays images so fast it could pass for a light
show at a rock concert. The maximum duration for each slide is
60 seconds.

4+ Background color: To add a background color, click the Color button in
the Background section of the QuickTime pane and then click the color
preview box. The Colors window appears, as shown in Figure 5-11. The
Colors window gives you multiple ways to select a color. The color
wheel includes a slider for selecting the color’s intensity. You can try
other ways to select a color — the icons along the top row of the Colors
window offer color-value sliders, color swatches, a spectrum, and a set
of crayons. To set a color, drag the color you chose in the Colors
window to the preview box in the QuickTime pane.
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The QuickTime resolution

You have some choices to make about how you
plan to use this movie, before setting the image
resolution and exporting the QuickTime movie.
Although you can go with the default resolution
of 640 x 480 pixels, you can also make a movie
as large as your monitor (which is how iPhoto
typically plays slideshows).

If you do increase the pixel resolution, you may

A resolution of 800 x 600 is okay for just about
all computer displays, but 640 x 480, the sug-
gested resolution, is by far the most commonly
used. With 640 x 480 pixels, the resulting file
size is small and easy to handle by e-mail or
other means (such as publishing on a Web
page). For example, a slideshow of ten photos,
at a 640 x 480 pixel image size, creates a

run into a problem. Pixel resolution affects file QuickTime file thatis 1MB; the same slideshow Book Il

X p : .~ at 800 x 600 pixels creates a 1.5MB file, and a Chapter 5
size dramatically, and you need to make a movie - A

. slideshow at 1,024 x 768 pixels creates a 2.3MB

that everyone can play. If you specify 1,024 x 768 file §
pixels (the typical display setting for slideshows ' &
on an iMac), the resulting movie may be too ~ Remember: Music takes up considerable a
large to send as an e-mail attachment — if space. A slideshow saved as a QuickTime file 12
that’s what you want to do with it. Your movie’s  with music (such as the sample song “Minuet §
screen size may also be too large for other in G”)is a lot larger than the same file saved =1
people’s monitors, such as older iBooks. without music. With music, the file size jumps 5

Although you can type any number you want as
a pixel dimension, you should maintain the 4:3
aspect ratio that digital cameras and displays
use. You can, however, reverse the ratio and
specify 480 x 640 pixels, if all the photos in the
slideshow are vertically oriented.

up to 1.6MB for a slideshow with ten photos
at a 640 x 480 resolution. You can reduce the
music’s sampling rate in iTunes before using
the music with the slideshow, but that’s another
topic, which we cover in Book I.
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The color you choose serves as the first and last frames of the movie
and fills the margins of vertically oriented photos or other odd-shaped
photos. You may want to choose a color that matches the backgrounds
of your photos, such as blue for blue sky or water photos. However,
black is the most effective choice for most slideshows.

4+ Background image: An alternative to a background color is a background
image, preferably one that doesn’t clash with the photos themselves
(unless you are trying for a special clashing effect). To set an image as
the background, select the Image option in the Background section of the
QuickTime pane, and then click the Set button to select an image from
your hard drive.

4 Music: Decide whether to include the music that you set in the Slideshow
Settings window, keeping in mind that the alternative is a silent movie
and a smaller file.

To view the finished movie, open the movie file using the QuickTime Player
or any other application that plays QuickTime movies. Your slideshow looks
like a professional presentation, and now you can share it with the world.

Exporting a slideshow to iDVD

A great way to share your slideshow is to burn a DVD, which can then be
played with any type of DVD player. If you have an Apple-supported DVD-R
drive (such as Apple’s SuperDrive), you can create your own DVDs with
slideshows, menus, and video clips — a process called burning.

iDVD offers tools for creating DVDs with menus for selecting material on the
disc. You can transfer a slideshow, including its music, directly from iPhoto
to iDVD to create a DVD slideshow.

To export a slideshow to iDVD, follow these steps:
1. In Organize mode, select an album or individual photos used in a
slideshow.
2. Click the iDVD icon in the Tools pane (available if you have iDVD).
The iDVD application opens, as shown in Figure 5-12.

3. Click the Customize button (or choose Project->Show Customize Panel
from the iDVD toolbar).

The Customize drawer opens to the left of the stage, attached to the
iDVD window.

4. Click the Media button in the Customize drawer and choose Photos
from the pop-up menu.
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Your albums from iPhoto appear, ready for use with iDVD. The photos
from your library, while remaining in your library, are now linked to an
iDVD project. You don’t need to export and import photos; in fact, you
can still make changes to the photos in your library and albums in
iPhoto, while keeping them linked to this iDVD project.

Creating DVDs is a much bigger topic than we can cover here — check
out Book IV for the full story on iDVD.

My Great DVD
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Chapter 6: Printing and
Publishing Photos and Books

In This Chapter

v~ Setting up your printer and printing photos

v Ordering prints from services
1 Assembling a photo book

v Sharing photos by e-mail

v Publishing Web pages

p eople generally save photos for posterity, nostalgia, history, and hun-
dreds of other reasons, but for the most part, people save photos so
that others can see them.

Paper is still the most useful medium for showing photos. You still want prints
to put in frames, scrapbooks, and wallets. Your grandmother still hasn’t fig-
ured out e-mail, let alone how to save a photo attached to an e-mail message,
so you’ll want to print photos for her. With iPhoto, you can create prints on
your own color printer and print as many as you want without using a serv-
ice. And if you want real photographic prints, you can order them directly
through iPhoto by using the Kodak online service.

You can go much further with iPhoto: You can even publish a photo book
that looks professional. After organizing photos into a book layout that can
include titles and captions, you can order professionally printed books
worthy of the Library of Congress.

And publishing photos on the Web is easy with the iPhoto HomePage fea-
ture. Not only can you connect to a Web site where you can publish your
photos, but you can also produce a layout of the Web page automatically
and add text, such as titles and captions. You can also export photos into
other file formats for use with other programs, such as Web authoring pro-
grams, and for posting to Web sites using methods other than HomePage.
You can even export an entire photo album to share with others.

This chapter walks you through all the details of printing your own photo-
graphic prints and things such as greeting cards, ordering prints from online
services, ordering photo books, and publishing photos on the Web.
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Setting Up Your Printer

The trees may not like it, but paper remains the most universal medium for
showing photos. True, with digital photography, the noxious chemicals of
film processing are gone, and the darkroom has been turned into a walk-in
closet, but you still need to make prints of some kind.

In fact, digital photography makes it easier than ever to get exactly the
prints you want without wasting money on the prints you don’t want. For
example, you can print your own contact sheets, which are quick prints of
photos in a thumbnail size. Or you can simply use iPhoto as a digital contact
sheet. As an added bonus, you can print individual photos on your own
color printer to see how they look in print form before ordering a high-
quality print on photographic paper. You can even print your own greeting
cards.

Read through this section to discover how to easily set up your printer to
take advantage of printing your own photos.

Picking a desktop printer and paper

Printing photos from iPhoto is just about the easiest thing you can do.
However, your results may be low quality, especially if you use a standard
office printer. Office printers used for invoices and documents are not going
to do justice to your color photos. To achieve the result that you want, you
have to spend a little money.

First, we recommend that you buy a color printer. You need at least a decent
inexpensive color printer, available from manufacturers such as Epson,
Hewlett-Packard, and Canon, for less than $200. Higher-quality color printers
are surprisingly affordable, such as the Canon i950 Color Photo Printer for
about $250. Note: Make sure that you factor in the number of prints that you
can make with a single ink cartridge and the cost to replace the cartridge.
Desktop printers designed to print photos, such as the aforementioned
Canon 1950, typically use six different ink colors rather than just the four
colors used by most color inkjet printers. The extra colors make photo
prints look outstanding.

A second factor to consider is the type of paper used for printing. The plain
typing paper that you use with a laser printer or photocopier is too thin and
can’t absorb enough ink to show colors well. You can still use regular copy
paper, however, to show how large a photo print is or for contact sheets.
Still, so-called “high resolution” paper used with inkjets is heavier and might
do better for test prints — it’s not glossy, but it has a smooth finish on one
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side. The best paper for finished prints or greeting cards is either glossy
photo paper or, if you can afford it, glossy film, made with polyethylene
rather than paper.

Setting up pages for your desktop printer

When using a printer with iPhoto, like with most Mac applications, you can
access printer quality features by choosing Filew>Page Setup. Different print-
ers offer different features (or sometimes, just different terminology for the
same types of features). You can access the printer’s settings by clicking the
Settings pop-up menu in the Page Setup dialog, as shown in Figure 6-1, which
offers these settings:

4+ Page Attributes: Choose the size of your paper. You can also set the
orientation of the page to portrait style (horizontal), or landscape style
(vertical facing left, or vertical facing right). You can also resize the page
to fit the paper.

4+ Custom Paper Size: You can specify custom sizes, depending on your
printer. Color photo printers typically offer sizes for precut photo paper,
such as 4 x 6. Your printer may also have choices for paper, such as plain,
inkjet paper, glossy photo paper, and so on.

4+ Summary: Displays a summary of the page attributes, including the
document page size, paper dimensions, orientation, scale, and paper
margins.
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If you have more than one printer that you can choose from, switch printers
by choosing the one that you want in the Format For pop-up menu in the Page
Setup dialog.

Printing Photos

After you set up your printer settings, you're ready to print. Follow these
steps:

1.
2.

Select one or more photos in Organize mode.

V?‘“\NG! Choose File=>Print or click the Print button in the Tools pane.
S Click the Print button, not the Order Prints button, which connects you

to the Kodak service.

The Print dialog appears with the photo that you selected displayed in a
preview pane, as shown in Figure 6-2.

Make any changes to the settings.

For example, in Figure 6-2, we set the Style setting to the Full Page option
to get a full-page print of a single photo, and we also specified one copy
and set the margins. A preview of the printed photo appears on the left
side of the dialog.

4. Click the Print button.
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The Print dialog offers pop-up menus for page styles, presets, and printers,
and various options for controlling the printing:

<+

+

Printer: If you have more than one printer, you can choose a different
printer.

Presets: You can save print settings if you click the Advanced Options
button. Presets saved in the Advanced Options area are listed in the
Preset pop-up menu for easy selection.

Margins: Use this slider to set the margin around the edges of the images
to be printed.

Style: Set the specific types of pages that iPhoto handles for any type of
color printer. When you choose a different style, the preview image in the
dialog changes to show that style. Some of these styles are described in
more detail in this chapter. The styles available from the Style menu are

¢ Contact Sheet: A quick print of photos in a thumbnail size.

¢ Full Page: The photo occupies a full page. You can drag the Margins
slider to increase the size of the margins of the page.

* Greeting Card: The photos are laid out in the standard greeting card
format, either single-fold or double-fold.

¢ N-Up: You can use this style to place from 4 to 16 photos on a single
page or to place the same photo several times on the same page.

e Sampler: This style offers two templates for layouts that are attrac-
tive for printed photos.

¢ Standard Prints: This style provides sizes and layouts for prints just
like the ones that you get from a photo service.

Copies: Specify the number of copies to print. If you print a set of photos,
this number specifies the number of copies of the entire set.

Preview button: Click to see a full-screen preview of the page that you're
printing.

Save As PDF button: You can save the pages as a PDF (Portable Document
Format) file that others can open with Adobe Acrobat.

Advanced Options button: Click to access the Advanced Options area of
the Print dialog. These settings vary from printer to printer. You can use
the Presets pop-up menu to save your settings by choosing Save As in the
pop-up menu and typing a name for the preset. The preset appears from
that point on in the Presets menu. The Advanced Options area includes
the Copies & Pages, Layout, Output Options, Error Handling, Paper Feed,
and Printer Features settings. (These settings are described in detail in a
book about Mac OS X such as Mac OS X All-in-One Desk Reference For
Dummies by Mark L. Chambers, published by Wiley Publishing, Inc.)
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Printing standard prints

Standard prints are what you get from a photo service. iPhoto makes con-
forming to standard print sizes with your color printer easy because it auto-
matically resizes images to fit properly for the settings you choose. These
settings are useful if you intend to use store-bought picture frames, which
are measured for specific sizes such as 4 x 6 or 8 x 10.

To select a standard print size when printing to your desktop printer, choose
these settings from the Print dialog:

1. Choose the Standard Prints option from the Style pop-up menu, as
shown in Figure 6-3.

2. Choose the appropriate size from the Size pop-up menu.
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it does at smaller print sizes. You need a resolution of at least 1800 x 2200
pixels for a decent 8 x 10 print. If you choose a large size for an image that is
lower in resolution than quality demands, iPhoto kindly signals you with a
yellow warning sign in the preview pane of the Print dialog.

Although the Print dialog offers many choices for printed photo sizes, you
may need to adjust the proportions of your photo to fit certain sizes. Photos
from most digital cameras are sized at proportions of 4 (width) x 3 (height),
which is fine for computer displays, DVDs, and iPhoto book layouts, but isn’t
the right proportion for standard prints. If you don’t adjust the proportions,
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you may find that some photos have unintended white margins at the sides
of the finished prints. iPhoto makes this adjustment easy with the Constrain
feature for cropping.

The Constrain pop-up menu in iPhoto offers choices for standard print and
display formats. When cropping is constrained, the cropped photo fits the
format properly. To find out more about cropping with the Constrain feature,
see Chapter 4 of this minibook.

Printing greeting cards

iPhoto provides a style for greeting cards. You can choose either the single-
fold or double-fold style. To select a greeting card layout when printing to your
desktop printer, choose the Greeting Card option from the Style pop-up menu
in the Print dialog.

iPhoto rotates and places your photo properly on the page so that you can
fold the page into a proper greeting card. You can click the option to print
in single-fold or double-fold style. The preview pane shows what the photo
looks like in either style:

4+ Single-fold: The photo appears upside down at the top of the page,
making a large greeting card with a single horizontal fold easy to create,
as shown in Figure 6-4.

4+ Double-fold: The photo appears in the top-right corner of the page
facing to the right, making a standard-sized greeting card with both a
horizontal and a vertical fold easy to create.
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Figure 6-5:
Choose
Contact
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number
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You can use the special glossy paper stock for greeting cards that is already

scored and perforated for easy folding.

Printing contact sheets for albums

In commercial photography, a contact sheet is a quick print of photos in a
thumbnail size. You can order contact sheets when you process film rolls so

that you can choose which ones to use for full prints.

Of course, in iPhoto, you can print your own contact sheets,

just like a com-

mercial photo service. Contact sheets can be useful for comparing the qual-
ity of several photos at once, making test prints of an entire album, or even
repeating the same photo in a grid for cutting up wallet-sized prints.

To print a contact sheet, choose the Contact Sheet option from the Style

pop-up menu in the Print dialog, as shown in Figure 6-5.

& i)

iPhoto

Source

- [[lll Photo Library
[ Last Roll

[ Last 12 Month
&) Album-marke
) vacation-spri
) work photos
[ 1P graphics
[ NY band tour

R

Printer: | LaserWriter Pro 630 L.
f

< |

Presets: | Standard

_Style
A(mss'—ﬁ'—\
oW
ESaveDaper

36 photos selected
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3 pages 1o print

@] band photos ¢
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[/ home land & t

)/ soccer-rail 2
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§i Trash
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@) (preview)

(‘Save As PDF_ ) { Advanced Options ) € print )

Cancel

Title: (multiple)
Dace: 319/02-6/24/03
Size: 36 photos.

Bytes: 18.9 MB = i

Music: Blip in the Life DSCFO016.JPG copy Portland OR Borders

E] 36 of 36 photos Import Edit  Book m—————— ([
& v & e = BoE R

Print Slideshow Email Order Prints ~ Order Book  HomePage  .Mac Slides Desktop iDvD Burn

The Contact Sheet style offers the following settings:

)

4 Across: Use the slider to choose how many slides you want across the
page. You can print up to eight photos in a row (although you need a

magnifying glass to see them).

4 Save Paper: Select the Save Paper option to print photos with thinner

margins. Keep it unselected to spread the photos out on
preview pane shows how the photos will print.

the page. The



Ordering Prints

You can order prints from the Kodak photo service directly from iPhoto that
are much higher quality than the prints you can make with a color printer.
To use the Kodak photo service, you set up an account with your credit
card, and Apple remembers your account information the next time that you
order prints. Select the size and quantity of the photos to be printed, and in
one click, transmit the photos directly to Kodak. Your finished photos are
printed on high-quality glossy photographic paper and are mailed or express-

Figure 6-6:
Order prints
from Kodak
with the
Order Prints
window.

delivered to you.

Ordering Prints
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To order prints, you need to connect to the Internet. Then follow these steps:

1. Select the photos to print in Organize mode.

You can also select an album to order prints of all the photos in the

album.

2. Click the Order Prints button in the Tools pane.

The photos that you selected appear in the Kodak Order Prints window,

as shown in Figure 6-6.

3. Click the Set Up Account button.

The Set Up Account dialog appears, as shown in Figure 6-7.

To order prints, you need an Apple account with 1-

Click® ordering enabled. If you don't have an Apple

account, you can create one in just a few minutes by
clicking Set Up Account.

Pricing is in US Dollars

1. Low resolution may result in poor print quality.

eee Order Prints
Kodak Quick Order
Print Service 4 x B's f
4x6 §0.49 each 0
S5x7 0.99 each 0
Wallet (4) 1.79 each 0
8x 10 3.99 each o
1 16 x 20 14.99 each 0
1 20 x 30 19.99 each 0
4x6 50.49 each 0
Sx7 0.99 each 0
Wallet (4) 1.79 each 0
8x 10 3.99 each o
1 16 x 20 14.99 each 0 Fy
20 x 30 15.99 each o v

Subrotal: 50.00
Tax (Estimated):
Shipping:

Order Total:

_f Cancel | fSetUpfg:muma
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[5] Set Up Account
Figure 6-7: Apple Account Sign-in
LOg intO To continue with your order, enter an Apple ID and Password. If you don't have an Apple
account, create one
your Apple
ahCCgUnLIn ’ Create Account ) Apple 1D: I
the Set ———————
Account P ¢ Learn More ) | Password: _ Forgot Password? _
dialOg. ( Cancel ) @

¢ If you already have an account: Sign in with your Apple ID (which is
the same as your .Mac ID) and password. You can skip Steps 4
through 7 if you already have an account.

¢ To create a new account: Click the Create Account button, which
takes you to another page in the Set Up Account dialog, as shown in
Figure 6-8.

[5) Set Up Account

@ Step 1 of 3: Create an Apple Account

Flease enter the following information to create your new Apple account.

Email Address buve@l 1 This is your Apple ID.
Password: ssssssss This must be at least 6 characters.
Verify: sessssss Retype your password.

Enter a question and answer that you can easily remember to help
us verify your identity in case you forget your password.

Question:

——

. Answer
Figure 6-8:

Please enter your date of birth.
Create . .
Month: | January [ :] Day: | 5 [ :]

anew
account E | would like to receive Apple news, software updates, special offers, and Privacy Poll
W|th your information about related products and services from other companies o e
personal
I 1 T AR AP
information. @ {_Cancel )} [ Continue }

4. Fill in your personal information and click the Continue button.

The information includes your e-mail address, a password, and a question
and answer that you can easily remember to help verify your identity in
case you forget your password.
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5. Click the Accept button to accept the Terms of Use agreement for the
service.

6. Enter your billing information and click the Continue button.

Include your billing address, phone number, credit card information, and
preferred shipping method (standard or express).

7. Enter your shipping address and phone number and click the Continue
button.

8. Enter the quantity of prints in the far right column of the Order Prints
window for each print size.

To quickly fill in a quantity of one for a specific print size for multiple
photos, click the Quick Order button at the top-right corner of the Order
Prints window. Alternatively, you can scroll down and specify different
numbers and sizes for each photo. The total cost updates as you make
your selections.

9. Click the Buy Now button to finish your order.

Apple offers 1-Click ordering with standard encryption for keeping your
credit card and shipping information secure. If you don’t have an Apple
Store 1-Click ordering account, you are guided through the process of
setting up an account for the first time.

A low-resolution warning (exclamation point in a yellow triangle) appears if
your photo is not high enough in resolution for a particular print size. You
can still order that print size for that photo, but the quality will probably

be poor. You get the same warnings when you print at these sizes on your
own printer — if you do test prints first, you know in advance which photos
work best at which sizes. We suggest that you use the 8 x 10 size with photos
1536 x 1024 pixels or higher in resolution.

You may already have realized that the Order Prints function, which is con-
nected to the Kodak service, is not the only way to order prints. Other serv-
ices may be less expensive or offer better choices. You can easily burn a CD
with a photo album (as we describe in Chapter 3 of this minibook) and send
the CD to a photo service. Many services on the Internet accept photos
attached to e-mails or uploaded directly to a Web site — we describe both
methods later in this chapter.

Services may accept only certain file formats for photos. You can export
photos from iPhoto in appropriate file formats by selecting one or more
photos, or an entire album, and choosing File>Export. We explain more
about how to do this later in this chapter, in the “Exporting to a photo
service” section.
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Inexpensive desktop publishing technology provided freedom for many
small presses and publishers and also paved the way for digital photography
and other multimedia pursuits. But it was not just the graphical interface of
the computer and the rise of laser printers that brought about this change —
it was most importantly the introduction of layout tools that everyone could
use. Overnight, anyone could be a newsletter publisher, or even a magazine
or book publisher, because tools were available to help you lay out elements
on pages.

iPhoto provides an automatic book layout capability that helps anyone become
a photo book publisher. You can assemble a book from a photo album and
have it professionally printed and bound to look as good as most books on
library shelves (better, in fact, because yours hasn’t been mishandled yet).
You can create catalog-style books, picture books, portfolios, story books,
and yearbooks, or use any of the layout themes for books that defy category.

Choosing a book layout theme

With iPhoto, you can choose from among several book layout themes and
place photos in pages automatically. Your first step is to choose the photos
that you want for the photo book and assemble them into a photo album, as
we describe in Chapter 3 of this minibook.

Book layouts are based on photo albums — the sequence of photos in the
album defines the sequence of the pages in the book. If you want to change
the sequence, rearrange the photos in the album. You can create different
types of books with the same photos by creating separate photo albums for
each book. Creating a photo album for a book is no different than creating a
photo album for any other reason. We describe how to create and arrange
photos in photo albums in more detail in Chapter 3 of this minibook. To start
the process of creating a book, you choose a book layout theme:

1. Select a photo album and arrange the photos in the sequence that you
want in Organize mode.

Flip to Chapter 3 of this minibook if you need help arranging your photos.
2. Click the Book mode button.

iPhoto displays the layout of the book with photos from the selected
album with the Picture Book theme. A preview of the cover page appears
at the top, with thumbnails of subsequent pages arranged below it, as
shown in Figure 6-9.

The Picture Book theme appears by default when you first click the Book
mode button. As you can see in Figure 6-9, photos of different sizes work
well in this format, and iPhoto makes semi-intelligent choices based on



Figure 6-9:
The Picture
Book layout
theme.
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photo sizes — page 3, for example, places two photos side-by-side. We
describe how to fine-tune the design of pages in the next section, “Fine-
tuning page layouts.”

3. Choose a book layout theme in the Theme pop-up menu in the
Tools pane.

The themes define the photo layout for the pages:

Catalog: This theme places more photos on each page than other
themes. It is often used for catalogs and directories.

Classic: The Classic theme is a standard layout for coffee-table books
with room for captions and commentary:.

Picture Book: The default setting, Picture Book is commonly used
for printed photo albums and does not include any text, such as
titles or comments.

Portfolio: This theme presents photos with accompanying captions
and text in a layout suitable for commercial portfolios, used by
artists and photographers to show their work.

Story Book: With photos placed at angles and combined on the page,
this theme offers attractive choices for page layouts that allow
enough room for text.

¢ Year Book: This variation of the Catalog theme provides a standard
layout for college and high school yearbooks, with multiple photos
on each page.

All the themes offer special title pages and variations of the layout in
order for you to customize your book.

[slala)
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Figure 6-10:
Preview for
the Classic
photo book
theme.

4. Optional: Select a page to preview and click the Preview button in the
Tools pane.

To really look at the way a theme works its magic on pages, select a page
from the row of thumbnails — scroll the row of thumbnails horizontally
to see more pages. The page that you selected appears in a separate
window, as shown in Figure 6-10.

By choosing themes and previewing pages, you can see right away what the
book looks like.

ecs NY band tour

<17 ] ™ show Guides

\\J

Fine-tuning page layouts

After selecting a book layout theme for your photo album, you can fine-tune
the design of each page. You can even rearrange the photos in your book
while designing — you may not realize that certain photos don’t look good
together until you see the page sequence in Book mode.

When you rearrange pages in Book mode (as in moving page 5 before page 3,
and so on), the photos on those pages are also automatically rearranged in the
photo album. You can set the photo sequence for your book in either Organize
mode by rearranging photos in the album or in Book mode by rearranging
pages. If you change the arrangement in the album, the book changes as
well, and vice versa. However, you can’t delete a photo in Book mode — use
Organize mode to delete a photo from the photo album used for the book.
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As you change the number of photos on a page,
or change the order of pages that have multiple
photos, the change affects the pages that come
afterwards. The best way to design pages is to
work forward in sequence from the cover page
and page one. When you make changes that
ripple across the page sequence, you can
decide whether you like the changes, and if you
do, you can lock the page by checking the Lock
Page check box in the Tools pane. From that

Locking pages and saving your work

point, changes made to other pages do not
affect the locked page.

As for saving your work, you don't have to:
iPhoto keeps track of your Book mode settings
for the photo album you select. But if you want
to change the book layout while preserving the
layout you just created, you can do this by
making a duplicate copy of the photo album;
just choose Filez>Duplicate.

To rearrange pages, click the page and drag it to the new location in the
sequence. While you drag, the sequence scrolls horizontally to reveal more
pages, so you can drag a page from the beginning to the end.

Each theme offers options for laying out pages. For example, in Figure 6-11,
page 7 shows two slides on the page. By changing the number of photos on
the page in the Page Design pop-up menu in the Tools pane, you can add or

delete a photo to this page.
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The Page Design pop-up menu, available for each theme, provides layouts for

4+ Cover: The cover page of the book.
4+ Introduction: The introduction page, which may have room for text.
4+ One: A book page layout with one photo on the page.

4+ Two, Three, Four, and so on: Book page layouts with two, three, four, or
more photos on the page (menu options change depending on theme).

Options that also appear in the Tools pane for each theme include the
following:

4+ Titles: Select the Titles check box to include titles. By default, the title
(or caption) for each photo in the book is the photo’s title in the photo
library.

4+ Comments: Select the Comments check box to add comments to your
book. Comments for photos in your photo library are, by default, used
as comments in layouts that offer space for them.

4+ Page Numbers: iPhoto automatically numbers the pages of your book, but
you can opt not to use page numbers by deselecting the Page Numbers
check box.

Editing titles and captions

The titles and comments that you assign to your photos can automatically
be used as titles and captions in books. In each layout theme, you can also
add more text — to the title and introduction page, and in some themes, to
captions. If your comments are like ours, “Daddy falls in the creek to much
applause,” and not meant to be real captions, adding more text is useful.

If you are ordering a print of this book, check it first for spelling errors and
typos. You can use the Spelling options in iPhoto’s Edit menu; first select the
text to be spell checked, and then choose Edit=>Spelling.

If the yellow caution triangle appears when editing titles and captions, it
means that the entered text will not fit in the text field of the printed book.
You need to either choose a smaller font, or better yet, edit the text to reduce
the number of characters, or the book may not print properly.

You can edit the text on pages by clicking directly in the text fields of the
layout in the preview pane. The preview pane increases the size of the image
within the pane, so that you can see clearly to type. You can increase or
decrease the size by dragging the size control slider on the right side under
the row of page thumbnails.
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To change the text font and style, follow these steps:

1. Drag over the text in the field to select it.
2. Choose Edit=>Font=>Show Fonts or press 38+T.

The Fonts window appears, as shown in Figure 6-12.
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3. Select a different font and/or style.

The selections that you make in the Fonts window change the appear-
ance of the text in the preview pane in Book mode. You can’t increase
the size of the text beyond the text field length because these layouts
adhere strictly to the themes. In general, the font changes that you make
to a caption on a page affect all the captions on all the pages.

To select a font, choose a family (such as Baskerville), a typeface style
within that family (such as Bold Italic), and the size of the font.

The Extras pop-up menu provides many font options for using fonts with
Mac OS X applications. Some of these options are useful for text in iPhoto,
including

e Show Preview/Hide Preview: Shows or hides a preview of the font
settings right in the Fonts window. (You can drag the window to be
larger to see both the preview and the font settings.)

¢ Show Characters: Displays the Character Palette window with
Japanese, Chinese, Cyrillic, Greek, and special symbols that you can
insert into your text.
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e Color: Assigns a color to the text. Keep in mind that the font color is
part of the defined book theme.

¢ Get Fonts: Launches your Web browser and takes you to the page on
the Apple site for buying fonts for the Mac.

4. Click the Close button to close the Font window.

If you want to create a more flexible page layout, well, that’s what page
layout programs are for! (We recommend Adobe PageMaker.)

Previewing and printing books

Previewing your book on your Mac is the best way to see quickly whether
the photos look right on the page. Printing is the best way to see whether
the photos print well and to catch any spelling errors or typos.

To preview the book, select any page from the row of thumbnails, and click
the Preview button in the Tools pane to see that page in a separate window
(refer to Figure 6-10). You can jump page by page with the arrow buttons,
and you can turn on the Show Guides option at the top of the window to see
the text box outlines.

To print the book, first set up the pages for your printer using File>Page
Setup, as we describe earlier in this chapter in the section, “Setting up pages
for your desktop printer.” Then follow these steps:

1. Choose File>Print in Book mode.

The Print dialog appears with the first page from the book displayed in a
preview pane.

2. Make changes to the settings.

The Print dialog for printing books offers the following settings: Printer,
Presets, Copies, Preview button, Save As PDF, and Advanced Options.
See the section, “Printing Photos,” earlier in this chapter for more on
printing options. Even without a printer, you can see how the book will
look by clicking the Preview button in the Print dialog. You can then
browse the entire photo book in Preview mode, clicking thumbnails to
reveal pages, as shown in Figure 6-13.

3. Click the Print button.

You can save the book as a PDF file, which is accepted by many printing and
publishing services. You can save an entire book as a PDF file and then attach
that PDF to an e-mail message. You can also post PDF files on Web sites. You
can save time and money by saving the book as a PDF, and then printing it
on a black-and-white printer to check for spelling errors or other mistakes
before you order a printed book.



Figure 6-13:
Previewing
the book
page from
the Print
dialog.
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NY band tour

Ordering professionally printed books

iPhoto links you directly to an online print service where you can order pro-
fessionally printed and bound versions of your book. When you first use the
service, you can either log into your existing Apple account or set up an
account with your credit card, as we describe earlier in this chapter in the
“Ordering prints” section.

The hardback books are covered in elegant linen, and they measure 9 x 11.25
inches. Note: The minimum number of pages for a book is ten pages; if you
order a book with less, you end up with blank pages. You can duplicate a
photo in the album and create another introduction page, add more photos,
or reduce the number of photos per page to create enough pages.

To order books, you need to connect to the Internet. Then follow these steps:

1. Click the Order Book button in Book mode or the Order Book icon in
Organize mode.

iPhoto converts your book layout into a form that can be transferred to
the book printing service. Depending on how big your book is, transfer-
ring may take a few minutes. The Apple Order Book window appears, as
shown in Figure 6-14.
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Order Book

To order books, you need an Apple account with
1-Click® ordering enabled. If you don't have an

iPhoto books make great gifts!

|2

between now and April 15,2003

Cover Colo[PAIET SN

Burgundy
Light Gray
Nawvy

Gera 20% discount on iPhota
book orders of $60.00 or
more purchased using iPhoto 2

Quantity

Books are hardback 9" x 11 1/4"
and covered in elegant linen.

Cost for 21 page book: §62.09

Figure 6-1 4: Apple account, you can create one in just a few Subtotal 50.00
minutes by clicking Set Up Account —

Use the Tay (Estimated)

Apple online Pricing is in US Dollars Shipping

book order-

ing service Order Total:

to order

a book. @ int Info ( cancel ) ( SetUp Account )

V?‘“\NG! If you get a warning message about low-quality images, it means that you
S ignored previous warning indicators about printing those images at cer-

tain sizes. The photos might be cropped and lower in resolution than their
original versions; if so, you can revert back to the original version of the
photo by selecting it in Organize mode and choosing Photos=>Revert to
Original. If the photos were taken at low resolution, one work-around is
to increase the number of photos on the page, using the Design Page pop-
up menu for that page (in Book mode). Using more photos on the page
reduces the size of the photo but doesn’t reduce its resolution, so the
photo looks and prints better.

Select the cover’s color and the quantity in the Color Cover
pop-up menu.

You can make color choices such as black, burgundy, light gray, or navy
for the cover of the book.

Click the Set Up Account button.

You need to set up your account with a credit card for billing, as we
describe earlier in this chapter in the “Ordering prints” section.

Follow the on-screen instructions to make the purchase.

Follow the instructions (the helpful folks at Apple are always improving
them) to finish the purchase process.
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Sharing Photos Online

Did you jump right to this section of the book when you first opened it?
Going online creates a whole new set of possibilities with your photos. You
can do projects you never considered before — a school play, the family
vacation, even business opportunities. Whatever the purpose is for using
photos, you can probably do it cheaper and easier online.

The fastest and easiest way to get photos in the hands of others is through
e-mail. But you can also share photo albums by using online photo services
(many of which also offer high-quality prints of digital photos). You can even
publish your photos on a Web page, whether you have a site of your own

or not.

Sending photos as e-mail attachments

Besides browsing the Web, sending e-mail with a photo is perhaps the most
common use of the Internet. E-mail is a great way to send a photo to one
person or a thousand people (although we discourage spamming — please
don’t send us your baby photos unless we know you). Of course, you can
even combine several photos in one e-mail, but if you send high-resolution
photos, the e-mail may be too large to send. Adding one photo to an e-mail
message is easy and almost always works.

N iPhoto works with your e-mail program. You can set up your e-mail program
by choosing iPhoto=>Preferences and selecting an e-mail application in the
Mail pop-up menu. For example, we use the Mail application provided with
Mac OS X.
If you have an e-mail account and you’re ready to send a message, attaching
a photo is simple. Follow these steps:

1. Select a photo in Organize mode.
2. Click the Email icon in the Tools pane.
The Mail Photo dialog appears, as shown in Figure 6-15.

Figure 6-15: Mail Photo

Choose T

a size for Size: Medium (640x480) x T! |

phOtOS to E::;E:;;ize; 122 s Choose size for emailed photos | |

e-mail in the Include: @ Tides & Comments

Mail Photo = = =

dialog. el = atllnis
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Figure 6-16:
An e-mail
message
ready to
send with

a photo.

. Choose a size for the image in the Size pop-up menu.

Choose from the following sizes: Small (240 x 320), Medium (640 x 480),
Large (1280 x 960), or Full Size (full quality). To find out more about sizing
photos for e-mail, see the sidebar, “Sizing photos for e-mail,” elsewhere
in this chapter.

. Select the Titles and the Comments check boxes to include titles and

comments if you want.

iPhoto includes the title and comment in the text part of the e-mail mes-
sage. iPhoto also puts the title into the subject field of the e-mail.

. Click the Compose button.

iPhoto processes your photos into the standard JPEG format for e-mail
attachments and then launches your mail application with a new mes-

sage featuring the photo, as shown in Figure 6-16.

80ce DSCFO016.JPG copy )

Artach Address Fonts Colors Save As Draft

To:|1

Ce:

Subject: DSCFO016.JPG copy

DSCFO016.JPG copy
Pete Sears on accordian

\\3

6. Add the e-mail recipient’s address and a subject line.

7. Save or send the e-mail message.

If you want to send the photo in its original file format or use PDF as a file

format (for a photo book, for example), don’t use the Email icon. First create
a new e-mail message and leave its window open. Then switch to iPhoto and

drag the thumbnail for the photo (to copy a photo in its original format)
directly into the message window to attach the file. To attach a PDF file, you



Figure 6-17:
Export a
photo with
the Export
Photos
dialog.
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have to save it on your hard drive first from iPhoto by choosing File2>Print
and then clicking the Save As PDF button. You can then use the Mail applica-
tion to attach the PDF file to the message.

Exportmq toa ph0t0 service

Apple offers the .Mac service for all Mac users (for a fee, of course). One of
its major benefits is the capability to share photos with others over the
Internet in the form of a slideshow. Online photo services would also love
your business. Besides offering prints, many offer online photo albums that
you can publish on the Internet to share with friends in a slideshow format.

To send your photos to an online service, you must follow the instructions
provided by the service. Many services accept photos attached to e-mails or
uploaded directly to their sites. Before sending photos, be sure that your
photos are in the format the service accepts. You can export photos from
iPhoto into the appropriate format.

Follow these steps for exporting photos to photo services:

1. Select one or more photos, or an entire album, in Organize mode.
2. Choose File=>Export.
The Export Photos dialog appears, as shown in Figure 6-17.

Export Photos

l File Expart ] ‘Web Page ‘ QuickTime™ |

— Images

Format .Original s !

—Size . —Name

| @ Full-size images | | @ Use filename

O Use title

=

| () Scale images no larger than

1536 1024 Use album name

| Preserve 3:2 aspect ratio | ™ Use extension

1 photo { cancel \ ( Export ?

3. Click the File Export tab.

The File Export pane appears, with options for exporting photos into
different file formats.
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4. Select the appropriate file format from the Format pop-up menu.

The Format pop-up menu provides the following formats:

¢ Original: The original format for the photo. (The format used by the
digital camera, typically JPEG.)

e JPG: Short for JPEG (Joint Photographic Experts Group), the stan-
dard image format for Web pages. Use this choice to make sure the
photo is in a standard version of JPEG (if your digital camera’s

format is specialized).

o TIFF: Tagged Image File Format, the standard format for desktop pub-

lishing software.

¢ PNG: Portable Network Graphics format, a new standard designed
to replace the GIF format that’s used extensively on the Web for

graphics.

Be sure to select the format that the photo service requires. Most serv-
ices support the JPEG and TIFF formats.

You can specify the image size and filename in the File Export tab. Keep
the Use Extension option selected if you want the filename to have a
standard extension that identifies the file’s format — this is usually the
case, especially with online services.

5. Click the Export button and choose a folder for saving the file.

Sizing photos for e-mail

The Size pop-up menu in the Mail Photo dialog
offers size choices, and we recommend the
following:

Choose the Small setting (240 x 320) to keep
e-mail attachments small. The photo resizes to
240 x 320 pixels, which is good enough for many
tasks, such as announcing a new baby or send-
ing someone a birthday photo.

Choose the Medium setting (640 x 480) if you
want to send photos that occupy a nice portion
of a typical monitor but not create too large of
an attachment.

Choose the Large setting (1280 x 960) if you are
sending samples of your photos to others who

will print them. The higher the resolution for
printing, the better quality the print result —
and the attachment is probably still small
enough to pass under the attachment size limits
of most Internet service providers.

Choose the Full Size (full quality) setting only
when sending photos to photo services for
making prints, or when high quality is absolutely
necessary, such as the rare occasion when you
publish photos in a magazine. The attachment
may be too large for some Internet service
providers. E-mail servers choke on large
attachments, and you may get a polite message
from your service provider informing you that
the attachment is too large.
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After exporting photos to your hard drive, follow the instructions from the
online service to upload the files to the service.

Publishing photos on Web pages

Publishing on the Web is by far the most universal method of distributing
photos online. Everyone in the world can see your photos on a Web page —
as long as they can find the Web page. (You can create a Web page whose
address you never tell anyone, but Google may still find it!)

You can publish photos on the Web by using iPhoto in two ways: Use the
HomePage feature of the .Mac service, or export your photos and upload
them to a site on the Internet (or e-mail them to a hosting service). With Web
publishing software, you can set up a Site folder on your hard drive where
you can temporarily store exported photos until posting them to the Web.

With HomePage on the .Mac service, others can see your photos on your
Web page hosted by Apple. You must first have a .Mac account, which you
can set up by visiting the Apple site and registering with a credit card, as
described in the “Ordering prints” section, earlier in this chapter.

Follow these steps to use the HomePage feature of the .Mac service:

1. Select the photos you want to publish in Organize mode.

You can select multiple photos or an entire photo album. You can even
publish an entire library.

2. Click the HomePage icon in the Tools pane.

The Publish HomePage window appears, with the photos that you
selected.

3. Choose a theme and layout option for the Web page.

Pick a theme for framing and placing the photos on the Web page from
the scrolling list of thumbnails on the right side of the Publish HomePage
window, as shown in Figure 6-18. The Layout options, at the bottom-left
corner of the Publish HomePage window, offer two choices: two-column
or three-column.

4. Edit the title and caption for the Web page.

You can edit the title and caption for the page by clicking inside the text
area and selecting the text, and then typing your own. By default, the
text comes from the titles and comments in your photo library.

5. Drag photos to change their locations on the page if you want to
change the photo sequence.
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806 Publish HomePage

= i,

Kids Blue
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a theme Publish to: = rockument I’B Include: ] “Send Me a Message”

f Layout: ) 2 Columns @® 3 Columns [ Counter ‘ “
or the a8

Web page. () (Hide Themes ) (cancel ) ( Publish )

6. Select the Send Me a Message check box if you want iPhoto to add a
Feedback button on your HomePage.

Anyone viewing your Web page can send you an iCard by clicking the
Feedback button that .Mac places on your Web page.

7. Select the Counter check box to display a counter on your HomePage.
A counter keeps track of how many times the page is viewed.

8. Select a HomePage site to publish to in the Publish To pop-up menu.

9. Click the Publish button.

iPhoto automatically sends the photos to the Web site and creates the Web
page. A message displays telling you publishing was successful and gives
you the address of the HomePage so that you can tell others.

To view your HomePage, type the address into your Internet browser. The
address is homepage.mac.com/membername (substitute membername with
your name). Figure 6-19 shows an example.

To make changes to your HomePage or to set up a password to protect
access to your HomePage, go to www.mac.com and click the HomePage icon.
You can make changes, preview the page, and republish the page from your
browser.



Figure 6-19:
The
published
HomePage
on the Web.
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If you already have a Web site, use the Export command to create HyperText
Markup Language (HTML) pages with your photos included, and then use
your usual method of uploading the pages to your site.

The Export function does not use layouts — its no-frills design is simple and
easy to modify with any HTML editing program. To publish a Web page of
photos by using the Export button, follow these steps:

1.
2.

Select one or more photos, or an entire album, in Organize mode.
Choose Filec>Export.

iPhoto displays the Export Photos dialog.

Click the Web Page tab.

The Web Page pane appears, as shown in Figure 6-20.

Customize the page layout.

You can specify the number of columns and rows for the photo thumb-
nails, and the background color and text color. The Web page uses
thumbnails as links to larger-size photos. You can specify the size of the
thumbnails in the Thumbnails section, and the size of the larger image in
the Image section. You can also choose to show titles and comments.

Click the Export button and save the page on your hard drive.

The main page with thumbnails and the associated photos are saved
in files ready to be uploaded to your Web site. You can open the pages
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in a Web browser, even though they exist only on your hard drive until
you upload them to your site. Figure 6-21 shows the main page with
thumbnails — viewers click a thumbnail to see the larger version of the

photo.
Export Photos
| File Export I—w:b—w:gq—] QuickTime™ |
&
— Page
Title: | Vacation-Alaska 2003
Columns: 3 Rows: 10 1 Page
Background: & Color I:l
C Image Set...
Text Color: El
— Thumbnail Image
Max width: | 240 Max width: 640
Figure 6-20: Max height: 180 Max height: 480
EXpOft a [ Show title [ Show title
Web page [l Show comment [_] Show comment
with photos
to any site. 24 photos Cancel 3 (" Export )
- Vacation-Alaska 2003 ————
@ = file:/ f fUsers/tony/SitesSites.htm| @ Q- Google )
wme...ic History Rockument-..oson .Mac Apple Mac Amazon eBay Yahoo! Newsv — —
Vacation-Alaska 2003
Figure 6-21:
The page
offers
thumbnails
that link to
larger
versions of
the photos.
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Chapter 1: Digital Moviemaking

In This Chapter

+ Reviewing moviemaking and what you can do with iMovie
1+~ Using a digital camcorder and video shooting techniques

v Touring iMovie and what you need to run it

Udeo is so pervasive in our world that nearly everybody on the planet
has seen it. Ordinary citizens have used camcorders to record violent
weather, exchanges between police and suspects, home bloopers, weddings,
and school plays. As the wise sage (and wisecracking baseball player) Yogi
Berra once said, “You can observe a lot just by watching.” People pay more
attention to events and people that are the subjects of video clips.

Making home movies is nothing new. But even with the best analog cam-
corder, you can’t edit a video. Before iMovie, you had to rent or buy thou-
sands of dollars worth of video editing gear and use complicated software to
edit videos — most home users couldn’t afford that equipment, and so they
had no way to edit their videos. With iMovie, you can not only edit your
video clips, you can also improve them by adding transitions and special
effects, matching the audio with the video or adding music, and creating a
final movie with just the scenes you want. You can then copy the movie to
your camcorder’s tape cassette, watch the movie on TV, save the movie as a
QuickTime file for use elsewhere, or even burn a DVD of the movie to use in
DVD players.

Digital technology makes video editing easy, cheaper, and more fun to make,
opening up entirely new possibilities. You'll find that with a Mac, iMovie, and
a digital camcorder, creating video clips for the Web or producing DVDs or
videotapes of weddings and other events is simple.

What Vou Can Do with iMovie

iMovie provides the basic, no-frills editing tools you need to put together a
movie from a set of video clips. You can navigate freely from scene to scene,
and save your edits and changes in digital format without the use of video-
tape. The result is a digital video movie you can save as a QuickTime file or
dump back to digital videotape without any loss in quality.
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If you aren’t that familiar with video, the following list explains what you can
do to create and produce a movie with iMovie. Although you may do these
steps in sequence, you can go back and redo many of these steps over and
over until your movie is exactly the way you want. With iMovie, you can do
the following:

4+ Shoot the video and transfer it to your computer. Use a digital cam-
corder to record video, which of course includes audio (unless you're
making a silent movie or adding sound later). Whatever you shoot
becomes the basis for your movie.

iMovie allows you to import your digital video footage with one click, and
it automatically separates the scenes for you into clips. You can then
pick out the good parts, snip out the slow or boring parts, shuffle scenes
around to your heart’s content, and add sound.

4+ Edit the video clips. Use iMovie to organize and edit your clips, and to
trim unwanted parts at the beginnings and endings (but make sure you
don’t lose any important sounds by trimming). You can edit the scenes
in the timeline viewer and synchronize the audio to the video. Import
photos from iPhoto or create still images from video scenes to mix in
with your movie. Find out how to do tight editing, and how to establish a
shot and create cutaways and cut-ins to make your movie more effective
and interesting to watch.

4+ Add special video effects and documentary-style effects for photos.
You can spiff up your video with visual effects like Lens Flare, Aged Film,
Letterbox, and Electricity. Want to sprinkle a glittering trail of fairy dust
over a festive scene? iMovie lets you do that, and you can even decide at
which point in the frame you want to use it. iMovie also enables you to
add haunting visual effects such as fog and ghost trails to your movies in
seconds. You can bring your photos from iPhoto to life with professional
documentary-style impact, using pan and zoom effects.

4+ Arrange the video clips in a sequence using a timeline, adding transi-
tions between scenes. Use iMovie to flow from scene to scene just right.
iMovie offers smooth transitions to make your video look professional.

4+ Edit the sound. Video includes sound, and you can add even more
sound to your movie three different ways:

¢ Use one of the included sound effects to augment the sound from the
video.

* Add a musical track from a CD, from your own iTunes library, or a
song you created in GarageBand and exported to your iTunes library.
You may want to fade music behind the sound from the video and
use it for transitions.

¢ Record your own voiceover. You can use iMovie to record directly
into an audio track.
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4+ Add titles and credits. When you’re done editing, you can add text as
end credits, rolling commentary, or opening titles. You can choose from
several styles and customize the text color and font.

4+ Save the final version and make copies. You can copy your movie to
digital videotape (such as the cassette used in your camcorder), or save
it as a QuickTime file for publishing on the Web and distributing by
CD-ROM or other methods. You can send the movie over to iDVD to
create a DVD with menus and everything that can play on any DVD
player. You can even copy the movie to conventional videotape, all with-
out any loss in quality, because the information is in digital form.

Don’t let the reduced image quality of Web video keep you from publishing
videos on the Web. Even though image quality suffers when you shrink
movies in size to put them on the Internet, video is a very effective medium
for communicating your message.

What you need for iMovie

Although iMovie makes video editing easy, you need a fairly robust Mac, and
if you want to create your own DVDs, you need an Apple-supported DVD-R

drive (such as the Apple SuperDrive).

Why is video editing easier now?

Video editing in the past conjures up images of
darkened rooms with dedicated technicians
tending to large tape machines surrounded by
huge consoles with thousands of levers, knobs,
and buttons. To edit videotape professionally,
technicians of yesteryear had to create a
master tape by literally cutting and splicing
together pieces of tape. Eventually, machines
were invented that synchronized two tape
decks with time code so that editors could pro-
vide a list of editing changes associated with
time codes, and the machines would do the
work of creating a master tape from other
tapes. Any copy made of the master videotape
was inferior in quality, and the quality degraded
even further with copies of copies.

Digital technology took a while to reach the
professional video editing room, but when it
did, it transformed video editing completely.

Professional video editing changed as digital
video hardware replaced older, more expen-
sive videotape controllers. The ability to edit the
video changed dramatically with digital video
compression technology, which allowed edi-
tors to store and edit video on a hard drive with-
out compromising quality.

iMovie is an even further improvement on digi-
tal editing, providing editing tools for people
with no background in video editing. With
iMovie, you can navigate freely from scene to
scene in any manner, and save your edits and
changes in digital format on a hard drive with-
out the use of videotape. Digital copies are
exact duplicates, and so there is no loss in
quality in the copies. You can edit to your
heart's content without ever sacrificing the
original quality of the video.
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If you don’t have the right equipment, or the money to invest in new equip-
ment (none of this is cheap), you can send your files to a service to be con-
verted to DVD. Or you can use iMovie on one Mac and later transfer the
project to another iMac with a DVD-R drive.

To use iMovie, you need the following requirements at a minimum:

4+ A digital video (DV) camcorder to record your footage and to convert
older footage and other video sources to the digital format.

4+ DV cassette tapes (called mini-DV in camcorders) to store the digital
video you capture with the camcorder.

4+ A Mac with a FireWire port to connect your camcorder and control it
from iMovie.

4+ A FireWire cable to connect your camcorder to the Mac. FireWire is also
known as IEEE 1394 DV terminal. The cable has a camcorder-style (very
small) connector on one end and a standard FireWire connector for the
Mac on the other end.

4+ Gigabytes of free space on your hard drive to store and edit video clips.
We typically use an 80GB hard drive for a small video project (half an
hour of video). Video data occupies about 3.6MB of storage space per
second — roughly 7GB for 30 minutes.

4+ At least 256MB of RAM, Mac OS X version 10.1.5 or later, and QuickTime
version 6 or later.

With iMovie, you can record directly to your hard drive without tape, but
your camcorder must be connected to the Mac. Although this makes sense
for interviews or other situations in which the camcorder is stationary, your
ability to move freely is severely hampered (unless you have an assistant
running after you, carrying a PowerBook running on batteries — it may look
silly, but it actually works). You’ll find no qualitative difference in recording
to the hard drive or to the DV cassette in the camcorder, but the cassette is
more convenient.

Why you need a digital video camcorder

If you're thinking about buying a camcorder, you should consider buying a
digital camcorder. Digital video makes all former methods of recording video
obsolete. You’ll find many advantages for digital video over analog video:

4+ You can copy digital videotapes without any loss in quality.

4 You can convert digital video on tape to digital video on your hard drive
with iMovie, which automatically detects scenes and creates individual
clips for them. iMovie controls a digital camcorder for both recording
directly to the hard drive and transferring digital video from the cam-
corder’s cassette.



207

What YVou Can Do with iMovie

4+ You can combine digital video clips into a sequence without any seams
between the clips — no weird fuzzy lines or flickers to cover up, and no
need to mask the artifacts from the analog-to-digital conversion process
that was necessary just a few years ago. The video you shoot is exactly
the same quality after the editing process.

Don’t throw out your old camcorder and forget about using analog videos.
With the level of control iMovie has over a digital camcorder, you can use a
digital camcorder for the importing of analog video by connecting your older
camcorder or VCR to your digital camcorder. We describe how to do this in
Chapter 2 of this minibook.

Why digital? What's the difference?

Digital camcorders offer tremendous advan-
tages over analog camcorders:

Digital camcorders are smaller and easier to
use. Digital video (DV) camcorders are smaller
because the size of the tape cartridge is smaller.
The largest DV camcorder you can buy in an
electronics store is about the same size as the
smallest 8mm camcorder of yesteryear. Small
size means more convenience, easier handling,
and longer battery life (due to less equipment to
power).

The quality is far better than ever before. Picture
quality with video depends on the horizontal res-
olution, which is measured across the picture
as if counting vertical lines. All video formats
(except high-definition television, or HDTV) have
the same vertical resolution, or number of lines
going down the picture. The horizontal resolu-
tion, however, varies. VHS tape offers 240 lines
of horizontal resolution, and a live TV broadcast
offers 300 lines. A digital satellite broadcast
offers 400 lines. Digital video in the mini-DV cas-
sette format used by camcorders offers 500 lines
of horizontal resolution, resulting in a much
sharper, clearer picture.

You can edit digital video with a personal com-
puter, a hard drive, and editing software. Digital
video is data. Before you could edit video as
digital data on a hard drive, you could only use
a computer to control traditional videotape
equipment that performed editing operations
based on a list of instructions. You really didnt
edit on the computer; your changes in an edit-
ing system translated into instructions for
the analog machines. Digital video changed all
that by providing a format for video that can
record and play back as digital information. You
can access the information — the video — at
any point, without needing to rewind or fast-
forward a tape.

You can make copies of copies with no loss in
quality. Digital video data lasts forever, even
though the medium for storing it doesn't last.
Even if you make copies of copies of copies,
the digital information will still be duplicated
exactly each time. The quality of analog video,
on the other hand, deteriorates when you copy
a tape. You probably have noticed this with
VHS tapes — a copy of a tape is not nearly as
good as the original.
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If you use a standard analog camcorder that uses 8 mm (millimeter) analog
videocassettes, you can choose to buy a hybrid digital Smm camcorder, such
as the Sony Digital8, that plays standard 8mm cassettes and also stores digi-
tal video using that format.

Don’t buy a more expensive camcorder in order to get features that you may
not need. DV camcorders offer an impressive set of features, some of which
you may never use. For example, in-camera editing is a feature that essentially
allows you to do minimal clip editing and sequencing in the camcorder (such
as the Sony camcorder that uses the Sony MiniDisc, instead of DV cassettes).
But as an iMovie user, you will probably never do in-camera editing — moving
your video clips to the iMac to edit them is much more convenient. And the
iMovie editing software gives you editing tools that are far more flexible, pow-
erful, and easier to use than camcorder buttons.

Touring iMovie

iMovie allows you to bring multimedia elements together and place them in
a sequence over time. iMovie keeps track of all these elements, capturing
the video (including the video’s audio portion) and storing a series of video
clip files on your hard drive. You can then import other elements, such as
photos from iPhoto, music from iTunes, and even other videos saved as
QuickTime files.

Starting iMovie

On most Macs, you find the iMovie icon in the Dock, but if that’s not the case,
you can find it in the Applications folder. Double-click the icon to open iMovie.
When you start iMovie for the first time, you have a choice of opening an
existing project or creating a new one (or quitting the program). If you open
an existing project, a window appears, similar to the one in Figure 1-1.

If your display is not set to at least 1,024 x 768 or higher in the Displays pref-
erences, you get a message from iMovie saying it can’t run. Your display’s
resolution is set to a lower number than possible, either accidentally or
intentionally. To change its resolution, follow these steps:

1. Choose System Preferences from the Apple menu in the upper-left
corner.
The System Preferences window appears.

2. Click the Displays icon.

The icon appears in the Hardware row of icons (and also, typically, in the
top row of most-used icons). The Displays pane appears.



Figure 1-1:
The iMovie
window
after
opening a
project.
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3. Click the highest pixel resolution setting in the Resolutions list.

Your display must be capable of at least 1,024 x 768 pixels to run iMovie;

choose that setting or a higher one if available.

=

Select the Millions option in the Colors pop-up menu.

5. Quit System Preferences by choosing System Preferences=>Quit

System Preferences.

Now your display setting offers the best quality viewing for your movies.
You can change your display settings at any time in Mac OS X, and your
settings take effect immediately. However, if you lower the pixel resolu-
tion below 1,024 x 768 while iMovie is running, iMovie quits abruptly.

iMovie: Soccer Games 02:54 (NTSC)
g

[ Edit volume.

Camera/edit mode switch iMovie monitor

Playback controls (rewind, play, play full-screen)

Scrubber bar

Clip/timeline viewer button switch

Disk space indicator

Clip/timeline viewer (shows timeline) ~ Media panes (clips pane showing)

Media pane buttons
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When you start iMovie for the first time, a Welcome to iMovie dialog appears,
providing the following choices:

4 Quit: Click this button to quit the program.

4+ Open Existing Project: Click this button to open a project already stored
on your hard drive. The Mac OS X Open dialog appears, which enables
you to browse folders to select a project file.

4+ Create New Project: Click this button to create a new project.

After clicking the Create New Project button, the Save dialog appears. Type
the name for your project in the Save As text field, and click the Where pop-up
menu to locate a folder for storing the project. Click the down-arrow button to
expand the dialog into the full Mac OS X Save dialog, which enables you to
browse folders easily.

After selecting a folder to save the project, click the Save button to save it.
iMovie uses the project name as the name for both the project file, and for the
folder that contains the project file and all the video clips associated with the
project file. iMovie saves the project folder inside the folder you selected.

After creating a new project or selecting an existing project, the project
appears in the iMovie window. If you are starting a new project, the iMovie
window appears with the iMovie monitor set to all black and the Clips pane
empty.

The next time you start iMovie, the program opens automatically with the
last project you opened. You can then continue working in the project, start
a new project by choosing Filec>New Project, or open another project by
choosing File>Open Project (or File>Open Recent, which displays a sub-
menu of projects opened recently).

Understanding the iMovie window elements

The iMovie window elements you use most often are the following:

4+ iMovie monitor: Your video clip plays in the iMovie monitor, whether
you select the clip in the Clips pane or in the timeline or clips viewer.

4+ Clips pane: iMovie stores incoming clips in the Clips pane until you use
them in the timeline or clip viewer. The Clips pane is one of the media
panes — you switch media panes by clicking the media panes buttons.

4+ Scrubber bar: Drag the triangle along the scrubber bar to move through
(or scrub through) a clip or sequence of clips frame by frame. The scrub-
ber bar plays whatever displays in the iMovie monitor. You can select a
single clip from the Clips pane and scrub through it, or you can create a
sequence in the timeline or clip viewer and scrub through that.



Touring iMovie 211

4+ Camera/edit mode switch: Click this switch on the scissors side